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New Features for Compaq Visual Fortran Version 6.6

New features added to Compaq Visual Fortran (Visual Fortran) Version 6.6
(since Visual Fortran Version 6.5 and 6.5A) include the following:

e Support has been added for 8-byte integer and 8-byte logical intrinsic data
types.

e The Windows API interface header files DFWINTY.F90 and DFWIN.F90 (and
its component files) have been extensively revised to work in both a 32-bit
and a 64-bit environment.

e A new version of the Compaq Extended Math Library (CXML) is included
with Visual Fortran Version 6.6. CXML Version 5.0 includes improved
performance for many CXML routines, a new set of routines for solving
sparse matrix problems using direct methods, sample files that show how
to invoke the direct sparse solver routines from Fortran and C, changes to
certain sparse iterative solver functions, changes in how messages can be
printed with the iterative solver functions (including changes to the
argument iounit), and other changes. The skyline solver routines are no
longer supported. The auxiliary LAPACK routine XLAENV is no longer
supplied by CXML; instead, the LAPACK routines DLAMCH and SLAMCH
have been modified to return compile-time constants instead of computing
values on each call.

e The types of Visual Fortran run-time libraries displayed in the visual
development environment Fortran tab (Project menu, Settings dialog box)
more closely match the run-time libraries available in Visual C++ (C/C++
tab). Also, the types of run-time libraries linked against while linking
against debug versionsof DLL libraries have changed, as described in Visual
Fortran/Visual C++ Mixed-Language Programs and Specifying Consistent
Library Types.

e The following new graphics functions let you draw Bezier curves (based on
fitting a cubic curve to four points):

e POLYBEZIER and POLYBEZIER_W

e POLYBEZIERTO and POLYBEZIERTO_W

e The following compiler options have changed or have been added:

e /annotations now provides information about optimizations in a listing
file.

e /architecture and /tune options now support the pn4 keyword for
Pentium 4 systems. In addition, the pnl, pn2, and pn3 keywords have
been added (pn is an abbreviation for Pentium) as the preferred
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keywords in place of p5, p6, and p6p.

e The /ccdefault:default option now allows other options, such as /vms,
to set the default carriage control.

e The keyword /fpscomp:ldio_spacing, for list-directed output, controls
whether a blank is inserted at run-time after a numeric value before a
character value. This option is set by /fpscomp:general.

e /integer_size now supports a value of 64 to allow INTEGER and
LOGICAL declarations to be treated as 8 bytes long (KIND=8).

e Specifying the /stand option (without keywords) now sets /stand:f95
(Fortran 95 standards checking) instead of /stand:f90 (Fortran 90
standards checking).

e If you specify /fast with /stand, /align:dcommons and /align:sequence
(usually set by /fast) are not set.

e A derived-type variable that is data initialized via default initialization of
any of its components will no longer be saved by default. A RECORD
variable that is data initialized via default initialization specified in its
STRUCTURE declaration will no longer be saved by default.

e The Fortran preprocessor fpp supports the macros __ DATE___ and
__FILE__ . When you request that fpp expand macros using "-fpp:-m",
these expand into character literals that give the name of the source file
being processed and the current date/time respectively.

e For additional new features and details, see the online release notes
(rel notes.txt orrel notes. htm.

e New or significantly revised sections in the Programmer's Guide include
Copying Projects and Viewing Fortran Data Types in the Debugger.

Beginning with Version 6.6, Visual Fortran no longer supports Windows NT Alpha
systems.

Changes to Compaq Array Visualizer are described separately in the Array
Visualizer HTML Help documentation.
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New Features for Compaq Visual Fortran Version 6.5 and
6.5A

New features added to Compaq Visual Fortran (Visual Fortran) Version 6.5A
(since Visual Fortran Version 6.5) include the following:

e The Fortran COM Server now allows you to select an out-of-process (.EXE)
COM server. Users now have a choice of the type of server, either a DLL
(in-process) COM server and an EXE (out-of-process) COM server. Other
Fortran COM Server enhancements allow array arguments to be assumed
shape and you can now add the ISupportErrorinfo interface to your server.

e The following new compiler options have been added:

e /assume:[no]protect constants specifies whether constant actual
arguments can be changed.

e /check:arg_temp_created requests that a run-time informational
message appear if actual arguments are copied into temporary
storage before routine calls.

e /warn:ignore_loc requests that the compiler issues warnings when %
LOC is stripped from an argument

e The following new ATTRIBUTES directives have been added: ALLOW_NULL,
DECORATE, IGNORE_LOC, and NOMIXED_STR_LEN_ARG

e The optional KIND argument has been added to INDEX, LEN_TRIM,
MAXLOC, MINLOC, SCAN, and VERIFY intrinsic procedures.

e For additional new features and details, see the online release notes
(rel notes.txt orrel notes. htm.

e New or significantly revised sections in the Programmer's Guide based on
customer feedback include Coding Requirements for Fortran Windows
Applications, Using Menus and Dialogs in SDI and MDI Fortran Windows
Applications, Using the Resource Editor to Design a Dialog, and
Compatibility with Compaq Fortran on Other Platforms.

e The section Pointer Arguments in the Language Reference has been
significantly revised based on customer feedback.

New features added to Compaq Visual Fortran Version 6.5 (since Visual Fortran
Version 6.1) include the following:
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The Fortran COM Server project type and the Fortran COM Server Wizard,
described in Creating a COM Server. The Fortran COM Server Wizard helps
you create a COM server or dual interface server. In addition, new
information about using COM and Automation is provided in Getting a
Pointer to an Object's Interface.

New COM routines are provided:

e COMStringFromGUID passes a GUID and returns the corresponding
string representation.

¢ COMIsEqualGUID determines if two GUIDs are the same.

Visual Fortran now generates optimized code for the Intel™ Pentium™ 111,

AMD™ K6, and AMD Athlon™ architectures, by providing new keywords for
the /arch and /tune compiler options.

New intrinsic procedures added:

e INT_PTR_KIND returns the INTEGER KIND that will hold an address.

e KIND= is now an optional argument to the intrinsic procedures LEN,
SHAPE, SIZE, LBOUND, and UBOUND.

e For x86 systems, POPCNT, POPPAR, LEADZ, and TRAILZ perform bit-
related operations on integer data.

New exception handling routines are provided:

e CLEARSTATUSFPQQ exception flags in the floating-point processor
status word (x86 processors).

e GETEXCEPTIONPTRSQQ returns a pointer to C run-time exception
information pointers appropriate for use in signal handlers established
with SIGNALQQ or direct calls to the C rtl signal() routine (x86
processors). For additional information about
GETEXCEPTIONPTRSQQ, see Obtaining Traceback Information with
TRACEBACKQQ and TRACEBACKQQ.

The new QuickWin graphics routine SETTEXTCURSOR has been added to
set the height and width of the text cursor (the caret) for the window in
focus.

e The interface to the AUTOAddArg subroutine has changed. The output_arg

argument (LOGICAL) is now the intent_arg argument (INTEGER). New
code should use the new documented interface. The old interface is
supported for compatibility purposes.

e New information about advanced exception handling and setting up various
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types of handlers for x86 systems is provided in Advanced Exception and
Termination Handling Considerations.

e For non-native unformatted files, you can now use the FORT_CONVERT.ext
or FORT_CONVERT_ext environment variable method to specify that files
with certain file extensions (such as .DAT) are in a specified non-native
format (see Methods of Specifying the Data Format). (Visual Fortran's
native numeric formats are little endian, including IEEE floating-point
formats.)

e Previous versions of Visual Fortran allowed only procedures and COMMON
blocks to have the DLLEXPORT or DLLIMPORT ATTRIBUTE. You can now
export/import module variables and arrays.

e A Visual Fortran compiled module now contains all of the information from
modules used (USE statement) by the module. This may greatly increase
the size of compiled modules, especially if the modules contain a USE
DFW N or USE DFW NTY statement. There are ways to minimize the
information contained in compiled modules when calling Win32 routines, as
described in Calling Win32 Routines and the Visual Fortran Windows
Module.

e In order to conform with clarified wording in the Fortran 95 standard, the
compiler has been changed so that when a READ statement encounters an
end-of-file condition, and there is no END specifier but there is an ERR
specifier, the ERR= branch is not taken. Similarly, if an end-of-record
condition occurs but there is no EOR specifier, an ERR branch is not taken.
If you do not specify a routine to handle such errors with the IOSTAT
specifier, omitting the END or EOR specifier results in a severe run-time
error (such as numbers 24 or 268 respectively).

e The run-time system has been changed to perform more thorough edit
checking on list-directed input. In accordance with the Fortran 95
Standard, the run-time system no longer accepts as numeric input "+", "-",
LU, DY, "ET, or Q" without expressing at least 1 digit. For example, the
run-time system used to allow a single "+" to convert to a O, but now it will
return a FOR$IOS_LISIO_SYN (number 59) error. In addition, ambiguous
expressions such as "+-" and "--" will be rejected

e Support has been added for reading nondelimited character strings as input
for character NAMELIST items.

e The %VAL and %REF used on actual arguments now override any
argument-passing mechanism specified in an explicit interface.

e New Visual Fortran Samples (described in Roadmap to the Visual Fortran
Samples) are provided, including:

e COM sample: Adder
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e DIALOG sample: Celsicon

e ExceptionHandling samples: ClearFP, Cslexp2, Cslexp4, GetEptrs,
Vbvfl, and Winexcpl

Isovar sample (ISO varying strings)

Mixed-language samples, new samples for MASM and Delphi
e QuickWin samples: Conapp, Dirkeys4, PostMini, and Resize

e Isovar, an ISO varying string sample

e Compiling modules is now faster.
e Concurrent-use licensing is now available.

e For additional new features and details, see the online release notes
(rel notes. txt orrel notes. ht m, located in the root directory of the
Visual Fortran CD-ROM or installed in Program Fi | es\ M cr osoft
Vi sual St udi o\ Df 98.

e New or significantly revised sections in the Programmer's Guide based on
customer feedback include Specifying Consistent Library Types and Using
the Console.

Changes to Compaq Array Visualizer are described separately in the Array
Visualizer HTML Help documentation.
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New Features for Compaq Visual Fortran Version 6.1

New features added to Compaq Visual Fortran (Visual Fortran) Version 6.1
(since Version 6.0.A) include the following:

e The Compaq Extended Math Library (CXML) is now provided with the Visual
Fortran kit (all editions). CXML is a highly efficient set of math library
routines that covers Basic Linear Algebra (BLAS), Linear Algebra Routines
(LAPACK), sparse linear system solvers, sorting routines, random number
generation, and signal processing functions.

In addition to being provided with Visual Fortran, CXML is also available on
other Compaq Fortran platforms. CXML is:

e Provided with Compaq Fortran Version 5.3 (or later) for Tru64 UNIX
Alpha systems and Compaq Fortran Version 1.0 (or later) for Linux
Alpha Systems

e Provided with Compaq Visual Fortran Version 6.1 (or later)

e Provided with Compaqg Fortran Version 7.3 (or later) for OpenVMS
Alpha systems

e Available as a separate download for most platforms (see the CXML
home page at http://www.compag.com/math)

For more information on CXML, see Using the Compag Extended Math
Library (CXML) in the Programmer's Guide or the online PDF file
Cxmlref.pdf. For information on online PDF files, see The IMSL Routines
and CXML Routines Online PDF Documentation.

e IMSL® Version 4 libraries are now provided with the Professional Edition
(prior to Visual Fortran 6.1, Visual Fortran provided IMSL Version 3
libraries). The IMSL routines reference documentation is available in PDF
format (not HLP format).

For information on using the IMSL libraries, see Using the IMSL
Mathematical and Statistical Libraries in the Programmer's Guide. For
information on online PDF files, see The IMSL Routines and CXML Routines
Online PDF Documentation. For more information about IMSL and Visual
Numerics®, Inc., see http://www.vni.com.

e New functionality has been added to the Dialog Procedures:

e You can use ActiveX Controls in your dialog boxes. See Using ActiveX
Controls in the Using Dialogs section in the Programmer's Guide.

e Edit Box control enhancements:
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You can now use multi-line edit controls and the maximum size
restriction of 256 characters has been removed. The Edit Box control
supports 2 additional integer indexes (see Using Edit Boxes):

e DLG_TEXTLENGTH - Sets or Gets the current length of the text in
the edit box.

e DLG _POSITION - Sets or Gets the current text cursor position in
the edit box.

e The dialog box supports a new callback index, DLG_SIZECHANGE (see
Control Indexes). This callback is invoked when the size of the dialog
box changes.

e New dialog routines are provided:

e DigSetTitle - Sets the title of the dialog box.

e DIgFlush - Updates the display of the dialog box. Useful when
changing the dialog box outside of a dialog callback.

e DIgModalWithParent - Allows you to specify the parent window of
a modal dialog box. Useful in an SDI or MDI Windows application
that uses modal dialog boxes.

e DlglsDIlgMessageWithDIg - Allows you to specify which dialog box
to check. Useful when the dialog box was created in a DLL.

e New SPORT_xxx (Serial Port) routines have been added.

The SPORT_xxx collection of routines helps Fortran programmers do basic
input and output to serial communication ports. The programming model is
much the same as a normal file except the user does a connect/release
instead of an open/close. Two types of read and write operations are
provided:

e Read and write arbitrary data from/to the port

¢ Read and write line terminated data

Calls are provided to set basic port parameters such as baud rate, stop
bits, timeouts, and so on. Additionally, a call is provided to return the
WIN32 handle to the port so that raw WIN32 APIs may be used to
implement additional needs of the programmer.

The documentation overview can be found in Using the Serial 1/0 Port
Routines in the Programmers Guide.

For a detailed description of the routines, see the Language Reference, A to
Z Reference under S (SPORT_xxx), such as SPORT_CONNECT.
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e The new subroutine TRACEBACKQQ allows you to initiate a stack trace in
your program whenever you like. The input arguments allow you to specify
your own message text to head the output and other options as well. See
the following for more information:

e Obtaining Traceback Information with TRACEBACKQQ in the
Programmer’s Guide

e TRACEBACKQQ in the Language Reference, A to Z Reference.

e In Developer Studio, you can now print a Fortran source file in color
(requires a color printer). After you open the source file in the text editor,
in the File menu select Print Colorized Fortran. This has been tested with
the Internet Explorer and Netscape browsers. Because Print Colorized
Fortran does not know when printing has completed, it creates and leaves
the HTML file in your TEMP directory. Delete previously printed HTML files
from your TEMP directory to free up disk space. Print Colorized Fortran
uses the FSC utility to create an HTML file with the coloring information and
then instructs the application on your system that handles HTML files to
print the file. If you encounter a problem using the Print Colorized Fortran
item, please use the FSC utility directly.

The FSC.EXE utility takes an .F9O or .FOR source file and produces an
HTML version that is colorized per the current Developer Studio Color
settings in the registry. It has default colors that are used if the current
registry settings are not available. The resultant HTML file may be printed
or viewed with your favorite browser. This utility may be invoked from a
command prompt (use FSC -? or FSC /h for help) or from within Developer
Studio.

e VFRUN provides a self-extracting executable file that installs redistributable
Visual Fortran run-time components on the target system. These run-time
components include DLLs and other files, as described in "Redistributing
Visual Fortran Files” in Compaq Visual Fortran Installing and Getting
Started.

VFRUN files are provided for different Visual Fortran releases and for x86
and Alpha systems. For example, for Visual Fortran v6.1, VFRUNG61i.exe is
provided for x86 systems and VFRUNG61la.exe is provided for Alpha
systems. You can download VFRUN from the Visual Fortran Web site,
http://www.compag.com/fortran (click on Downloads and Updates, then
Run-Time Redistributables Kit). Please download the VFRUN kit for the
version of Visual Fortran used to create the executable application.

e Visual Fortran (VF) Reporter is a new tool that helps you report problems
by e-mail to the Visual Fortran team. This tool gathers and displays system
information and guides you to send relevant information in an e-mail
message. This tool can be optionally installed during Visual Fortran
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installation. For information on technical support and using VF Reporter,
see Compagq Visual Fortran Installing and Getting Started.

e Greater Access to Windows APls

Additional interface definitions have been provided to simplify calling Win32
routines from Visual Fortran:

e DFWINTY.F90 has 980 new derived types and 4070 new Fortran
parameter constants added. These new items represent the difference
between Microsoft Visual C++ 4 header files and Visual C++ 6 header
files.

e USER32.F90 has 72 new interfaces to routines in USER32.LIB. These
new routine interfaces again represent the difference between
Microsoft Visual C++ 4 header files and Visual C++ 6 header files.

¢ KERNEL32.f90 has 50 new interfaces to routines in KERNEL32.LIB.
e GDI32.F90 has 25 new interfaces to routines in GDI32.LIB.

¢ ADVAPI32.F90 has 50 new interfaces to routines in ADVAPI32.LIB.

In all these files, the new material is under conditional compilation so that
defining *__DO_NOT_INCLUDE_VC6_ITEMS" will remove the new items.
Search for the string above to locate the new items which will be found
towards the ends of the files.

The files are shipped without the string being defined, and the mod files will
contain the new items.

e New or changed compiler options include:

e The /align option now includes the /align:sequence keyword to allow
alignment of derived type data with the SEQUENCE statement. This
option appears in the Fortran Data category in the Project Settings
dialog box (see Categories of Compiler Options).

e The /ccdefault:keyword option controls carriage control use when
writing to a terminal screen. This new option appears in the Run-Time
category in the Project Settings dialog box.

e The /cxml option requests that the Compaq Extended Math Library
(CXML) library be linked against (provided for documentation
purposes only). This new option appears in the Library category in the
Project Settings dialog box.

e The /fast option now sets the /arch:host /tune:host /align:sequence
options.
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e The /imsl option ensures that the IMSL libraries will be passed to the
linker (your program needs to specify the appropriate USE statements
and set the IMSL environment variables). This new option appears in
the Library category in the Project Settings dialog box.

¢ Visual Fortran puts literals into read-only memory so storing into a dummy
argument that has a constant as its associated actual argument will result
in an access violation and program termination:

call f(0)

éﬁbroutine f(i)
i =1 I this will die

e Two new Fortran source directives for controlling optimizations are now
available:

e CDECS$ IVDEP
e cDEC$ UNROLL

For an overview of these directives, see Compiler Directives Related to
Performance in the Programmer's Guide.

For more detail, see 1VDEP Directive and UNROLL Directive in the Language
Reference.

e Version 6.1 for x86 (Intel) systems contains all of the applicable updated
files from the Microsoft Visual Studio 6.0 Service Pack 3. Therefore, Version
6.1 x86 users do not need to install Visual Studio 6.0 Service Pack unless
you have other Visual Studio products. Version 6.1 for Alpha systems
contains all of the applicable updated files from the Microsoft Visual Studio
6.0 Service Pack 2.

e You can now maintain previously saved Fortran Environment Project
Settings (see Saving and Using the Project Setting Environment for
Different Projects. Use the Manage Saved Fortran Environment icon in the
Fortran toolbar. Also, application wizards that assist in creating a new
Fortran Windows project have been enhanced.

e HTML Help now supports the ability to define (View menu, Define Subset...
item) and use subsets of the current collection of HTML Help titles (see
Compagq Visual Fortran Installing and Getting Started). This is especially
useful when using the full-text search capabilities of HTML Help.

e HTML help no longer includes embedded Adobe Acrobat PDF files. Instead,
the PDF files ship on the Visual Fortran CD-ROM (and are installed if



New Features for Compaq Visual Fortran Version 6.1 Page 6 of 6

requested). For details, see The IMSL Routines and CXML Routines Online
PDF Documentation. This reduces the size of the Visual Fortran HTML help
(CHM) file and minimizes the possibility of software problems displaying
embedded PDF files reported on certain systems.

e For additional details, see the online release notes, installed in Pr ogr am
Files\M crosoft Visual Studio\Df98.

Changes to Compaq Array Visualizer are described separately in the Array
Visualizer HTML Help documentation.
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Introduction to the Programmer's Guide

In this document, links are denoted by a T or th when you pass your pointer over a
blue-colored term. In either case, click on the link to see further information.

The Programmer's Guide contains the following information:

o How to build and debug efficient applications:

o Building Programs and Libraries

o Using the Compiler and Linker from the Command Line
o Compiler and Linker Options

o Debugging Fortran Programs

o Performance: Making Programs Run Faster

¢ Special coding and related considerations for certain Visual Fortran project
types:

o Using QuickWin
o Creating Fortran DLLS
o Creating Windows Applications

e Topics about programming with Visua Fortran on Windows® 2000, Windows
NT® 4.0, Windows Me, Windows 98, and Windows 95 systems:

o Portability and Design Considerations
o Using Dialogs

o Drawing Graphics Elements

o Using Fonts from the Graphics Library
o Using National Language Support Routines
o Portability Library

o Files, Devices, and |/O Hardware

o Using COM and Automation Objects
o Creating a COM Server

o Programming with Mixed Languages
o Creating Multithread Applications

e Topicsrelated to datatypes and handling run-time errors.

o Data Representation
o Handling Run-Time Errors




Introduction to the Programmer's Guide Page 2 of 2

o The Floating-Point Environment

o Advanced Exception and Termination Handling Considerations
o Converting Unformatted Numeric Data

o Hexadecimal-Binary-Octal-Decimal Conversions

e Topicsdiscussing how to use IMSL® and CXML library routines:

o Using the IMSL Mathematical and Statistical Libraries
o Using the Compaq Extended Math Library (CXML)

e Topicsdiscussing compatibility and tools:

o Compatibility |nformation
o Using Visual Fortran Tools

Note: Visual Fortran contains many extensions to the full ANSI/ISO standard
language. In this book, the Visual Fortran extensions to the Fortran 95 standard appear
in this color.
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Programmer's Guide Conventions

This section discusses the following:

e General Conventions
e Syntax Conventions
e Platform labels

General Conventions

The Programmer's Guide uses the following general conventions.
(Note that in most cases, blanks are not significant in Fortran 90 or
95.)

When You See This ||Here Is What It Means

Extensions to Fortran || Dark teal type indicates extensions to the
95 Fortran 95 Standard. These extensions
may or may not be implemented by other
compilers that conform to the language
standard.

DF, LINK, FL32 Uppercase (capital) letters indicate
filenames and MS®-DOS®-level
commands used in the command console.

expression Words in italics indicate placeholders for
information that you must supply. A file-
name is an example of this kind of
information. Italics are also used to
introduce new terms.

[optional item] Items inside single square brackets are
optional. In some examples, square
brackets are used to show arrays.

{choicel | choice2} Braces and a vertical bar indicate a choice
among two or more items. You must
choose one of the items unless all of the
items are also enclosed in square brackets.
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A horizontal ellipsis (three dots) following
an item indicates that the item preceding
the ellipsis can be repeated. In code
examples, a horizontal ellipsis means that
not all of the statements are shown.

s[, s]...

compiler option This term refers to Windows options,
OpenVMS qualifiers, and Tru64 UNIX and
Linux options that can be used on the
compiler command line.

I Comrent |ine i i ;

VRITE (*.%) ' Hello & This kind of type is used for program
awerl d' examples, program output, and error
messages within the text. An exclamation
point marks the beginning of a comment in
sample programs. Continuation lines are
indicated by an ampersand ( & ) after the
code at the end of a line to be continued

and before the code on the following line.

AUTOMATIC, Bold capital letters indicate Compaq®
INTRINSIC, WRITE || Fortran statements, functions,
subroutines, and keywords. Keywords are
a required part of statement syntax,
unless enclosed in brackets as explained
above.

In the sentence, "The following steps occur
when a DO WHILE statement is
executed," the phrase DO WHILE is a
Compaq Fortran keyword.

Bold lowercase letters are used for
keywords of other languages. In the
sentence, "A Fortran subroutine is the
equivalent of a function of type void in C,"
the word void is a keyword of C.

Fortran This term refers to language information
that is common to ANSI FORTRAN 77,
ANSI/1SO Fortran 95 and 90, and Compaq
Fortran (formerly DIGITAL Fortran).
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Fortran 95/90

This term refers to language information
that is common to ANSI/ISO Fortran 95
and ANSI/1SO Fortran 90.

Fortran 95 This term refers to language information
that is common to ANSI/1SO Fortran 95.
Fortran 90 This term refers to language information

that is common to ANSI/ISO Fortran 90.

Compag Fortran,
DIGITAL Fortran

These terms refer to the same language.

OpenVMS, VMS

These terms refer to the same operating
system.

True4 UNIX, DIGITAL
UNIX

These terms refer to the same operating
system.

Windows systems

This term refers to all supported
Microsoft® Windows® operating systems.
(See labels WNT and W9* in Platform
Labels below.)

integer

This term refers to the INTEGER(KIND=1),
INTEGER(KIND=2), INTEGER (INTEGER
(KIND=4)), and INTEGER(KIND=8) data
types as a group.

real

This term refers to the REAL (REAL
(KIND=4)) and DOUBLE PRECISION (REAL
(KIND=8)) data types as a group.

complex

This term refers to the COMPLEX
(COMPLEX(KIND=4)), DOUBLE COMPLEX
(COMPLEX(KIND=8)), and COMPLEX
(KIND=16) data types as a group.

logical

This term refers to the LOGICAL(KIND=1),
LOGICAL(KIND=2), LOGICAL (LOGICAL
(KIND=4)), and LOGICAL(KIND=8) data
types as a group.

Page 3 of 5
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Syntax Conventions

The Programmer's Guide uses certain conventions for language
syntax. For example, consider the following syntax for the
PARAMETER statement:

PARAMETER [(] c = expr [, c = expr ]...DI]

This syntax shows that to use this statement, you must specify the
following:

e The keyword PARAMETER

o An optional left parenthesis

e One or more c=expr items, where c is a named constant and
expr is a value; note that a comma must appear between
c=expr items.
The three dots following the syntax means you can enter as
many c=expr items as you like.

o An optional terminating right parenthesis

The dark teal brackets ([ ]) indicate that the optional parentheses
are an extension to standard Fortran.

Platform Labels

A platform is a combination of operating system and central
processing unit (CPU) that provides a distinct environment in which
to use a product (in this case, a language). For example, Microsoft®
Windows® 98 on x86 is a platform.

Information applies to all supported platforms unless it is otherwise
labeled for a specific platform (or platforms), as follows:

VMS | Applies to OpenVMS™ on Alpha processors.

U*X Applies to Tru64 UNIX® and Linux® on Alpha processors.

TU*X | Applies to Tru64 UNIX® on Alpha processors.
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WNT || Applies to Microsoft 2000 and Windows NT® 4.0 operating
systems on AMD and Intel® x86 processors, and 64-bit
Windows operating systems on Intel 1A-64 processors.

W9* | Applies to Microsoft Windows 98, Windows Millennium
Edition (Me), and Windows 95 operating systems on AMD
and Intel x86 processors.

Alpha | Applies to operating systems on Alpha processors.

1a32 Applies to 32-bit Windows operating systems on AMD and
Intel x86 processors (see "System Requirements and
Optional Software" in Compaq Visual Fortran Installing
and Getting Started).

1a64 Applies to 64-bit Windows operating systems on 1A-64
processors.
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Building Programs and Libraries

Visual Fortran includes the Microsoft visual development environment (also used
by the same version of Visual C++®) and associated Visual Studio software
development tools. This industry-leading environment makes it easy for you to
create, debug, and execute your programs. It includes a full-feature text editor,
debugger, and interactive help. You can build your source code into several
types of programs and libraries, either using the visual development
environment or working from the command line. For an introduction to this
environment, see Compaq Visual Fortran Installing and Getting Started.

This section describes how to use the visual development environment to define
a project, open and close a project workspace, and build a project:

e Overview of Building Projects

e Types of Projects you can build

e Defining Your Project and selecting project features with the visual
development environment

e Errors During the Build Process

e Compiler Limits

e Running Fortran Applications

o Copying Projects

¢ Visual Fortran Samples

For more information on:

e Building programs and libraries at the command line, see: Using the
Compiler and Linker from the Command Line and Using Visual Fortran
Tools.

e Using the Debugger, see Debugging Fortran Programs.

¢ Details about using the development environment, see the Visual C++
User's Guide.

Overview of Building Projects

The Microsoft Visual C++™ Development Environment (also called Developer
Studio) organizes development into projects. A project consists of the source
files required for your application, along with the specifications for building the
project. The build process involves defining your project, setting options for it,
and building the program or library.

Each project can specify one or more configurations to build from its source

files. A configuration specifies such things as the type of application to build, the
platform on which it is to run, and the tool settings to use when building. Having
multiple configurations lets you extend the scope of a project but still maintain a
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consistent source code base from which to work.

When you create a new project, the Microsoft visual development environment
automatically creates Debug and Release configurations for you. The default
configuration is the Debug configuration. To specify the current configuration,
select Set Active Configuration from the Build menu.

Projects are contained in a workspace. When you create a new project, you
indicate whether the project is created in a new workspace or an existing
workspace. To open an existing project, you open its workspace. A workspace
can contain multiple projects.

Once you open a workspace, the development environment displays a FileView
pane, which displays the files contained in the project, and lets you examine
visually the relationships among the files in your project. Modules, include files,
or special libraries your program uses are automatically listed as dependencies.
The output window displays information produced by the compiler, linker, Find
in Files utility, and the profiler.

You can specify build options in the Project menu Settings dialog box, for one of
the following:

e The entire project
e For certain configurations
e For certain files

For example, you can specify certain kinds of compiler optimizations for your
project in general, but turn them off for certain configurations or certain files.

Once you have specified the files in your project, the configurations that your
project is to build, and the tool settings for those configurations, you can build
the project with the commands on the Build menu.

In addition to using the visual development environment, you can also use the
command line (DF command). You can also develop the application from the
visual development environment and export a makefile for use in command-line
processing (NMAKE command). Your choice of development environment
determines what you can do at each stage.

The following diagram illustrates the development process for using the visual
development environment or command line:

Example of Development Process
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Notes in the diagram point to places where you can read more about a
particular part of the development process:

Building Programs and Libraries (the current chapter)

Using the Compiler and Linker from the Command Line

Using Visual Fortran Tools

The Floating-Point Environment and Handling Run-Time Errors
Debugging Fortran Programs

Profiling Code from the Command Line

Analyze Program Performance

NohkowNPE

For more overview information about building projects with the visual
development environment, see:

¢ How Information Is Displayed
¢ Menu Options
e Using the Shortcut Menu

How Information Is Displayed

The Microsoft visual development environment displays information in windows,
panes, and folders. One window can contain several panes, and each pane can
display one or more folders. A pane is a separate and distinct area of a window;
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a folder is a visual representation of files in a project. Folders show the order in
which Visual Fortran compiles the files, and the relationship of source files to
their dependent files, such as modules.

When you initially create a project, the Project Workspace window contains
some default panes, accessible through tabs at the bottom of the window, to
display information about the content of the project. You can also open an
output window, which has panes that display build output, debug output, Find in
Files output, and profiler output. In addition to the default panes, you can create
customized panes to organize and display project information in ways most
useful to you.

You can access information about components of the project from the panes in
the project window. Double-clicking any item in a pane displays that item in an
appropriate way: source files in a text editor, dialog boxes in the dialog editor,
help topics in the information window, and so on.

Be sure to select the appropriate pane when using the menu commands, in
particular the Save and Save As commands. Commands on the File menu affect
only the window that currently has the focus.

Menu Options

Menu options that are available to you may look different, depending on which
window or pane has current focus. The Debug menu, for example, is only visible
when you are debugging.

The visual development environment has the following menu bars and toolbars:

e Standard menu bar
e Standard toolbar

o Build toolbar

e Build minibar

e Resource toolbar

o Edit toolbar

e Debug toolbar

e Browse toolbar

e Fortran toolbar

e Controls toolbar

= ToO select or deselect the menu bars and toolbars:
¢ In the Tools menu, click Customize item

e Click the Toolbar tab
e Select (click) the toolbar name
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Using the Shortcut Menu

The project window has a shortcut menu that lists commands appropriate for
the current selection in the window. This is a quick method to display commands
that are also available from the main menu bar.

= To display the shortcut menu:

e« Move the mouse pointer into the project window and click the right mouse
button.

You can now select project commands that are appropriate for your current
selection in the project window.

Types of Projects

When you create the project, you must choose a project type. You need to
create a project for each binary executable file to be created. For example, the
main Fortran program and a Fortran dynamic-link library (DLL) would each
reside in the same workspace as separate projects.

The project type specifies what to generate and determines some of the options
that the visual development environment sets by default for the project. It
determines, for instance, the options that the compiler uses to compile the
source files, the static libraries that the linker uses to build the project, the
default locations for output files, defined constants, and so on.

You can build seven kinds of projects with Visual Fortran. You specify the project
type when you create a new project. They are summarized in the following
table:

Project Key Features

Type

Fortran Single window main projects without graphics (resembles

Console character-cell applications). Requires no special programming

Application expertise. For a Visual Fortran Sample of a Console

(.EXE) Application, see ...\ COMON Msdev98\ MYPRQIECTS\ CELSI US, as
described in "Opening an Existing Project” in Compaq Visual
Fortran Installing and Getting Started.
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Fortran Single window main projects with graphics. The programming
Standard complexity is simple to moderate, depending on the graphics
Graphics and user interaction used. Samples of Standard Graphics
Application Applications (QuickWin single window) resemble those for
(.EXE) QuickWin Applications (see below).

Fortran Multiple window main projects with graphics. The

QuickWin programming complexity is simple to moderate, depending on
Application the graphics and user interaction used. Samples of QuickWin
(.EXE) Applications (QuickWin multiple window) are in ...\ DF98

\ SAMPLES\ QUI CKW N, such as QWPIANO and QWPAINT.

Fortran Multiple window main projects with full graphical interface and
Windows access to all Win32 API routines. Requires advanced
Application programming expertise and knowledge of the Win32 routines.
(.EXE) Samples of Win32 Applications are in ...\ DF98

\ SAMPLES\ ADVANCED\ W n32, such as PLATFORM or POLYDRAW.

Fortran COM || Uses the Component Object Model (COM) to implement a
Server (.DLL) || COM server. COM supports client-server interaction between a
user of an object, the client, and the implementor of the
object, the server. Clients may be written in Visual Fortran
using the Fortran Module Wizard or in other languages, such
as Visual C++ and Visual Basic. Requires advanced knowledge
of COM. Samples of Fortran COM Server (and COM client)
applications are in ...\ DF98\ SAMPLES\ ADVANCED\ COM, such as
Adder.

Fortran Static || Library routines to link into .EXE files.
library (.LIB)

Fortran Library routines to associate during execution.
Dynamic-Link

Library
(.DLL)

The first four projects listed in the preceding table are main project types,
requiring main programs. The last two are library projects, without main
programs. The project types are discussed in detail in:

e Fortran Console Application

e Fortran Standard Graphics Application
e Fortran QuickWin Application

e Fortran Windows Application

e Fortran COM Server

e Fortran Static library
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e Fortran Dynamic-Link Library

When migrating legacy applications, choosing a project type that will minimize
porting effort depends on what the application does. A character-cell application
that does not use any graphics (such as a program ported from a UNIX system)
can usually be converted into a Fortran Console Application. When a legacy
Windows 3.1 (or older) application uses graphics calls, you can try a Fortran
Standard Graphics Application or a Fortran QuickWin Application project type.
However, be aware that with such legacy graphics applications:

e The routine names of certain legacy graphic QuickWin routines might need
to be changed to the current routine names (and their current argument
lists). For example, the following table lists some of known obsolete
routines and their supported replacement routines:

Obsolete QuickWin Routine Replacement Routine

SETGTEXTVECTOR SETGTEXTROTATION
GETGTEXTVECTOR GETGTEXTROTATION
GETHANDLEQQ GETHWNDQQ
WGGETACTIVE GETACTIVEQQ
WGSETACTIVE SETACTIVEQQ
INITIALMENU INITIALSETTINGS
SETTEXTROWS SETWINDOWCONFIG

e The character-oriented method of user interaction can be modernized with
menus, mouse clicks, and dialog boxes. If the routine uses the
PEEKCHARQQ routine, see the PEEKAPP or PEEKAPP3 Visual Fortran
Samples in the QuickWin folder.

After you select your project type, you need to define your project (see Defining
Your Project).

If you need to use the command line to build your project, you can:

o Initially use the visual development environment and later create a
makefile (see The Project Makefile)

e Use the DF command compiler options to specify the project type (see
Specifying Project Types with DF Command Options)

e Create the application from the DF command line (see Using the Compiler
and Linker from the Command Line)

Fortran Console Application Projects
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A Fortran Console application (.EXE) is a character-based Visual Fortran
program that does not require screen graphics output. It looks similar to a
program running on a UNIX® workstation or a terminal connected to a
mainframe computer.

Fortran Console projects operate in a single window, and let you interact with
your program through normal read and write commands. Console applications
are better suited to problems that require pure numerical processing rather than
graphical output or a graphical user interface. This type of application is also
more transportable to other platforms than the other types of application.

Fortran Console applications can be faster than Fortran Standard Graphics or
Fortran QuickWin graphics applications, because of the resources required to
display graphical output (see Using the Console).

Any graphics routine that your program calls will produce no output, but will
return error codes. A program will not automatically exit if such an error occurs,
so your code should be written to handle this condition.

With a Fortran Console project, you can use static libraries, DLLs, and dialog
boxes, but you cannot use the QuickWin functions. You can select the
multithreaded libraries with this and all of the other Fortran project types.

As with all Windows command consoles, you can toggle between viewing the
console in a window or in full-screen mode by using the ALT+ENTER key
combination.

A sample Fortran Console project is Celsius (see \ \YPPRQJECTS\ CELSI US), as
described in "Opening an Existing Project” in Compaq Visual Fortran Installing
and Getting Started or Defining Your Project.

Fortran Standard Graphics Application Projects

A Fortran standard graphics application (.EXE) is a Visual Fortran QuickWin
program with graphics that runs in a single QuickWin window. A standard
graphics (QuickWin single document) application looks similar to an MS-DOS
program when manipulating the graphics hardware directly, without Windows.

A Fortran standard graphics application allows graphics output (such as drawing
lines and basic shapes) and other screen functions, such as clearing the screen.
Standard Graphics is a subset of Quickwin, sometimes called Quickwin single
window. You can use all of the QuickWin graphics functions in these projects.
You can use dialog boxes with these and all other project types (see Using

Dialogs).

You can select displayed text either as a bitmap or as text. Windows provides
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APIs for loading and unloading bitmap files. Standard graphics applications
should be written as multithreaded applications. (For information about
multithreaded programs, see Creating Multithread Applications.)

Fortran standard graphics (QuickWin single document) applications are normally
presented in full-screen mode. The single window can be either full-screen or
have window borders and controls available. You can change between these two
modes by using ALT+ENTER.

If the resolution selected matches the screen size, the application covers the
entire screen; otherwise, it is a resizable window with scroll bars. You cannot
open additional windows in a standard graphics application. Standard graphics
applications have neither a menu bar at the top of the window, nor a status bar
at the bottom.

Fortran standard graphics applications are appropriate for problems that:

e Require numerical processing and some graphics
e Do not require a sophisticated user interface

When you select the Fortran standard graphics project type, the visual
development environment includes the QuickWin library automatically, which
lets you use the graphics functions. When building from the command line, you
must specify the /libs:gwins option. You cannot use the run-time functions
meant for multiple-window projects if you are building a standard graphics
project. You cannot make a Standard Graphics application a DLL.

For more information about Standard Graphics (QuickWin single window)
applications, see Using Quickwin.

Fortran QuickWin Application Projects

Fortran QuickWin graphics applications (.EXE) are more versatile than standard
graphics (QuickWin single document) applications because you can open
multiple windows (usually called multiple-document interface or MDI) while your
project is executing. For example, you might want to generate several graphic
plots and be able to switch between them while also having a window for
controlling the execution of your program. These windows can be full screen or
reduced in size and placed in various parts of the screen.

QuickWin library routines lets you build applications with a simplified version of
the Windows interface with Visual Fortran. The QuickWin library provides a rich
set of Windows features, but it does not include the complete Windows
Applications Programming Interface (API). If you need additional capabilities,
you must set up a Windows application to call the Win32 API directly rather than
using QuickWin to build your program. For more information on QuickWin
programming, see Using QuickWin.
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Fortran QuickWin graphics applications (.EXE) have a multiple-document
interface. Applications that use a multiple-document interface (MDI) have a
menu bar at the top of the window and a status bar at the bottom. The
QuickWin library provides a default set of menus and menu items that you can
customize with the QuickWin APIs. An application that uses MDI creates many
"child" windows within an outer application window. The user area in an MDI
application is a child window that appears in the space between the menu bar
and status bar of the application window. Your application can have more than
one child window open at a time.

Fortran QuickWin applications can also use the DFLOGM.F90 module to access
functions to control dialog boxes. These functions allow you to display, initialize,
and communicate with special dialog boxes in your application. They are a
subset of Win32 API functions, which Windows applications can call directly. For
more information on using dialog boxes, see Using Dialogs.

When you select the Fortran QuickWin project type, the visual development
environment includes the QuickWin library automatically, which lets you use the
graphics functions. QuickWin applications should be written as multithreaded
applications. (For information about multithreaded programs, see Creating
Multithread Applications.)

When building from the command line, you must specify the /libs:qwin compiler
option to indicate a QuickWin application (or /libs:qwins option to indicate a
Fortran Standard Graphics application). A Fortran QuickWin application that uses
the compiler option is similar to a Fortran Standard Graphics application in that
it has no menu bar or status bar. (A Fortran Standard Graphics application is a
QuickWin application with a set of preset options that is offered in the program
types list for your convenience.)

As with a Fortran Standard Graphics application, the application covers the
entire screen if the resolution selected matches the screen size; otherwise, it is
a resizable window with scroll bars.

You cannot make a Fortran QuickWin application a DLL.

For information on how to use QuickWin functions, including how to open and
control multiple windows, see Using Quickwin.

Fortran Windows Application Projects

Fortran Windows applications (.EXE) are main programs selected by choosing
the Fortran Windows Application project type. This type of project lets you calls
the Windows APIs directly from Visual Fortran. This provides full access to the
Win32 APIs, giving you a larger (and different) set of functions to work with
than QuickWin.



Building Programs and Libraries Page 11 of 58

Although you can call some of the Win32® APIs from the other project types,
Fortran Windows applications allow you to use the full set of Win32 routines and
use certain system features not available for the other project types.

The DFWIN.F90 module contains interfaces to the most common Win32 APIs. If
you include the USE DFWIN statement in your program, nearly all of the Win32
routines are available to you. The DFWIN.F90 module gives you access to a full
range of routines including window management, graphic device interface,
system services, multimedia, and remote procedure calls.

Window management gives your application the means to create and manage a
user interface. You can create windows to display output or prompt for input.
Graphics Device Interface (GDI) functions provide ways for you to generate
graphical output for displays, printers, and other devices. Win32 system
functions allow you to manage and monitor resources such as memory, access
to files, directories, and 1I/0 devices. System service functions provide features
that your application can use to handle special conditions such as errors, event
logging, and exception handling.

Using multimedia functions, your application can create documents and
presentations that incorporate music, sound effects, and video clips as well as
text and graphics. Multimedia functions provide services for audio, video, file
1/0, media control, joystick, and timers.

Remote Procedure Calls (RPC) gives you the means to carry out distributed
computing, letting applications tap the resources of computers on a network. A
distributed application runs as a process in one address space and makes
procedure calls that execute in an address space on another computer. You can
create distributed applications using RPC, each consisting of a client that
presents information to the user and a server that stores, retrieves, and
manipulates data as well as handling computing tasks. Shared databases and
remote file servers are examples of distributed applications.

Writing Fortran Windows applications is much more complex than other kinds of
Visual Fortran projects. For more information on how to create Fortran Windows
applications, see Creating Windows Applications.

You can access the Windows API online documentation help file, Platform SDK,
included with Visual Fortran. You can also obtain information through the
Microsoft Developer Network. Microsoft offers Developer Network membership,
which includes a development library and a quarterly CD containing technical
information for Windows programming.

For information on calling Win32 routines, see Calling Win32 Routines.

Fortran Static Library Projects
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Fortran static libraries (.LIB) are blocks of code compiled and kept separate
from the main part of your program. The Fortran static library is one of the
Fortran project types.

Static libraries offer important advantages in organizing large programs and in
sharing routines between several programs. These libraries contain only
subprograms, not main programs. A static library file has a .LIB extension and
contains object code.

When you associate a static library with a program, any necessary routines are
linked from the library into your executable program when it is built. Static
libraries are usually kept in their own directories.

If you use a static library, only those routines actually needed by the program
are incorporated into the executable image (.EXE). This means that your
executable image will be smaller than if you included all the routines in the
library in your executable image. Also, you do not have to worry about exactly
which routines you need to include — the Linker takes care of that for you.

Because applications built with a static library all contain the same version of
the routines in the library, you can use static libraries to help keep applications
current. When you revise the routines in a static library, you can easily update
all the applications that use it by relinking the applications.

A static library is a collection of source and object code defined in the FileView
pane. The source code is compiled when you build the project. The object code
is assembled into a .LIB file without going through a linking process. The name
of the project is used as the name of the library file by default.

If you have a library of substantial size, you should maintain it in a dedicated
directory. Projects using the library access it during linking.

When you link a project that uses the library, selected object code from the
library is linked into that project’'s executable code to satisfy calls to external
procedures. Unnecessary object files are not included.

When compiling a static library from the command line, include the /c compiler
option to suppress linking. Without this option, the compiler generates an error
because the library does not contain a main program.

To debug a static library, you must use a main program that calls the library
routines. Both the main program and the static library should have been
compiled using the debug option. After compiling and linking is completed, open
the Debug menu and choose Go to reach breakpoints, use Step to Cursor to
reach the cursor position, or use the step controls on the Debug toolbar.
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Using Static Libraries

You add static libraries to a main project in the visual development environment
with the Add to Project, Insert Files option in the Project menu. You can enter
the path and library name in the Insert Files into Project dialog box with a .LIB
extension on the name. If you are using a foreign makefile, you must add the
library by editing the makefile for the main project. If you are building your
project from the command line, add the library name with a .LIB extension and
include the path specification if necessary.

For an example of a static library project, see the Visual Fortran Samples
folder ...\ DF98\ Sanpl es\ Sci gr aph\ Sci gr aph, which creates a static library.

To create a static library from the command line, use the /c compiler option to
suppress linking and use the LIB command (see Managing Libraries with LIB).

To create a static library from the visual development environment, specify the
Fortran Static Library project type.

Fortran Dynamic-Link Library Projects

A dynamic-link library (.DLL) is a source-code library that is compiled and linked
to a unit independently of the applications that use it. A DLL shares its code and
data address space with a calling application. A DLL contains only subprograms,
not main programs.

A DLL offers the organizational advantages of a static library, but with the
advantage of a smaller executable file at the expense of a slightly more complex
interface. Object code from a DLL is not included in your program's executable
file, but is associated as needed in a dynamic manner while the program is
executing. More than one program can access a DLL at a time.

When routines in a DLL are called, the routines are loaded into memory at run-
time, as they are needed. This is most useful when several applications use a
common group of routines. By storing these common routines in a DLL, you
reduce the size of each application that calls the DLL. In addition, you can
update the routines in the DLL without having to rebuild any of the applications
that call the DLL.

With Visual Fortran, you can use DLLs in two ways:
1. You can build a DLL with your own routines. In the visual development
environment, select Fortran Dynamic-Link Library as your project type.

From the command line, use the /DLL option with the DF command.

2. You can build applications with the run-time library stored in a separate
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DLL instead of in the main application file. In the visual development
environment, after you open a workspace:
o From the Project menu, click Settings to display the project settings
dialog box
o Click the Fortran tab
o Select the Library category
o In the Use Fortran Run-Time Libraries box, select DLL

From the command line, use the /libs:dll compiler option to build
applications with the run-time library stored in a separate DLL.

For more information about DLLS, see:

e Creating Fortran DLLs

Defining Your Project

To define your project, you need to:

Create the project

Populate the project with files

Choose a configuration

Define build options, including project settings
Build (compile and link) the project

ahLNPE

= TO create a new project:

1. Click the File menu and select New. A dialog box opens that has the
following tabs:
o Files
o Projects
o Workspaces
o Other Documents

2. The Projects tab displays various project types. Click the type of Fortran
project to be created. If you have other Visual tools installed, make sure
you select a Fortran project type. You can set the Create New Workspace
check box to create a new Workspace.

3. Specify the project name and location.

4. Click OK to create the new project. Depending on the type of project being
created, one or more dialog boxes may appear allowing you to only create
the project without source files or create a template-like source file.

If a saved Fortran environment exists for the Fortran project type being
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created, you can also import a Fortran environment to provide default
project settings for the new project (see Saving and Using the Project
Setting Environment for Different Projects).

This action creates a project workspace and one project. It also leaves the
project workspace open.

To discontinue using this project workspace, click Close Workspace from the File
menu.

To open the project workspace later, in the File menu, click either Open
Workspace or Recent Workspaces.

= To add files to an existing project:

e To add an existing file to the project:

1.
2.

3.

If not already open, open the project workspace (use the File menu).
In the Project menu, select Add to Project and click Select Files... from
the submenu.

The Insert Files into Project dialog box appears. Use this dialog box to
select the Fortran files to be added to the Project. To add more than
one file to the project, hold down the ctrl key as you select each file
name.

e To add a new file to the project:

1.
2.

3.

If not already open, open the project workspace (use the File menu).
In the Project menu, select Add to Project and click New... from the
submenu.

The New dialog box appears. Specify the file name and its location.
Click (select) the type of file (Fortran Fixed Format Source or Fortran
Free Format Source).

Click OK. The editor appears, letting you type in source code. The file
name appears in the FileView pane.

B To define a project from a set of existing or new source files:

ahONPE

On the File menu, click New...

Click the Projects tab.

Select the type of project.

Name the project.

Click OK. Depending on the type of project being created, one or more
dialog boxes may appear allowing you to only create the project without
source files or create template-like source files.

If a saved Fortran environment exists for the project type being created,
you can also import a Fortran environment to provide default project
settings for the new Fortran project (see Saving and Using the Project
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Setting Environment for Different Projects).

6. Add existing files and/or new files to the project.
To add an existing file to the project:

1. In the Project menu, select Add to Project and click Files... from the

submenu.

2. The Insert Files into Project dialog box appears. Use this dialog box to
select the Fortran files to be added to the Project. To add more than
one file to the project, hold down the ctrl key as you select each file

name.
To add each new file to the project:

1. In the Project menu, select Add to Project and click Select New... from
the submenu.

2. The New dialog box appears. Specify the file name and its location.

3. Click the type of file (Fortran Fixed Format Source or Fortran Free
Format Source).

4. Click OK. The editor appears allowing you to type in source code. The
file name appears in the FileView pane.

7. You can now select "Build filename" from the Build Menu to build your
application.

You need to add these kinds of files to your project:

e Program files with .F9O, .FOR, or .F extension

e A resource file with an .RC extension

o If your project references routines or data in a Fortran dynamic-link library
(DLL), you need to add the import library (.LIB file created while building
the DLL) as a file to your project (see Building and Using Dynamic-Link
Libraries)

For information on:

e How to use icon files, see Using QuickWin.

e Using binary files, see Files, Devices, and 1I/0 Hardware.

¢ Using the Dialog Editor, Graphics Editor, or other Resource Editors, see the
Visual C++ User's Guide.

For more information on defining and building projects, see:

e Files in a Project

¢ Selecting a Configuration

¢ Setting Build Options

¢ Specifying Consistent Library Types
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¢ Creating the Executable Program

Files in a Project

When you create a project, the Microsoft visual development environment
always creates the following files:

File Extension || Description

Project

workspace .DSW Stores project workspace information.

file

Project file .DSP Used to build a single project or subproject.

Contains environment settings for Visual Fortran,
Workspace such as window sizes and positions, insertion

. . .OPT . . . .
options file point locations, state of project breakpoints,
contents of the Watch window, and so on.

Directly modifying the .DSW and .DSP files with a text editor is not supported.

For information on creating (exporting) a makefile, see The Project Makefile.

When you create a project, you also identify a project subdirectory. If the
subdirectory does not exist, the visual development environment creates it.
Project files that the visual development environment creates are put into this
directory.

When you create a project, the visual development environment also specifies
subdirectories for intermediate and final output files for the various
configurations that you specify. These subdirectories allow you to build
configurations without overwriting intermediate and final output files with the
same names. The General tab in the Project Settings dialog box lets you modify
the subdirectories, if you choose.

If you have existing source code, you should organize it into directories before
building a project, although it is easy to move files and edit your project
definitions if you should later decide to reorganize your files.

If your program uses modules, you do not need to explicitly add them to your
project, they appear as dependencies (.mod files).

For a newly created project (before you request a Update Dependencies), the
visual development environment scans the file list for modules and compiles
them before program units that use them. The visual development environment
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automatically scans the added project files recursively for modules specified in
USE statements, as well as any INCLUDE statements. It scans both source files
(.FOR, .F, .F90) and the resource file (.RC), and adds all the files it finds to a
Dependencies folder. You cannot directly add or delete the files listed in this
folder.

Module files are a precompiled, binary version of a source file, stored as a .mod
file. When you change the source definition of a module, you can update

the .mod file before you rebuild your project by compiling that source file
separately by clicking (selecting) the file in the FileView pane and select Compile
from the Build menu.

To control the placement of module files in directories, use the /[no]lmodule
compiler option.

To control the search for module files in directories, use the /[nolinclude and
the /assume:source_include compiler options.

The Project Makefile

The visual development environment speeds and simplifies the task of building
programs and libraries outside of the visual development environment by
allowing you to export a makefile, which is a set of build instructions for each
project. Makefiles contain the names of the source, object, and library files
needed to build a program or library, plus the compiler and linker options
selected in the Project Settings dialog boxes.

The visual development environment updates the build instructions in internal
makefiles when you add or remove project files in the project window, and when
you make changes to the compiler or linker options in the Project Settings
dialog boxes. To get an updated version of a makefile, update project
dependencies (use the Build menu) and from the Project menu, select Export
Makefile. The makefile is used by the external program maintenance utility,
NMAKE.EXE.

You can edit the makefile generated by the visual development environment if
you need to perform unusual or exceptional builds. Remember, however, that
once you have edited a makefile, exporting the makefile again from the visual
development environment will overwrite your changes.

If you use a foreign makefile for a project, the visual development environment
calls NMAKE to perform the build. You can run NMAKE from the console
command line to perform builds either with makefiles exported by the visual
development environment or with foreign makefiles that you have edited. For
more about the external program maintenance utility, see Building Projects with
NMAKE.
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Note: When you use a foreign makefile, the project is considered to be
foreign. You cannot use the Project Settings dialog box to make changes to
the build options, or use the Add to Project dialog box to add files.

Selecting a Configuration

A configuration defines the final binary output file that you create within a
project. When you create a new project, the visual development environment
creates the following configurations:

Debug By default, the debug configuration sets project options to
configuration include the debugging information in the debug
configuration. It also turns off optimizations. Before you can
debug an application, you must build a debug configuration
for the project.

Release The release configuration does not include the debugging
configuration information, and it uses any optimizations that you have
chosen.

Select the configuration in the Build menu, Set Active Configuration item. Only
one configuration can be active at one time.

When you build your project, the currently selected configuration is built:

e If you selected the debug configuration, a subfolder called Debug contains
the output files created by the build for the debug version of your project.

o If you selected the release configuration, a subfolder called Release
contains the output files created by the build for the release version of your
project.

A configuration has the following characteristics:

e Project type: specifies the type of Fortran application to build, such as a
Fortran Static Library, Fortran Console application, Fortran QuickWin
application, Fortran Windows application, and so on.

e Build options: specifies the build options, which include the compiler and
linker options (project settings).

Although debug and release configurations usually use the same set of source
files, the information about project settings usually differs. For example, the
default debug configuration supplies full debug information and no
optimizations, whereas the default release configuration supplies minimal debug
information and full optimizations.

You can also define new configurations within your project. These configurations
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can use the existing source files in your project, the existing project settings, or
other characteristics of existing configurations. A new configuration does not
have to share any of the characteristics or content of existing configurations,
however.

You could, for instance, create an initial project with debug and release
configurations specifying an application for the Win32 environment, and add
source files to the project. Later, within the project, you could create debug and
release configurations specifying a DLL for the Win32 environment, add an
entirely disjoint set of files to this configuration, and make these configurations
dependencies of the application configurations.

Platform Types

The platform type specifies the operating environment for a project. The
platform type sets options required specifically for a given platform, such as
options that the compiler uses for the source files, the static libraries that the
linker uses for the platform, the default locations for output files, defined
constants, and so on. Visual Fortran supports the Win32 platform type.

For more information:

e On viewing and changing the project build options for the current
configuration, use the Project settings dialog box (see Setting Build
Options).

e On errors during the build process, see Errors During the Build Process.

Setting Build Options

When you create a new configuration, you specify options for file creation and
build settings by selecting the Settings item in the Project menu.

For the currently selected configuration of a project, the Project Settings dialog
box (see Categories of Compiler Options) allows you to specify the compile and
link options, optimization, or browse information.

Configurations have a hierarchical structure of options. The options set at the
configuration level apply to all files within the configuration. Setting options at
the configuration level is sufficient for most configurations. For instance, if you
set default optimizations for the configuration, all files contained within the
configuration use default optimizations.

However, you can set different options for files within a configuration, such as
specific optimization options — or no optimization at all — for any individual files
in the configuration. The options that you set at the file level in the configuration
override options set at the configuration level.
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The FileView pane shows the files associated with the project configuration and
allows you to select certain files.

You can set some types of options, such as linking or requesting browse
information, only at the configuration level.

You can set options at the following levels within a configuration:

Any options set for the current configuration apply to every
Configuration | file in the configuration unless overridden at the file level.
level Options set for the configuration apply to all actions, such as
compilation, linking, and requesting browser information.

Any options set for a file apply only to that file and override
File level any options set at the configuration level. Options set for
selected files apply to file-level actions, such as compiling.

You can insert both source files (.FOR, .F90, .F, .Fl, .FD) and object files (.OBJ)
by using the Project menu Add to Project, Files item.

You should always insert all source files used by your application into the
project. For example, when you update a source file, the next time you build
your application, the visual development environment will create a new object
file and link it into your project.

You should also insert the names of any necessary static libraries and DLLs
with .LIB extensions to be linked with your project. Use only the library names,
not the names of any files within the libraries.

If you have installed the same version of Microsoft Visual C++ and Visual
Fortran (in the same directory tree), you can include C/C++ source code files. If
the same version of Microsoft Visual C++ is not installed, include C/C++ object
code instead.

You can set and save project settings as described in the following sections:
e Compile and Link Options for a Configuration or Certain Files

¢ Saving and Using the Project Setting Environment for Different Projects
e Source Browser Information for a Configuration

Compile and Link Options for a Configuration or Certain Files
You can set compiler or linker options by using the Project Settings dialog box.

B To display the Project Settings dialog box:
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1. Open your project workspace.
2. In the Project menu, click Settings.

The Fortran tab of this dialog box presents options grouped under different
categories. Select the category from the Category drop-down list:
Project Settings HE

Win32 Debug j General | Debug  Fortran | CAC++ | Lirk: { EE

-[#] CELSIUS FOR Categons: [ General iz |

Settings Far:

Code Generation

: Compatibility -
‘wiaming Lg Compilation Diagnostics :I'

.. . |Debug
Optimizatio) £ utemal Procedures
Floating Point

Predefined Fortran Data

[T Generate Source Browse Information

Froject Options:

Adoampile_only Adebug: full dfinclude:"'Debug’ frologo ;I
Amodule:"Debugs’ fobject."'Debug'
/pdbfile;"'Debug/DFED.FOB" LI

] I Cancel |

You can choose compiler and linker options through the various categories in
the Fortran and Link tabs. For details about the compiler options, see Categories
of Compiler Options.

If a compiler option is not available in the Project Settings dialog box you can
enter the option in the lower part of the window under Project Options: just as
you would using the command line.

The FileView pane shows the files associated with the project configuration and
lets you select certain files. The options that you set at the file level in the
configuration override options set at the configuration level. Linking options only
be applied at the configuration level (not the file level).

The linker builds an executable program (.EXE), static library (.LIB), or
dynamic-link library (.DLL) file from Common Object File Format (COFF) object
files and other libraries identified in the linker options. You direct the linker by
setting linker options either in the visual development environment, in a build
instructions file, or on the console command line. For example, you can use a
linker option to specify what kind of debug information to include in the program
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or library.

For more information on compiler and linker options, see Compiler and Linker
Options.

Saving and Using the Project Setting Environment for Different
Projects

You can set any of the compiler or linker options described in Compiler and
Linker Options in the Project menu, Settings dialog box. The Fortran tab of this
dialog box presents several categories of options to set.

Visual Fortran provides a facility to save and re-use the Project settings for
multiple projects of the same project type. For example, you can save your
Project settings environment for a Fortran QuickWin project and use those

saved settings as defaults when you create a new Fortran QuickWin project

type.

The saved Fortran environment project settings are those associated with the
Fortran tab and the displayed tool tab(s) in the Project Settings dialog box. You
can:

e Save a Fortran project settings environment for an existing project
e Use a previously saved project settings environment for a new project
¢ Manage the current set of saved Fortran environment settings

= TO save a project settings Fortran environment:

1. Open the appropriate workspace.

2. Modify the Project Settings dialog box as needed. If you specify actual file
names for output files, consider changing them to use the default file
naming conventions.

3. In the File menu, click Save Fortran Environment or click the green tree on
the Fortran toolbar. A window resembling the following dialog box appears:

Saving a Project Settings Environment

Save Fortran Console Environment |

— Current Settings

| Linker I

Releagze:

Aoompile_only Anclude:"Release"' snologo ﬂ

Debug:

T T T T T T T T T T E T Bl
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LT IS, LT U LT IS, LTI S GU IS DTy F LS. — I

Ainchude: ' Debug’ fmologo Atraceback

=

Esisting 5 aved Fortran Conzole calldocdl ;I
Ervironments: [duplicates are 7] debugtest

zafearray LI
Comment bo be azsociated :I
with Enviranment;

=
Save Fortran Conzole :
Ervviranment as: IEEISlus
| Save Environment I Cancel |

4. The Tool Combo box allows you to view the project settings for either the
Fortran or the displayed tools (such as Linker). The Release and Debug
configuration values are displayed for the selected tab. Verify that the
displayed values are acceptable.

5. The edit box titled Saved Fortran Console Environment allows you to
specify the name of the environment to be saved.

6. Click the Save Settings button to save the settings as a project settings
environment.

= To use an existing Fortran environment when creating a new project:

1. If a Fortran environment exists for the specified new Fortran project type,
you will be asked whether you want to apply project settings options from
a saved Fortran environment. If you click Yes, a window resembling the
following dialog box appears:

Using an Existing Fortran Project Settings Environment

Fortran Environment |

— Default Settings

T ool =
doompile_only fnologo Awarm:nofileopt Aibe: quin ﬂ
Feleaze:

I

Debug: doompile_aonly Anologo a_’warn:nnfilecupt a’debu_g:full .-"_Dl:ltil'l'liZEZD ﬂ
Awarnargument_checking Acheck:bounds Alibz:quin

Lizt af QuickMin Environmments: Inm j

Tools: Fartran j
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foompile_only Anclude: "R eleases"" bz gwin Anologo J
Releaze: |Awarn:nofileopt

fcheck:bounds Acompile_only Adebugifull fnclude:'Debug,™ J
Debug:  |Alibs:gwin Anologe Aoptimize:2 Asarn: argument_checking
Awarrnobileopt J

Apply | Cancel

2. For the selected Fortran project type, a list of saved Fortran environments
appears. Select a Fortran environment. Verify that the selected
environment is correct by viewing the Project Settings options.

3. After selecting the appropriate Fortran environment for the Fortran project
being created, click the Apply button to use the saved settings for the new
project.

4. Complete other tasks associated with creating a new project, such as
adding source files, and so on.

= TO manage saved Fortran environments:

1. In the Tools menu, click Managed Saved Fortran Environment or click the
saw on the Fortran toolbar. A dialog box resembling the following appears:

Managing Saved Fortran Project Settings Environments

/ Manage 5aved Fortran Environments

Console
calldocdll
debugtest
zafearay

Cluickain

OEnEnc
platfarm

N I

Delete | Digplay Environments with Duplicate Settings | |

| ak | Canel |
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2. Initially, this dialog box displays the project types for which there are saved
Fortran environments. Double-click on the project type name to view the
saved Fortran environments for that project type.

This dialog box allows you to display the Fortran environments associated
with each project type. Double-click the name of a project type to display
the Fortran environments associated with that project type.

3. To display the project settings for a Fortran environment:
o Click the name of a Fortran environment.
o View the project settings for the Fortran tab.
o Click the other tool tab (such as Linker) and view that tool's project
settings.
o If needed, click (select) a different Fortran environment.
4. To determine whether a duplicates exist for a Fortran environment:
o Click (select) the name of an environment or a project type.
o Click the Display Environments with Duplicate Settings button.
o If the Fortran environments have different project settings, No
Duplicates Found is displayed.
o If the Fortran environments have identical project settings, the
duplicate environments are displayed.
5. To delete a Fortran environment:
o Click (select) the name of an environment or the project type.
o Click the Delete button.
o Click OK to the delete confirmation box.

Source Browser Information for a Configuration

The Source Browser generates a listing of all symbols in your program;
information that can be useful when you need to debug it, or simply to maintain
large volumes of unwieldy code. It keeps track of locations in your source code
where your program declares, defines, and uses names. You can find references
to variables or procedures in your main program and all subprograms it calls by
selecting one of the files in your project, then using the Go to Definition or Go to
Reference button on the Browse toolbar. Source Browser information is
available only after you achieve a successful build.

Browser information is off by default for projects, but you can turn it on if you
wish. To set the browse option for the current configuration:

e In the visual development environment:

1. In the Project menu, click Settings.

2. In the General category of the Fortran tab, set the Generate Source
Browse Information check box.

3. Click the Browselnfo tab and set the Build Browse info check box.
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Click OK.

Build your application.

In the Tools menu, click Source Browser.

Near the bottom on the Browse window, locate the Case sensitive
check box. Since Fortran is a case-insensitive language, make sure
the Case sensitive check box is clicked off.

8. When you are done using the Browse window, click OK. The Browse
window allows you to view graphs of calling relationships between
functions and view the symbols contained within the file, and perform
other functions.

NO O

e On the command line:

1. Specify the /browser option.

2. Use the Browse Information File Maintenance Utility (BSCMAKE) utility
to generate a browse information file (.BSC) that can be examined in
browse windows in the visual development environment.

When the browse option is on, the compiler creates intermediate .SBR files
when it creates the .OBJ files; at link time, all .SBR files in a project are
combined into one .BSC file. These files are binary, not readable, but they are
used when you access them through the Browser menu.

Specifying Consistent Library Types

There are a number of Visual C++ run-time libraries that offer the same entry
points but have different characteristics. The default Visual C++ library is
libc.lib, which is single threaded, non-debug, and static. The Visual C++ and
Visual Fortran libraries must be the same types. The incompatible types are:

e Mixing single-threaded with multi-threaded versions of the libraries
e Mixing static and dynamic-link versions of the libraries
e Mixing debug with non-debug versions of the libraries

The default Fortran libraries depend on the project type:

Fortran Project Default Libraries Used

Type

Fortran Console Static, single-threaded libraries dfor.lib and libc.lib
Fortran Standard Static, multithreaded libraries dformt.lib and libcmt.lib
Graphics

Fortran QuickWin Static, multithreaded libraries dformt.lib and libcmt.lib
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Fortran Windows Static, multithreaded libraries dformt.lib and libcmt.lib

Fortran DLL Dynamic-link libraries dfordll and msvcrt (and their
import libraries)

Fortran Static Library | Static, single-threaded libraries dfor.lib and libc.lib

Pure Fortran applications can have mismatched types of libraries. One common
scenario is a Fortran QuickWin application that links with a Fortran Static library.
Fortran QuickWin (and Fortran Standard Graphics) applications must use the
static, multithreaded libraries, and by default, Fortran Static libraries are built
using static, single-threaded libraries. This causes a conflict, so the Fortran
Static library and the QuickWin application must both be built using static,
multithreaded libraries.

Similarly, different C/C++ applications link against different C libraries. If you
mix the different types of applications without modifying the defaults, you can
get conflicts. The debug version of a library has a letter "d" appended to its base
file name:

e Static, single-threaded: libc.lib and libcd.lib
e Static, multithreaded: libcmt.lib and libcmtd.lib
e Dynamic-link libraries: msvcrt and msvcrtd (.lib import library and .dll)

When using a Debug configuration, Visual C++ selects the debug libraries.
Visual Fortran does not select debug libraries for any configuration, but provides
a Project Settings option to request their use. To specify different types of
Fortran libraries in the visual development environment, open the Project
Settings dialog box, click the Fortran tab, and select the Libraries category:

e To specify static libraries, select the appropriate type of static (non-DLL)
library under Use Run-Time Libraries (see /libs:static).

e To specify dynamic-link libraries, select the appropriate type of DLL library
under Use Run-Time Libraries (see /libs:dll).

e To specify multithreaded libraries, select the appropriate type of Multi-
thread library under Use Fortran Run-Time Libraries (see /threads).

e To specify the debug libraries, select the appropriate type of Debug library
under Use Run-Time Libraries (see /[no]dbglibs). If you specify debug
libraries (/dbglibs) and also request DLL libraries (/libs:dll) (Use Run-Time
Libraries that include both Debug and DLL), be aware that this combination
selects the debug versions of the Fortran DLLs. These Fortran DLL files
have been linked against the C debug DLLs.

e When you specify QuickWin or Standard Graphics libraries under Use Run-
Time Libraries, this selection implicitly requests Multi-threaded libraries.

For details about the Visual C++ libraries used and compiler options available,
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see Visual Fortran/Visual C++ Mixed-Language Programs.

Creating the Executable Program

When you are ready to create an executable image of your application, select
the Build menu. You can:

e Compile a file without linking

e Build a project

e Rebuild all parts of a project

e Batch build several configurations of a project

o Clean extra files created by project builds

o Execute the program, either in debug mode or not
o Update program dependencies

e Select the active project and configuration

o Edit the project configuration

o Define and perform profiling

When you have completed your project definition, you can build the executable
program.

When you select Build projectname from the Build menu (or one of the Build
toolbars), the visual development environment automatically updates
dependencies, compiles and links all files in your project. When you build a
project, the visual development environment processes only the files in the
project that have changed since the last build.

The Rebuild All mode forces a new compilation of all source files listed for the
project.

You either can choose to build a single project, the current project, or you can
choose multiple projects (requires batch build) to build in one operation.

You can execute your program from the visual development environment using
ctrl+F5 or Execute from the Build menu (or Build toolbar), or from the command
line prompt.

Compiling Files In a Project

You can select and compile individual files in any project in your project
workspace. To do this, select the file in the project workspace window (FileView
tab). Then, do one of the following:

e Press Ctrl+F7.
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e Choose Compile from the Build menu (or Build toolbar).

e Click the right mouse button to display the pop-up menu and select
Compile.

You can also use the ctrl+F7 or Compile from the Build menu (or Build toolbar)
options when the source window is active (input focus).

Errors During the Build Process

Compiler and linker errors are displayed in the Build pane of the output window.
If the Output window is not displayed, in the View menu, click Output.

To quickly locate the source line causing the error, follow these steps:

1. Double-click the error message text in the Build pane of the output
window.

_Or_

2. Press F4. The editor window appears with a marker in the left margin that
identifies the line causing the error. You can continue to press F4 to scroll
through additional errors.

If you need to set different compiler options for some of your source files, you
can highlight the source file name and select the Project menu, Settings item.
Options set in this manner are valid only for the file you selected.

After you have corrected any compiler errors reported during the previous build,
choose Build from the Build menu. The build engine recompiles only those files
that have changed, or which refer to changed include or module files. If all files
in your project compile without errors, the build engine links the object files and
libraries to create your program or library.

You can force the build engine to recompile all source files in the project by
selecting Rebuild All from the Build menu. This is useful to verify that all of your
source code is clean, especially if you are using a foreign makefile, or if you use
a new set of compiler options for all of the files in your project.

If your build results in Linker errors, be aware that the project type selected and
the project settings in the Libraries category (see Categories of Compiler
Options) determine the libraries linked against. Also, you can specify additional
user-created libraries.
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B To view the include file and library directory paths in the visual
development environment:

1. In the Tools menu, click Options.
2. Click the Directories tab.
3. In the drop-down list for Show Directories For, select Include files and view

the include file paths.
4. In the drop-down list for Show Directories For, select Library files and view

the library paths.
5. Click OK if you have changed any information.

= To view the libraries being passed to the linker in the visual
development environment:

1. If not already open, open your Project Workspace (File menu, Open
Workspace).

2. In the Project menu, click Settings.

3. Click the Link tab

4. In Link tab's Project Options box, type the following option:

/verbose:lib

5. Click OK. The next time you build the project, the list of libraries will be
displayed with other build-related messages in the output pane (bottom of
screen).

If you have trouble linking CXML libraries, see also Using CXML from Visual
Fortran.

With the Professional and Enterprise Editions, if you have trouble linking IMSL
libraries, specify the /imsl option and see Using the IMSL Libraries from Visual
Fortran.

If you encounter linker errors, see Linker Diagnostic Messages and Error
Conditions.

To view a description of build and run-time messages, see Error Messages or, in
the visual development environment, highlight the error identifier (such as
LNK2001) in the output pane and press F1.

Compiler Limits

The following table lists the limits to the size and complexity of a single Visual
Fortran program unit and to individual statements contained in it.

The amount of data storage, the size of arrays, and the total size of executable
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programs are limited only by the amount of process virtual address space
available, as determined by system parameters:

Language Element Limit
Actual number of arguments per CALL | No limit
or function reference

Arguments in a function reference in a || No limit
specification expression

Array dimensions 7

Array elements per dimension

9,223,372,036,854,775,807 or
process limit

Constants; character and Hollerith

2000 characters

Constants; characters read in list-
directed 1/0

2048 characters

Continuation lines

511

DO and block IF statement nesting
(combined)

128

DO loop index variable

9,223,372,036,854,775,807 or
process limit

Format group nesting

8

Fortran source line length

132 characters

INCLUDE file nesting 20 levels
Labels in computed or assigned GOTO | 500

list

Lexical tokens per statement 3000
Named common blocks 250
Parentheses nesting in expressions 40
Structure nesting 20

Symbolic name length

63 characters
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Running Fortran Applications

You can execute programs built with this version of Visual Fortran only on a
computer running the Microsoft Windows 2000, Windows NT, Windows Me, or
Windows 9x operating system. You can run the programs from the command
console, Start ... Program ... group, Windows Explorer, and the Microsoft visual
development environment.

Each program is treated as a protected user application with a private address
space and environment variables. Because of this, your program cannot
accidentally damage the address space of any other program running on the
computer at the same time.

Environment variables defined for the current user are part of the environment
that Windows sets up when you open the command console. You can change
these variables and set others within the console session, but they are only valid
during the current session.

If you run a program from the console, the operating system searches
directories listed in the PATH user environment variable to find the executable
file you have requested. You can also run your program by specifying the
complete path of the .EXE file. If you are also using DLLs, they must be in the
same directory as the .EXE file or in one specified in the path.

You can easily recover from most problems that may arise while executing your
program.

If your program is multithreaded, Windows NT and Windows 2000 starts each
thread on whichever processor is available at the time. On a computer with one
processor, the threads all run in parallel, but not simultaneously; the single
processor switches among them. On a computer with more than one processor,
the threads can run simultaneously.

If you specified the /fpscomp:filesfromcmd option (Compatibility category in
Project Settings, Fortran tab), the command line that executes the program can
also include additional filenames to satisfy OPEN statements in your program in
which the filename field (FILE specifier) has been left blank. The first filename
on the command line is used for the first such OPEN statement executed, the
second filename for the second OPEN statement, and so on. In the visual
development environment, you can provide these filenames in the Project menu
Settings item, Debug tab, in the Program Arguments text box.

Each filename on the command line (or in a visual development environment
dialog box) must be separated from the names around it by one or more spaces
or tab characters. You can enclose each name in double quotation marks
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(filename™), but this is not required unless the argument contains spaces or
tabs. A null argument consists of an empty set of double quotation marks with
no filename enclosed ().

The following example runs the program MYPROG.EXE from the console:

MYPROG "" OUTPUT. DAT

Because the first filename argument is null, the first OPEN statement with a
blank filename field produces the following message:

File name missing or blank - please enter file nane<R>
UNI T number ?

The number is the unit number specified in the OPEN statement. The filename
OUTPUT.DAT is used for the second such OPEN statement executed. If
additional OPEN statements with blank filename fields are executed, you will be
prompted for more filenames. Programs built with the QuickWin library prompt
for a file to open by presenting a dialog box in which you can browse for the file
or type in the name of a new file to be created.

Instead of using the /fpscomp:filesfromcmd option, you can:

o Call the GETARG library routine to return the specified command-line
argument. To execute the program in the visual development environment,
provide the command-line arguments to be passed to the program in the
Project menu Settings item, Debug tab, in the Program Arguments text
box.

e Call the GetOpenFileName Win32 routine to request the file name using a
dialog box. For an example of how to call the GetOpenFileName routine,
see the Visual Fortran Sample GetOpenFileName in ... Df 98
\ Sanpl es\ Advanced\ W n32\ Get OpenFi | eNane.

If you use the visual development environment debugger and need to specify a
working directory that differs from the directory where the executable program
resides, specify the directory in the Project menu Settings item, Debug tab, in
the Working Directory text box.

Run-time error messages are displayed in the console or in a message box
depending upon the project type of the application you build (see Run-Time
Message Display and Format). If you need to capture these messages, you can
redirect stderr to a file. For example, to redirect run-time error messages from a
program called BUGGY.EXE to a file called BUGLIST.TXT, you would use the
following syntax:

BUGGY. EXE > BUGLI ST. TXT

The redirection portion of the syntax must appear last on the command line.
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You can append the output to an existing file by using two greater-than signs
(>>) instead of one. If the file does not exist, one is created. For more
information about command-line redirection, see Redirecting Command-Line
Output to Files.

To run (deploy) your application on another Windows system, use the VFRUN
tool to install the necessary run-time DLLs and related files. The VFRUN tool
provides the run-time redistributable files for Visual Fortran applications, in the
form of a self-installing kit. You can download the run-time redistributable files
VFRUN kit from the Visual Fortran Web page (click Downloads area). VFRUN and
the deployment of Visual Fortran applications is further described in the Compaq
Visual Fortran Installing and Getting Started guide.

For more information:

e On using the debugger with Fortran programs, see Debugging Fortran

Programs.
e Locating errors in the debugger, see Locating Run-Time Errors in the

Debugger.

e On locating the source of exceptions, see Locating Run-Time Errors and
Using Traceback Information.

e On handling run-time errors with source changes, see Methods of Handling
Errors

e On environment variables recognized during run-time, see Run-Time
Environment Variables

e On each Visual Fortran run-time message, see Run-Time Errors

Copying Projects

You need to follow certain procedures to move a project’s location, whether you
copy a project to:

e Another disk or directory location on the same PC system
e Another PC system where Visual Fortran is also installed

= TOo copy an existing Visual Fortran project to another disk or system:

1. Copy all project files to the new location. You do not need to copy the
subdirectories created for each configuration.

Keep the folder/directory hierarchy intact by copying the entire project tree
to the new computer. For example, if a project resides in the folder
\ MyPr oj ect s\ Proj app on one computer, you can copy the contents of that
directory, and all subdirectories, to the \ MyPr oj ect s\ Pr oj app directory on
another computer.

2. After copying all of the files, delete the following files from the main
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directory at the new location. These files are disk- and computer-specific
and should not be retained:

o *.opt files

o *.ncb files (if present)

3. After copying the files, if you copied the subdirectories associated with each
configuration, you need to delete these contents of subdirectories at the
new location, such as the Debug and Release subdirectories. The files
contained in these subdirectories are disk- and computer-specific files and
should not be retained. For example, Visual Fortran module (.MOD) files
contained in these subdirectories should be recreated by the Visual Fortran
compiler, especially if a newer version of Visual Fortran has been installed.
The internal structure of module files can change for Visual Fortran
releases.

If you copied the project files to the same system or a system running the
same platform or major Visual Fortran version, do the following steps to
remove most or all of the files in the configuration subdirectory:

o Open the appropriate project workspace. In the File menu, either
select Open Workspace or select Recent Workspaces. If you use Open
Workspace, select the appropriate .DSW file.

o For each configuration, select the appropriate configuration by
selecting Set Active Configuration in the Build menu.

o For the current configuration, select Clean in the Build menu.

o Repeat the previous two steps for other configurations whose
subdirectories have been copied.

4. If you copied the project from a PC running a Visual Fortran 5, you should
open the project at its new location using Visual Fortran 5, before you
convert the project to Visual Fortran Version 6 format.

If you open a project created with Visual Fortran 5 with Visual Fortran
Version 6, Visual Fortran 6 will convert the project to Visual Fortran Version
6 format. Converting the project back to Version 5 format is not easily
performed (must be done manually).

If possible, open the project under Visual Fortran Version 5 after you move
it, before you convert the project to Version 6 format. This ensures that the
project has been moved successfully and minimizes the chance of
conversion problems. An alternative is to make an archive copy of the
Visual Fortran 5 project files before you open and convert the project to
Visual Fortran Version 6 format.

5. View the existing configurations. To view the existing configurations
associated with the project:

o Open the project workspace. In the File menu, either select Open
Workspace or select Recent Workspaces. If you use Open Workspace,
specify the appropriate .DSW file (navigate to the appropriate project
directory and double-click the .DSW file).

o Select Configurations from the Build menu.
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6.

o View the available configurations. You can also remove or add
configurations.
If you copied the project to a PC running a different platform, specify new
configurations.

If you copied the project to the same system or to a system where the
same major version of Visual Fortran is installed that uses the same
platform, you may not need to create any new configurations.

If you copy the files to a different platform, opening the project reveals
that the target platform is still set to the original platform. Although this is
not obvious, you can tell this is so because the Build, Compile, and Execute
options are grayed out in the Build menu. Before you can build the
application on the new platform, you must first specify one or more new
configurations for the project on the new platform.

To create Debug and Release targets for this project, you create a new
configuration while running Visual Fortran on the new platform. The
platform for a new configuration is assumed to be the current platform.
This same behavior applies when moving projects between any two
platforms.

To create a new project configuration:

a. In the Configurations dialog box, click the Add button. The Add Project
Configuration dialog box appears.

b. In the Configuration box, type a new configuration name. The names
do not matter, as long as they differ from existing configuration
names.

c. Select the configuration from which to copy the settings for this
configuration and click OK. Usually, you will want to copy the settings
from a similar configuration. For example, if this new configuration is a
release configuration, you will usually copy settings from an existing
release configuration.

d. The Projects dialog box appears with the new project configuration.
Repeat the process as necessary to create as many configurations as
you need.

7. Check and reset project options.

Because not all settings are transportable across different disks, systems,
or platforms, you should verify your project settings on the new platform.
To verify your project settings:

a. From the Project menu, choose Settings. The Project Settings dialog
box appears.

b. Review the tabs and categories to ensure that the project settings you
want are selected. Pay special attention to the following items:
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= General Tab — Review the directories for intermediate and output
files. If you moved the project to a different system, be aware
that any absolute directory paths (such as c.\ TEMP or
\ Mypr oj \ TEMP) will most likely need to be changed. Instead, use
relative path directory names (without a leading back slash),
such as Debug.

= Custom Build Tab — Review for any custom commands that might
change between platforms.

» Fortran and Linker tabs — Nonstandard options in the original
configurations must be replicated (as applicable) in the new
configurations.

For example, if you moved a project from a Windows NT Alpha
system running Visual Fortran 6.5A or earlier, a few Alpha-only
compiler options are either not needed (such
as /synchronous_exceptions and /granularity) or are not
available on ia32 systems (such as /rounding_mode, /pipeline,
and /math_library:accurate). You also might find new compiler
options that might benefit your application (see Compiler
Options).

» Pre-link and Post-build Step tabs — Review for any custom
commands that might change between platforms.

8. If you are copying your project between systems, check your source code
for directory paths referenced in INCLUDE or similar statements.
Developer Studio provides a multi-file search capability called Find in Files,
available from the Edit menu.

Visual Fortran Samples

On the Visual Fortran media CD-ROM, Samples are located in folders under
I nf o\ Df \ Sanpl es. After a Custom installation, the Samples are installed by default
in folders under .. . \Mcrosoft Visual Studio\Df 98\ Sanpl es.

You can view and copy the source code samples for use with your own projects.
Use a text editor to view the sample programs (Samples); they are not listed as
topics in HTML Help Viewer.

If you do not install Samples, you can copy appropriate Samples folders or files
from the Visual Fortran CD-ROM to your hard disk (remove the Read-Only
attribute file property for the files copied).

For a description (roadmap) of the Samples, see Roadmap to the Visual Fortran
Samples (Samples.htm) or in a Web browser open the file Samples.htm (use
File menu, Open). The following table shows where to locate Samples.htm and
the Samples on the Visual Fortran CD-ROM (at any time) or on your hard disk
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(after installation):

To Locate: Look:
Roadmap to the On the Visual Fortran CD-ROM, open the file:
Samples | nf o\ Df \ Sanpl es\ Sanpl es. ht m

On your hard disk (after installation), open the file:
...\ Mcrosoft Visual Studio\Df 98\ Sanpl es\ Sanpl es. ht m

Samples folders On the Visual Fortran CD-ROM, locate folders under:
| nf o\ Df \ Sanpl es

On your hard disk (after installation), locate folders
under:
...\ Mcrosoft Visual Studio\Df98\ Sanpl es

For example, after a Custom installation, the ...\ Df 98\ Sanpl es\ Tutori al folder
contains short example programs, called Tutorial samples. The Tutorial samples
describe (as source comments) how they can be built. Unlike other samples, all
Tutorial samples are contained in a single directory.

Longer sample programs are also provided in their own subdirectories and
include a makefile (for command-line use) as well as the source files. Many
samples include a project workspace file, allowing you to open the project
workspace in the visual development environment, view the source files in the
FileView pane, build the sample, and run it.

Samples for the Compaq Array Visualizer (Professional and Enterprise Editions)
are located in folders under ...\ ArrayVisualizer\ Sanpl es.

For a description of the Samples, see the Roadmap to the Visual Fortran
Samples.

Roadmap to the Visual Fortran Samples

The Visual Fortran kit provides a number of source code sample programs
(samples) that cover a variety of topics. These samples are provided for
illustration purposes only, although they can be freely used as a basis for other
programs. You can copy the samples as needed. Use a text editor to view the
samples; they are not listed as topics in HTML Help viewer.

On the Visual Fortran media CD-ROM, samples are located in folders under
I nf o\ Df \ Sanpl es. If you request that samples be installed using a Custom
installation, the samples are by default installed in subdirectories

under ...\ Mcrosoft Visual Studio\Df98\Sanples.



Building Programs and Libraries Page 40 of 58

Visual Fortran samples include the following:

Advanced Samples:
o Samples Using Component Object Model
o Samples Showing Direct Fortran 90 Descriptor Manipulation
o Samples Using OpenGL®
o Samples Using Win32 API Calls
e Dialog Box Samples
e DLL Samples
e Exception Handling
¢ ISO Varying Strings
¢ Mixed-Language Programming Samples
e QuickWin Programming Samples
o Includes the Postmini graphical postprocessing software, which can be
used to examine the output of a number of process, device and circuit
simulation (TCAD) programs, as well as import data from ASCII files.
¢ Scientific Graphing (SciGraph) Utility Samples
e Tutorial Samples (illustrate Fortran language constructs)
e Miscellaneous Samples:
o Includes a sample that converts data files created by Lahey Fortran to
unformatted files which can be read by CVF

Advanced

Within the Advanced category, there are several other categories of samples.
Each category is described below, and the specific samples within each are
described in its section. Each category is contained within its own subdirectory
of ...\ Df 98\ Sanpl es\ Advanced:

Samples using Component Object Model (advanced\com)
Samples Showing Direct Fortran 90 Descriptor Manipulation
(advanced\descript)

e Samples Using OpenGL (advanced\opengl)

Samples Using Win32 API Calls (advanced\win32)

Component Object Model (Advanced\ Com)

The COM samples demonstrate use of the Component Object Model from within
Visual Fortran:

e adder: The Adder sample demonstrates a Fortran COM server and its use
by Visual Fortran, Visual C++, and Visual Basic clients. The COM server
implements a very simple "adding machine" object. Each client displays a
dialog box that uses the server. Adder is used as an example in Creating a
COM Server.

e autodice: The autodice sample demonstrates interactions between Fortran
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and Excel 97. This program takes 12 numbers and uses Automation to tell
Excel 97 to draw a histogram of the numbers. The EXCEL97A module
generated by the Fortran Module Wizard is used as the interface to EXCEL.
You must have Microsoft Excel 97 installed on your computer in order to
successfully run this sample.

e dlines: The dlines sample demonstrates interactions between Fortran and
the Developer Studio. This program converts Debug lines to IFDEF
directives (metacommands). It uses COM to drive Microsoft Developer
Studio to edit the source file.

The COM interfaces defined in DSAPP.F90 are taken from:
...\Mcrosoft Visual Studio\Common\Mdev98\ Bi n\devshl.dlI
The COM interfaces defined in DSTEXT.F90 are taken from:
...\ Mcrosoft Visual Studio\Comobn\Msdev98\Bi n\ devedit. pkg

The dlines sample program is invoked with the following command line:
dl i nes i nputsource outputsource debugchar ifdefname

Where: Inputsource is the filename of the input source file. Note: The
source file must be fixed form.

outputsource is the filename of the output source file.

debugchar is the the debug character in the source file to replace
with IFDEF directives (metacommands)

ifdefname is the name to use with the IFDEF directives

This program is useful as a tool to edit PowerStation Fortran files that used
something other than "C" or "D" as the comment character.

e dsbuild: The dsbuild sample demonstrates using Automation to drive
Developers Studio to rebuild a project configuration.

The Automation interfaces defined in DSAPPA.F90 are taken from:
...\Mcrosoft Visual Studio\Comopn\Mdev98\Bi n\devshl.dlI

The Automation interfaces defined in DSBLDA.F90 are taken from:
...\ Mcrosoft Visual Studi o\ Common\ Msdev98\ Bi n\ devbl d. pkg

The dsbuild program is invoked with the following command line:
dsbuil d project.dsw configuration

Where: project.dsw is the file specification of the project file.

configuration is the name of the configuration to rebuild.

e ErrorInfo: The Errorinfo sample demonstrates a Fortran COM Server that
supports COM Errorinfo objects. For information about COM Errorinfo
objects, see Adding Support for COM Errorinfo Objects and the Platform
SDK online documentation.

e iweb: The iweb sample uses the COM interfaces in SHDOCVW.DLL to start
a Web Browser and direct the browser to navigate to a specified URL. The

iweb program is invoked with the following command line:
iweb url
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Where: url is the URL to display
Any arguments not provided on the command line will be prompted for.

e safearray: The safearray sample demonstrates converting a Fortran two-
dimensional array to a COM SafeArray and reading the data back from the
SafeArray.

e Variant: The variant sample demonstrates using the VARIANT
manipulation routines in Visual Fortran. VARIANTs are used in COM
interfaces.

Direct Fortran 90 Descriptor Manipulation (Advanced\ Descri pt)

In other languages, such as C or Pascal, pointers are simple memory addresses
with no notion of how the information is organized at the address pointed to.
Fortran 90 pointers differ dramatically, by not just containing a memory
address, but also keeping track of the bounds and strides of each dimension of
an array. To accomplish this, the Fortran 90 compiler uses something called an
Array Descriptor, which stores the details of how the array is organized. Array
Descriptors may also be called Dope Vectors in other implementations.

By manipulating the contents of a descriptor directly, you can perform
operations that would otherwise not be possible in strict Fortran 90. You can
associate a Fortran 90 pointer with any piece of memory, organized in any way
desired (so long as it is rectangular in terms of array bounds). You can also pass
Fortran 90 pointers to other languages, such as C, and have the other language
correctly interpolate the descriptor to obtain the information it needs. Important
for mixed-language programming, you can create a Fortran 90 pointer
associated with an array which is accessed in C's row order, rather than
Fortran's traditional column order, allowing the same array to be used with the
same subscripts from both C and Fortran.

The descript workspace has three subprojects. Each creates its own executable,
and there are no dependencies between them:

e cassign: A Fortran 90 pointer is associated with a C array, in row order.
This pointer is then passed back to Fortran, which reads the values written
by C in exactly the same way that C wrote them. This project uses
descript.h, which provides the C prototypes, routines, and structure
definitions to the Fortran 90 pointers.

o fassign: A Fortran 90 pointer is associated with a Fortran 90 array, in row
order, and then passed to a C routine which can read the array in natural C
notation.

e cube: Through use of the Bitmap module a Fortran 90 pointer is created
that points to an internal .BMP file, with its special structure (rows
reversed). Once this pointer is setup, the .BMP can be written to directly
and then quickly displayed on a QuickWin child window. This method is
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used to show a flicker-free spinning cube.
OpenGL (Advanced\ Opengl )

OpenGL is a protocol for performing advanced 3-dimensional graphics. Visual
Fortran includes Fortran 90 modules and link libraries for using OpenGL from
Fortran. The sample programs included in this section illustrate programs that
take advantage of these facilities.

All OpenGL samples will run under Windows NT, Windows 2000, Windows Me,
and Windows 98, but require the OSR2 release of Windows 95 to run there.
Refer to our Frequently Asked Questions at
http://www.compag.com/fortran/visual/fag.html for more information.

e 3dcube: The 3dcube sample displays a three-dimensional box on a black
background. It uses QuickWin to create the window and draw the shapes
using primitive 3D graphics.

e olympic: The olympic sample displays 5 rings on a window that rotate and
move towards each other, ultimately creating the Olympic symbol. It
illustrates calls to the OpenGL libraries, techniques for supporting code on
32- and 64-bit systems, techniques for reading arguments from the
command line, and interface blocks, among other Fortran 90 concepts. This
sample must be compiled with /fpscomp:logicals due to a difference in the
way that Visual Fortran and Microsoft PowerStation Fortran interpret logical
values. It must also be linked against the QuickWin libraries.

e puzzle: The puzzle sample displays a Rubik's Cube, and allows you to try
and solve it. There is currently a problem with the colors in this sample. It
uses Win32 calls to manage the windowing interface. Again, it illustrates
techniques for supporting code on 32- and 64-bit systems.

e simple: The simple sample displays some points, lines, and simple shapes
in a window. It uses QuickWin to manage the windowing interface. It is, as
it sounds, a very simple example, using primitive 2-D graphics. One
interesting aspect of it is the use of color and how to set some of the
standard colors.

e wave: The wave sample displays a window with a surface waving. It uses
QuickWin to manage the windowing interface. Beyond the usage of
OpenGL, here are many interesting demonstrations in this sample,
including the animation and the trapping of characters typed while the
window has focus. The keys that are trapped are:

o C, which changes the contour of the wave

o [space], which pauses the animation. To resume, hit space again
o S, which changes the shading of the wave

o A, which causes the wave to spin. To stop spinning, hit A again

o L, which changes the color of the wave.

Win32 API Calls (Advanced\ W n32)



Building Programs and Libraries Page 44 of 58

Visual Fortran includes Fortran 90 modules and libraries for doing Windows
programming at the Win32 API level. For information on calling Win32 routines
from a Fortran application, see Calling Win32 Routines. These samples
presented here show Win32 APl examples of how this is done:

e angle: The angle sample uses the Windows interface to manage the GUI.
It illustrates a basic Windows program, including the event dispatcher, and
the use of pens and dialog boxes. The angle sample displays a shape
consisting of a straight line plus an arc, and allows the user to input X,Y
coordinates, angle of the arc, and radius of the arc, and then redraws.

e bounce: The bounce sample uses Win32 calls but creates a console
application, rather than a Windows based one. It is a multi-threaded
application that creates a new thread whenever the letter "A" is typed, up
to a maximum of 32. Each thread bounces a happy face of a different color
across the screen. All threads are terminated when the letter "Q" is typed.
This particular application requires that several compatibility switches be
set: /fpscomp:logicals, /fpscomp:ioformat, /fpscomp:general. These are
found under the Compatibility entry on the Fortran tab of the Project
Settings dialog box.

e check_ sd: The check sd sample illustrates the use of security descriptors.
The purpose of the sample is to assist people who want to manipulate
security descriptors with sample code that they can start from. This
sample, as is, examines the security descriptor on files, and could be easily
modified to check the security descriptor on other objects. To use this
sample, check_sd with no arguments checks the security descriptors on the
A: device. check_sd d:\a.fil will check the d:\a.fil file. In this case, D: must
be formatted with the NTFS file system because only NTFS files have
security descriptors.

o cliptext: The cliptext sample demonstrates copying text to and from the
clipboard. It uses the Windows interface to manage the GUI, and as such,
also demonstrates the use of WinMain and MainWndProc that contains the
event dispatcher. It has an "about"” box, located under the File menu item,
as there is no Help.

o cmndlg: The cmndlg sample demonstrates the use of common dialog
boxes, including "About”, File access dialogs, and error message dialogs.
Each dialog box is demonstrated being used in three different ways:
standard, using a modified template, and using a hook function. Cmndig
displays "Hello World" in a window, and allows the user to change the text
and colors, etc.

e consolec: The consolec sample demonstrates the use of the
SetConsoleTxtAttribute and GetConsoleScreenBufferInfo APIs to set or get
the console text color attributes. This is a console application that is linked
against dfwin.lib. If no arguments are passed to consolec, it prints out a
color sample in a command window. The arguments are FOREGROUND
color and BACKGROUND color, and the valid options are BLACK, BLUE,
GREEN, CYAN, RED, MAGENTA, YELLOW or WHITE. The color argument
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passed must be in uppercase, or an error will be output.

e crypto: The crypto sample demonstrates using the Cryptography API to
encrypt and decrypt files.

e cursor: The cursor sample demonstrates how to manipulate a cursor and
select a region. It uses the Windows interface to manage the GUI. The
program will either let the user draw boxes (regions) or will calculate 1027
prime numbers when RETURN is entered. During that calculation, the
cursor is turned into an hourglass.

e drives: The drives sample determines all drives on the system, both local
and remote, and determines their file system type. This is a console
application that links against dfwin.lib.

e event: The event sample demonstrates the basic concepts involved when
using asynchronous 1/0. It reads one file asynchronously and writes
another synchronously. This is a console application that links against
dfwin.lib and requires two arguments, the input file and output file. This
executable transfers one file to another. Refer to the readme.txt for
information on how to set it up in the Developer Studio.

e exitwin: The exitwin sample demonstrates how to shut down applications.
When run, it will ask whether you want to continue, as it will log you off.
Optionally, you can compile it to reboot the system. This is a Windows
application that uses Windows to manage the GUI.

o floppy: The floppy sample demonstrates how to access a physical floppy
disk using the Win32 API set. It has two major functions:

1. It can be used to display the geometry of a disk, floppy -g a:

2. It can be used to produce a disk image or to write a disk image to a
floppy, floppy -c a: bootdisk (produces a disk image of a:) or floppy -c
bootdisk a: (make a: identical to bootdisk image).

This is a Fortran Console program that is linked against dfwin.lib.

e generic: The generic sample demonstrates the basic concepts required in
building a Windows application and could be used as a basis for building a
first Windows program. The specific features that generic implements are:

Custom icon

Standard Menu Bar

Standard Help Menu

Full WinHelp Support

Keyboard Accelerator Usage

. Version Control Information

e getdev: The getdev sample demonstrates the GetDeviceCaps() API. Also,
in this sample, the main window is a dialog box, and all the interesting
code is in the window procedure for that dialog box. This is different than
many of the other Windows-based samples, which use MainWndProc to
handle the events.

e getopenfilename: The getopenfilename sample demonstrates the use of
the APl GetOpenFileName(). When run, it brings up a dialog box listing
either text files or Fortran files in the project directory. It also gives you the

2Rl A
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option of opening the file read-only.

e getsys: The getsys sample demonstrates the APIs GetSysColor(),
GetSystemDirectory(), GetSystemlInfo(), GetSystemMetrics(),
GetSystemPaletteEntries(), and GetSystemTime(). Also, in this sample, the
main window is a dialog box, and all the interesting code is in the window
procedure for that dialog box. This is different than many of the other
Windows-based samples, which use MainWndProc to handle the events.

e inherit: The inherit sample demonstrates inheritance of file handles from
one process to a child process. It also demonstrates the use of anonymous
pipes as stdout and stderr replacements. It contains two projects, child and
inherit. The inherit project creates inherit.exe, which can be run without
the other project. To run inherit, specify two parameters:

1. Trace file to write stdout and stderr
2. Command to execute

The inherit program is run within QuickWin so that it can be a "console-
less" parent. Otherwise, there are configuration problems when trying to
pipe.

To use this sample, first set the current project to child and build it, then
set the current project to inherit and build it. Before you run it, read the
readme.txt file in the project; this will tell you what changes you need to
make to your project configuration in order to run this sample.

e iNnput: The input sample is a basic Windows application that does very
general processing on mouse button events and keyboard events. It
demonstrates how input messages are received, and what additional
information comes with the message. When run, it displays the current
pointer location, whether the right or left mousebutton was clicked, and
outputs a message based on a 5 second timer.

e maskblt: The maskblt sample is intended to demonstrate masked bit block
transfers. It is unclear that it is working correctly, either in its current form,
or as received from Microsoft. However, it does demonstrate basic calls to
functions that support bitmaps and keyboard accelerators used by
clipboard functions.

e MDI: The MDI sample demonstrates the multiple document interface. It
creates a simple window that can create child windows within itself. It also
can set the titles on these child windows.

e menu: The menu sample demonstrates the use of popup menus, user
defined menus and menu functions. It is a very simple program that allows
you to select items off a menu, invoke a pop-up menu, and basically do
little else, but is a good example of how to start with menus.

e mlitithrd: The mlititrhd sample demonstrates the use of multiple threads.
The main routine, mltithrd.f90, has a brief guide to writing multi-threaded
applications at the top of the file. It uses the multi-document interface to
create child windows, and bounces colored traces through each one.

e Output: The output sample demonstrates using TextOut() and DrawText()
to write to a window. It is a very simple sample, outputting text and a few
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simple shapes, such as a rectangle, ellipse, and pie-wedge.

e owncombo: The owncombo sample demonstrates the use of functions and
messages for combo boxes and owner-draw control styles. It brings up a
window and lets you play with the different combo box styles.

e paths: The paths sample demonstrates the use of paths and clipping
regions. A path is one or more figures or shapes that are filled, outlined, or
both filled and outlined. Paths are used in various drawing and painting
applications. This sample demonstrates how 6 different types of paths can
be set up. With this release, when the application first runs, the window is
too small for the titles on the paths, and must be manually resized.

e platform: The platform sample demonstrates some very simple menu
choices, and the popup dialog boxes that you can create from them. This
sample displays "menus" that give you information about which platform
you are running on.

e plgdraw: The plgdraw sample demonstrates the PIgBIt() APIl. The PIgBIt
function performs a bit-block transfer of the bits of color data from the
specified rectangle in the source device context to the specified
parallelogram in the destination device context. The sample displays a
rendered version of the contents of the middle grid in the leftmost grid.

e polydraw: The polydraw sample demonstrates capturing mouse clicks and
movement, and combining that with some keyboard input (the Ctrl or Shift
keys). It is a very simple program that allows the user to draw lines,
curves, and move some points around on the screen.

e process: The process sample demonstrates creating and terminating
processes from within another program. The user interface is very simple,
a dialog box with two buttons "Create" and "Terminate"”, and window with
the list of created processes.

e registry: The registry sample demonstrates the Registry API. This sample
displays information from the system registry, allowing the user to traverse
the various trees. It is a fairly simple sample, but could be used as an
example.

e select: The select sample demonstrates how to manipulate a cursor and
select a region. This sample has two projects under it:

1. Select, which provides a dynamic link library (dll) of routines for
selecting a region

2. Demo, which contains an executable program that uses the select
library above.

To use this sample, first set select as the current project and build
select.dll, then set demo as the current project to build the executable.

e setinfo: The setinfo sample demonstrates how to set the attributes of a
file. It has a simple interface, allowing the user to enter a filename in an
edit field. The GetInfo button will retrieve information about the file and
display it. To set file information, modify the values in the Time and Date
edit fields, and click the Setinfo button. To set file attributes, set the
appropriate check boxes and click on the SetAttr button.

This sample also demonstrates the use of the GetFileTime() and
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SetFileTime() API calls.

e sharemem: The sharemem sample demonstrates the use of named
shared memory between two independent processes. There are two
projects in this sample, sharemem and othrproc. These can be built in
either order; neither depends on the other. To use this sample, first start
Sharemem, then start Othrproc. (Note, this is best done outside of
Developer Studio.) The visual effect is better if the focus remains with
Othrproc, while the mouse moves with Sharemem. A "shadow" mouse is
displayed on Othrproc with the same coordinates as the mouse on
Sharemem.

e Startp: The startp sample demonstrates various CreateProcess()
parameters, including starting processes in a given priority class. This is
very similar to the "start" command but with added functionality. It is best
run from outside Developer Studio, but when run from within Developer
Studio, will give usage information in a console window.

e streblt: The streblt sample demonstrates the use of the StretchBlt
function. This Block Transfer function goes beyond a simple BitBIt, giving
the option of stretching or compressing a bitmap to fit a different area in
the destination device context.

e subclass: The subclass sample demonstrates subclassing of standard
windows controls, such as button, edit field, and list box. It allows the user
to create an arbitrary number of child controls on the main window. These
controls are subclassed, and the subclass procedure provides the user a
way to move and size the controls. A menu item switches in and out of
"Test Mode". When this is on, the subclass procedure passes all message
through to the standard procedure, and the controls act just like normal.

e takeown: The takeown sample demonstrates how to give an Administrator
access to a file that has been denied to all. It must be run from an
Administrator account. There is a sample file provided named takeown.txt
which may be used by the sample.

e termproc: The termproc sample demonstrates how to terminate a
process, given its process id. Although this can be built within the
Developer Studio, it is best run from the command line.

e threads: The threads sample demonstrates suspending, resuming, and
setting the priorities of threads. The display shows two threads, red and
green, which draw paths across the window. There are menu items to
suspend, resume, and set the priority of the two threads. Caution, if the
priority of one or the other of the threads is set too high little else will run
on the system.

e timers: The timer sample demonstrates the use of the SetTimer() and
KillTimer() APIs. It creates 4 rectangles on its window, each with a different
and inverts the color whenever the timer goes off. This sample
demonstrates two timer mechanisms.

e tls: The tls sample demonstrates multiple threads calling into a single DLL.
It also demonstrates the use of DLLEXPORT to export entry points from a
DLL, rather than using .DEF files. The tls sample has two projects, tisdll
and tls. The workspace is configured such that the tls project is dependent
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on the tisdll project. If you build tls, it will automatically build tisdll. When
running, each thread is blocked waiting for the user to click OK in a
message box. The thread may be running in a minimized window.

e Virtmem: The virtmem sample demonstrates the use of various virtual
memory APIs. The sample has a main window with menu items that will
modify a set page to have different attributes. In order to write to memory,
the page must be committed and set to read/write access. Attempting to
write to a read only page will cause an access error, "memory cannot be
read".

e world: The world sample demonstrates scaling and translating an image
from a metafile with world coordinate transforms. It uses the calls
SetWorldTransform() and PlayEnhMetaFile() to do the linear transformation
between world space and page space, and to play the enhanced metafile.
The sample provides a single sample metafile, sample.emf, although others
could be used.

o wxform: The wxform sample demonstrates world transforms. It has three
dialog boxes that display help, track mouse movements, or allow the user
to enter transform information. The different quadrants of the screen have
different properties, as described in the help box. This sample also
demonstrates using messages to communicate between different window
procedures.

Dialog Boxes (Dialog)

The Dialog samples demonstrate several of the newer dialog controls available
through Visual Fortran. There is also a sample that demonstrates how to use
modeless dialog boxes. The dialog samples can be found in the

directory ...\ Df 98\ Sanpl es\ Di al og:

e CelsiCon: The CelsiCon sample is a Fortran Console application that uses a
dialog box. It uses an undocumented hook into the dialog initialization
event WM_INITDIALOG. It also sets special customizations on that dialog
box by using Win32 calls. With a simple modification to the source
program, it can also be built as a QuickWin application.

e dllprgrs: The dllprgrs sample demonstrates using the Visual Fortran Dialog
Procedures in a DLL. The public routines in the DLL can be called to:

o DisplayProgressBox — Display a dialog box containing a progress bar
o SetProgress — Set the current progress bar value
o DestroyProgressBox — Destroy the dialog box

o fxplorer: The fxplorer sample demonstrates an SDI Fortran Windows
application using the Visual Fortran Dialog Procedures. It uses an Internet
Explorer ActiveX control in the main window of the application. The
Internet Explorer control is installed with Internet Explorer. If Internet
Explorer is not installed, this sample will not run.

o mmplayer: The mmplayer sample demonstrates a dialog-based Fortran
Windows application using the Visual Fortran Dialog Procedures. It uses an
ActiveMovie control in the main window of the application. The ActiveMovie
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control is installed with Internet Explorer. If Internet Explorer is not
installed, this sample will not run.

e progress: The progress sample program demonstrates a "dialog-based"
Fortran application using the Visual Fortran Dialog Routines, including the
progress bar. The main window of the application is a dialog box. It
contains Start, Stop, and Exit buttons plus a progress bar. The Start button
begins a lengthy operation that is broken into 100 steps. In this simple
example, each step is sleeping for .25 seconds.

e showfont: The showfont sample demonstrates a "dialog-based" Fortran
application using the Visual Fortran Dialog Routines. The main window of
the application is a dialog box. This program demonstrates the use of a Tab
control. The Tab control is used to select the properties of a font. The font
is used to display a sample text string.

e therm: The therm program demonstrates a "dialog-based" Fortran
application using various Visual Fortran Dialog Routines, including several
that are new to CVF V6.0. The main window of the application is a dialog
box. This program uses a Spin control, a Slider control, a Progress bar
control, and Picture controls. It also demonstrates using multiple modeless
dialog boxes.

e Whizzy: The whizzy sample demonstrates many of the controls available
with the dialog manager module provided by Visual Fortran. Note that it is
built with the "Logical Values" compatibility switch set. This is required for
correct interaction with the dialog manager routines.

DLL Examples (DLL)

Within Visual Fortran you can create and use dynamically linked libraries (DLLS).
A DLL is loaded at run time by its calling modules (.EXE or .DLL). When a DLL is
loaded, it is mapped into the address space of the calling process. There are
generally two ways to bring in a DLL, either at image activation time or at run-
time. If an image is linked against the import library for a DLL the code is
mapped into the image's address space at image activation time. If the import
library is not available, the DLL needs to be mapped in with Windows API calls.
The following DLL examples can be found in subdirectories under ...\ Df 98

\ Sanpl es\ DLL:

e DLLEXP1: The DLLEXP1 sample demonstrates a workspace that contains
two projects: one that creates a DLL and a second that uses that DLL,
linking against the import library created by the first project. Note that for
the Fortran Console application to run, the DLL created by the first project
must be found somewhere along the PATH.

e DLLEXP2: The DLLEXP2 sample demonstrates how COMMON variables
defined in a DLL can be shared between multiple programs. Two programs
are built against the same DLL. The first program is run, and then PAUSEs.
The second program is run and changes the COMMON variables, and exits.
When the first program resumes, it displays the changed values.
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e LoadExpl: The LoadExpl sample demonstrates how to dynamically map a
DLL without using an import library. It is a workspace with two projects,
one the DLL and the other the executable that uses it.

Exception Handling (ExceptionHandling)

Visual Fortran Version 6.5 introduces some routines to make it easier for the
user to control floating-point exception handling:

e ClearFP: The ClearFP sample demonstrates CLEARSTATUSFPQQ, a
subroutine to clear the ia32 floating-point status word exception flags.

e Cslexcp2: The Cslexcp2 sample demonstrates exception and termination
handling in a Fortran Console application.

e Cslexcp4: The Cslexcp4 sample demonstrates how to wrap a Fortran entry
point inside a C try/except block to allow testing for exceptions that might
occur in the protected Fortran code.

e GetEptrs: The GetEptrs sample demonstrates how to establish a signal
handler with SIGNALQQ (or the C signal() function) and use the
TRACEBACKQQ and GETEXCEPTIONPTRSQQ Fortran library routines to
generate a traceback display from the handler.

e Winexcpl: The Winexcpl sample demonstrates exception handling in a
Fortran Windows application. It was based on the GENERIC sample, with
structured exception handling (SEH) incorporated.

e VBVF1: The VBVF1 sample demonstrates exception handling in a Visual
Basic application that calls a Visual Fortran DLL. This is an ia32-only
sample.

ISO Varying Strings (Isovar)

The Isovar samples demonstrate one possible implementation for the interface
to dynamic-length character strings in Fortran 95. The publicly accessible
interface defined by this module is conformant with the auxiliary standard,
ISO/IEC 1539-2: 1999. The Isovar samples are in separate directories

under ...\ Df 98\ Sanpl es\ | sovar and include:

e unittest: The unittest sample contains 80 small functions that test each of
the features of the ISO varying string module. Some of the features tested
are concatenation, assignment, and searching for a substring.

e vocab: The vocab sample uses the ISO varying string module to read a
text file and keep a list of each word found in the file and its frequency.
When the file is completely read, it prints out the word list and the
frequency of each word.

e wrdcnt: The wrdcnt sample uses the I1SO varying string module to read a
text file and keep count of how many words are seen. When the file is
completely read, it prints out the total number of words found in the file.
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Miscellaneous (Misc)

There are a number of miscellaneous samples that demonstrate some specific
aspects of Visual Fortran or its utilities. The following miscellaneous examples
can be found in separate subdirectories under ...\ Df 98\ Sanpl es\ M sc:

e calcaver: The calcaver sample demonstrates Fortran 90 features, including
an interface block, assumed shape array, and the use of modules. It does
have a Developer Studio workspace associated with it, or can be built using
nmake and the makefile.

e char2: The char2 sample demonstrates the use of the utility fsplit90. This
utility creates separate files for each program unit within a file. Once it has
been split, it is identical to charexmp. Build this sample using nmake.

e charexmp: The charexmp sample does some simple character handling,
generating arrays of the alphabet and outputting them to the screen. It has
a Developer Studio workspace associated with it, or it can be built using
nmake.

e console: The console sample demonstrates some of the basic console-
manipulating routines. Console sets the size of the console, clears the
console, and positions the cursor to write a line at the top of the console,
and again at a line further below. A DOS command prompt is an example
of a console.

e cvt_If _unf: The cvt_If _unf sample converts data files created with Lahey
Fortran to an unformatted binary file. There are two projects within this
sample:

o cvt_If _unf which builds the conversion utility
o test which uses cvt_If _unf to convert a data file created by Lahey
Fortran and then read it from CVF.

o fctrl: The fctrl sample is a very simple one, demonstrating recursion. It is a
console application, and computes and displays the factorials of the
integers 1 to 12. 13! is too big for a 32-bit integer. This sample can be built
either from within Developer Studio, or by using the makefile.

o fivt: The fivt sample is a basic Installation Verification program for Visual
Fortran. It compiles and links a program, and then reads the listing file to
make sure the expected version of the compiler was used. It can be
compiled and run from either the command line or the Developer Studio.
To run fivt from the command line, either set FORT5=FIVT.INP, or invoke it
as FIVT < FIVT.INP. To run from Developer Studio, refer to the
README.TXT file in that directory.

o forprint: The forprint sample is a console application that uses the
OpenFile and Print dialog boxes to select and print text files, including files
with Fortran carriage control. Forprint preprocesses the file, generating a
text file that can be printed by any printer. This sample can be built either
from within Developer Studio or by using the makefile.

o fppdemo: The fppdemo sample demonstrates the use of the Fortran
Preprocessor, FPP. FPP is a C-like preprocessor, as opposed to the
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preprocessing directives that are part of the Fortran 90 standard. It is
easiest to build using the makefile, but there is a Developer Studio
workspace for it. This workspace has 5 projects, one per variation of fpp
defines. It illustrates how to pass fpp flags to the compiler from the
Developer Studio; it must be done by hand from within the Settings dialog
box.

e mandel: The mandel sample demonstrates a simple Win32 application
with a C main program calling a Fortran subroutine.

e uopen: The uopen sample demonstrates the use of the USEROPEN
keyword from the OPEN statement. In this particular example, the Fortran
file calls a C program to do the specialized OPEN.

e Icinfo: The Icinfo sample demonstrates the use of NLS routines to support
some natural language extensions. It also demonstrates how the string
order is affected by choice of natural language. The Icinfo sample is a
console application that prints out information about what the different
language and currency settings are on the computer.

Mixed-Language (Mixlang)

Visual Fortran can be called by a number of other languages, including Visual
C/C++, Visual Basic, and MASM (Assembler). Also, it can call other languages,
such as C/C++. The following samples in subdirectories under ...\ Df 98

\ Sanpl es\ M xI ang demonstrate some of the calling standards or argument
definitions that must be used to effectively interwork with other languages:

e Cc_call _f: The C_Call_F sample demonstrates a mixed-language application
in which a C (or C++) main program calls a Fortran subroutine. It is
presented in two different styles; one where the Fortran and C code are
built together in the same project and one where the Fortran code is built
separately into a DLL which is then called from C. This sample also
demonstrates how to pass character/string arguments to Fortran.

e delphi: This ia32-only sample demonstrates various interactions between
Visual Fortran and Borland™ Delphi. Delphi must be installed to build and
run this sample:

o CallDVF: The CallDVF sample demonstrates calling Fortran from
Delphi. There are examples of an integer function, a REAL function,
and a character function.

e spline: The spline sample demonstrates mixed language programming
with Visual C/C++. Spline is easiest built from within Developer Studio. The
project contains four projects, Console, QuickWin, VC, and spldll. The last
project, spldll, creates the dll file used by the other projects.

The spline sample implements a "best fit curve" algorithm to a set of
coordinates. The coordinates are input by clicking on a window or through
a data file. Each of the first three projects within this workspace create a
different program, using different paradigms:

o Console creates an application that runs in a console window and
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takes input from a data file, fsplit.dat

o QuickWin creates an application using the QuickWin interface that
takes input from mouse clicks.

o VC creates an application using Visual C/C++ and the Microsoft
Foundation Classes that takes input from mouse clicks.

This workspace and its projects also demonstrate one method of dealing
with interproject dependencies. It copies the dependent .DLL file to the
local directory before linking and running the project.

e Vvb: This set of samples demonstrates various interactions between Visual
Fortran and Visual Basic (VB). In all cases, there is an executable that is
the VB program which you can run. There is also the VB Project, as well as
the Visual Fortran project available so you can modify them as you wish:

o arrays: The arrays sample demonstrates how to pass arrays of
strings from VB to CVF

o callback: The callback sample demonstrates how to invoke VB
callback routines passed to a CVF subroutine

o returnstring: The returnstring sample demonstrates how to call a
Fortran character string function from Visual Basic.

o simple: The simple sample shows very basic interactions between
Visual Fortran and VB, passing numbers from one to the other

o typearrays: The typearrays sample demonstrates how to pass an
array of user-defined types from VB to Visual Fortran, including how to
write into some fields of that type from within the Fortran routine.

e MASM: This set of ia32-only samples demonstrates various interactions
between Visual Fortran and MASM, Microsoft's Assembly Language. MASM
must be installed to build these samples:

o simple: The simple sample demonstrates the most simple call from
Fortran to MASM.

o vecprod: The vecprod sample demonstrates how to calculate the
inner product of two vectors in a MASM program. These two vectors
were passed from Fortran to MASM, and the result was passed back to
the Fortran main program.

o allocabl: The allocabl sample is a rewrite of vecprod using allocatable
arrays rather than static ones.

QuickWin (Quickwin)

Visual Fortran provides a library of routines called QuickWin. QuickWin is a
library that lets you build applications with a simplified version of the Windows
interface with Visual Fortran. The QuickWin library provides a rich set of
Windows features, but it does not include the complete Windows Applications
Programming Interface (APIl). If you need additional capabilities, you must set
up a Windows application to call the Win32 API directly rather than using
QuickWin to build your program. The following samples demonstrate how to use
QuickWin, and how to program around some of the strange paradigms of the
package.
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The following QuickWin examples can be found in subdirectories under ...\ Df 98
\ Sanpl es\ Qui ckW n:

e calendar: The calendar sample is a simple QuickWin application. It
displays a graphical monthly calendar for the current month.

e chaos: The chaos sample is a QuickWin application that demonstrates the
use of menus, dialog boxes for input and output, message boxes for the
signaling of error states, various ways of recovering from error conditions
and still keep the program running, QuickWin graphics routines, multi-
threading, and Fortran 90. There is a document in the CHAOS subdirectory,
README.TXT, that describes this program and its algorithms in more detail.

e cleanwin: This sample illustrates how to use native Windows APIs to
radically change the appearance of a standard QuickWin window.

e conapp: This sample demonstrates a method for creating a console
window from within a QuickWin application. The sample has two parts: a
DLL which creates the console window and performs 1/0 to or from it, and
a QuickWin program that calls that DLL. To allow the DLL to access the
console using units *, 5, and 6, this sample uses a technique not
recommended for any other use. The DLL is linked against the Fortran
dynamic-link libraries, but the QuickWin application is linked against the
Fortran static libraries. Generally this is discouraged, because using the two
different libraries means that the main program and the DLL cannot share
1/0 units. In this case, that is the intended outcome.

e dirkeys: This sample demonstrates a mechanism for passing directional
keys from QuickWin to the user's program.

o dirkeys2: This sample illustrates the use of a callback procedure (hook)
using SetWindowsHookEx for keyboard events. It demonstrates how to get
around the limitations of the PASSDIRKEYS routine, specifically how to trap
for Insert, Delete, and Ctrl-C keys.

e dirkeys4: This sample demonstrates the PASSDIRKEYSQQ routine. The
PASSDIRKEYSQQ routine allows easy access to the Insert, Delete, and Ctrl-
C keys.

e menudriv: This sample illustrates three programming idioms for use in
QuickWin applications. These are: using the menu to drive various
functions; getting control on EXIT; using the status bar to indicate program
progress.

e peekapp: This multi-threaded sample simulates a compute loop with
Peekchar and Getchar to handle input as it comes in character by
character. It is intended to be used within a QuickWin program.

e peekapp3: This multi-threaded sample is similar to peekapp, but contains
a procedure to perform an orderly shutdown on the character-reading
thread.

e poker: The poker sample demonstrates the use of QuickWin and some
simple controls on the window. This sample uses QuickWin to manage the
windowing interface, but uses some of the Win32 API calls, and must be
linked against dfwin.lib. It should be mentioned that the file CARDS.F90
takes a longer time to compile than any of the o ther files that make up the



Building Programs and Libraries Page 56 of 58

poker sample. Also, before building, you should make sure you update all
dependencies, as there are many.

e postmini: The Postmini graphical postprocessing software can be used to
examine the output of a number of process, device and circuit simulation
(TCAD) programs, as well as import data from ASCII files. This version of
PostMini uses QuickWin for the graphical interface. Other versions are
available for Compaq Tru64 UNIX and OpenVMS Alpha that use other
graphical interfaces. Refer to the README file in the PostMini directory for
details on this sample.

e gwpaint: The gwpaint sample demonstrates using mouse callbacks and
graphics routines in a QuickWin application. It has two windows, a "control
grid” window and a "canvas" window. QuickWin's built-in File.Save option
can be used to save the contents of either window as a bitmap (.BMP) file.

e gwpiano: The gwpiano sample demonstrates using mouse callbacks and
menu callbacks in a QuickWin application. It draws a graphical piano
keyboard on the screen that can be played using the mouse. It should be
noted that two compatibility options, "Logical Values™ and "Filenames from
Command Line" are set for this sample. The former affects interacting with
the QuickWin routines, and the latter causes a File dialog box to come up in
response to an OPEN request.

e Resize: The resize sample demonstrates how to use Win32 API calls from
within a QuickWin application to correctly size the information to be
displayed to a QuickWin window.

e testscrl: The testscrl sample demonstrates how to scroll to the last line of
a window that has scroll bars. It also shows how to make a window without
scroll bars.

Scientific Graphing Utility (SciGraph)

SCIGRAPH is a package of Fortran routines for drawing scientific graphs. Graph
types available include line, bar, XY, and pie graphs. All graphs are fully
customizable, including control over axis, log scales, data points, colors and
shades, error bars, and many other aspects of a scientific graph. All graphs are
drawn using Visual Fortran's QuickWin graphics routines, so they can be easily
added to an already existing QuickWin application.

The SciGraph package can be found in ...\ Df 98\ Sanpl es\ Sci Gr aph:

e scigraph: The SciGraph sample offers a starting scientific graphing
package to support some basic forms of graphs. There are two projects in
this sample:

o Scigraph, which creates a library and some .MOD files
o Sgdemo, which creates a program to demonstrate some of the basic
forms of graphs

Build the Scigraph project first, followed by Sgdemo. Note that the output
area for the SCIGRAPH.LIB project is included as a path to find .MOD files.
There is a .WRI file in the SCIGRAPH directory that contains basic reference
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information on the various SciGraph calls, including a list of error returns
and possible causes.

A known limitation of SciGraph is directly related to the known QuickWin
limitation of 256 colors on the graphics device. This limitation shows itself
when trying to print or save as a bitmap file; only a black screen is printed
or saved.

Tutorial

All Tutorial samples are simple programs, and most of them are standalone.
Each contains compilation information at the top of the file, both for command
line and from within Developer Studio. If there are multiple files, this is noted at
the top of the program. All tutorial samples can be found in the

directory ...\ Df 98\ Sanpl es\ Tutori al :

e assocn: The assocn sample illustrates the non-associativity of floating-
point addition.

e cycle: The cycle sample illustrates the Fortran 90 statements CYCLE and
EXIT.

o derived: The derived sample demonstrates a derived type structure, type
variables, and assign values.

e dtypearg: The dtypearg sample demonstrates the use of SEQUENCE to
allow passing a derived-type argument.

e dtypecom: The dtypecom sample demonstrates placing derived-type
objects in COMMON blocks.

o dtypemod: The dtypemod sample demonstrates the use of a module to
allow passing a derived-type argument. It also shows WRITE of a derived-
type.

e epsilon: The epsilon sample illustrates several calculations of machine
epsilon.

e internal: The internal sample illustrates the use of an internal subroutine
and the CONTAINS statement.

e interval: The interval sample demonstrates the use of rounding control.
This sample must be compiled without optimizations.

e keynames: The keynames sample demonstrates the Fortran concept of
using a type structure and a subroutine defined within a module. This
sample also requires NAME_SSN.F90 to build.

e matherr: The matherr sample demonstrates handling run-time math
exceptions. This sample is not a standalone application, but can be included
in other programs.

e mathtest: The mathtest sample uses matherr above to demonstrate the
response to error conditions on intrinsic math calls. It uses the
MATHERRQQ subroutine in MATHERR.F9O0.

e mbcomp: The mbcomp sample demonstrates the use of the National
Language Support (NLS) routines.

e namelist: The namelist sample demonstrates the NAMELIST Statement.

e percent: The percent sample demonstrates a user-defined operator, in
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this case a unary operator .c. that converts a floating point number to a
"percentage".

e pointer: The pointer sample demonstrates allocating and deallocating
pointers and targets.

e pointer2: The pointer2 sample demonstrates pointing at a pointer and
target, and the use of the ASSOCIATED intrinsic.

e realg: The realg sample demonstrates using coordinate graphics. This
sample uses the QuickWin package to display to the screen.

e recurs: The recurs sample is a very simple demonstration of a recursive
subroutine.

e showfont: The showfont sample uses QuickWin to display a variety of
fonts. This sample demonstrates various calls to QuickWin.

e sigtest: The sigtest sample demonstrates user-defined exception handlers.
It shows how to establish the name of the exception handler as the
function to be invoked if an exception happens.

e sine: The sine sample demonstrates the use of QuickWin to output sine
waves and some simple shapes.

e testget: The testget sample illustrates the use of internal READ to convert
from REAL to CHARACTER. This is best run from outside of Developer
Studio, and can be built simply by df testget.f9O0.

e threads: The threads sample demonstrates multiple threads with
QuickWin. It is a much simpler program than advanced\win32\bounce, but
IS not as efficient at run time.

e unclear: The unclear sample demonstrates the use of generic module
procedures. A generic procedure called "dup" has three instances; one with
real arguments, one with integer arguments, and one with character
arguments.

e Where: The where sample demonstrates the Fortran 90 constructs
WHERE and ELSEWHERE.
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Using the Compiler and Linker from the
Command Line

The DF command is used to compile and link your programs. In most cases, you
will use a single DF command to invoke the compiler and linker. The DF
command invokes a driver program that is the actual user interface to the
compiler and linker. It accepts a list of command options and file names and
directs processing for each file.

If you will be using the DF command from the command line, you can use:

e The supplied Fortran Command Prompt window in the Compaq Visual
Fortran program folder, in which the appropriate environment variables in
DFVARS. BAT are preset.

e Your own terminal window, in which you have set the appropriate
environment variables by executing the DFVARS. BAT file. This file sets the
environment variables (such as PATH, INCLUDE, and LIB) and allows use of
IMSL and CXML libraries. By default, DFVARS. BAT is installed in \ Program
Files\M crosoft Visual Studio\Df 98\BI N.

The driver program does the following:

o Calls the Visual Fortran compiler to process Fortran files.
Passes the linker options to the linker.

Passes object files created by the compiler to the linker.
Passes libraries to the linker.

Calls the linker or librarian to create the .EXE or library file.

The DF command automatically references the appropriate Visual Fortran Run-
Time Libraries when it invokes the linker. Therefore, to link one or more object
files created by the Visual Fortran compiler, you should use the DF command
instead of the LINK command.

Because the DF driver calls other software components, error messages may be
returned by these other components. For instance, the linker may return a
message if it cannot resolve a global reference. Using the /watch:cmd option on
the DF command line can help clarify which component is generating the error.

This section contains the following information:

The Format of the DF Command

Examples of the DF Command Format

Input and Output Files

¢ Environment Variables Used with the DF Command
Specifying Project Types with DF Command Options
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¢ Redirecting Command-Line Output to Files
Using the DF Command to Compile and Link
DF Indirect Command File Use

Compiler and Linker Messages

The Format of the DF Command

This section describes the format of the DF command. It also provides an
alphabetical list of DF command options.

The DF command accepts both compiler options and linker options. The
command driver requires that the following rules be observed when specifying
the DF command:

o Except for the linker options, options can be specified in any order.
e Linker options must be preceded by the keyword /link and must be
specified at the end of the command line, following all other options.

The DF command has the following form:
DF options [/link options]
options

A list of compiler options (or linker options preceded by the /link option). These
lists of options take the following form:

[/option:[arg]] [filenane.ext]...
Where:
/option[:arg]

Indicates either special actions to be performed by the compiler or linker,
or special properties of input or output files.

The following rules apply to options and their names:

e Options begin with a slash (/). You can use a dash (-) instead of a
slash.

¢ Visual Fortran options are not case-sensitive. Certain options provided
for compatibility with Microsoft Fortran PowerStation options are case-
sensitive, such as /FA and /Fafile.

e You can abbreviate option names. You need only enter as many
characters as are needed to uniquely identify the option.

Certain options accept one or more keyword arguments following the
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option name. For example, the /warn option accepts several keywords,
including argument_checking and declarations.

To specify only a single keyword, specify the keyword after the colon (:).
For example, the following specifies the /warn option declarations keyword:

DF /warn: decl arations test.f90

To specify multiple keywords, specify the option name once, and place
each keyword in a comma-separated list enclosed within parentheses with
no spaces between keywords, as follows:

DF /warn: (ar gunment _checki ng, decl arations) test.f90

Instead of the colon, you can use an equal sign (=):

DF /war n=(ar gunment _checki ng, decl arations) test.f90
filename.ext

Specifies the files to be processed. You can use wildcard characters (such
as *.f90) to indicate multiple files or you can specify each file name.

The file extension identifies the type of the file. With Fortran source files,
certain file extensions indicate whether that source file contains source
code in free (such as .f90) or fixed (such as .for) source form. You can also
specify compiler options to indicate fixed or free source form (see /[no]
free).

The file extension determines whether that file gets passed to the compiler
or to the linker. For example, files myfile.for and projfile.f are passed to the
compiler and file myobj.obj is passed to the linker.

Compiler Options, Alphabetic List

The following table lists the DF command compiler options alphabetically:

/[no]alignment /[no]altparam
/architecture /[no]asmattributes
/[no]asmfile /assume
/[noJautomatic /bintext
/[no]browser /ccdefault
/[no]check /[no]Jcomments
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/[no]compile_only

/convert

/cxml /[no]d_lines
/[no]dbglibs /[no]debug
/define /dll
/[no]error_limit /[no]exe
/[no]extend_source /extfor

/extfpp /extink
/[no]f66 /[no]f77rtl
/fast /[no]fixed
/[no]fltconsistency (ia32 only) || /[no]fpconstant
/fpe /fpp
/[no]fpscomp /[no]free

/help or /? /iface

/imsl /[no]include
/[no]inline /[no]intconstant
/integer_size /[no]keep
/[no]libdir /libs

/[no]link /[no]list
/[no]logo /[no]machine_code
/[no]map /math_library
/[nolmodule /names
/[no]object /[no]optimize

/[no]pad_source

/[no]pdbfile

/[no]pipeline (ia64 only)

/preprocess_only

/real_size

/[no]recursive

Page 4 of 19
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/[no]reentrancy /[no]show
/source /[no]static
/[no]stand /[no]syntax_only
/[no]threads /[no]traceback
/[no]transform_loops /tune

/undefine /unroll

/[no]vms /[no]warn
/[no]watch /what

/winapp

For more information:

e On DF command examples, see Examples of the DF Command Format

e On compiler option categories, see Categories of Compiler Options

e On using the FL32 command, see Microsoft Fortran PowerStation
Command-Line Compatibility

e About Fortran PowerStation options (such as /MD) and their DF command
equivalents, see Equivalent Visual Fortran Compiler Options

Examples of the DF Command Format

The following examples demonstrate valid and invalid DF commands:
Valid DF Commands

In the following example, the file to be compiled is test.f90 and the file
proj.obj is passed to the linker:

DF test.f90 proj.obj

In this example, the .f90 file extension indicates test.f90 is a Fortran free-
form source file to be compiled. The file extension of obj indicates proj.obj
is an object file to be passed to the linker. You can optionally add the /link
option before the file proj.obj to indicate it should be passed directly to the
linker.

In the following example, the /check:bounds option requests that the
Fortran compiler generate additional code to perform run-time checking for
out-of-bounds array and substring references for the files myfile.for and




Using the Compiler and Linker from the Command Line Page 6 of 19

test.for (fixed-form source):

DF /check: bounds nyfile.for test.for

In the following example, the /link option indicates that files and options
after the /link option are passed directly to the linker:

DF nyfile.for /link myobject.obj /out:nmyprog.exe
Invalid DF commands

The following DF command is invalid because the /link option indicates that
items after the /link option are passed directly to the linker, but the file
test.for should be passed to the compiler:

DF nyfile.for /link test.for /out:nyprog.exe

The following DF command is invalid because the /link option is missing
and the /out linker option is not recognized as a compiler option:

DF nyfile.for test.for /out:myprog. exe

A correct form of this command is:

DF nyfile.for test.for /link /out:nyprog. exe

In this case, you can alternatively use one of the DF options (/exe) that
specifies information to the linker:

DF nyfile.for test.for /exe:myprog.exe
For more information:

Environment Variables Used with the DF Command
e Specifying Project Types with DF Command Options
Using the DF Command to Compile and Link

DF Indirect Command File Use

Compiler and Linker Messages

Input and Output Files

You can use the DF command to process multiple files. These files can be source
files, object files, or object libraries.

When a file is not in your path or working directory, specify the directory path
before the file name.

The file extension determines whether a file gets passed to the compiler or to
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the linker. The following types of files are used with the DF command:
o Files passed to the compiler: .f90, .for, .f, .fpp, .i, .i90, .inc, .fi, .fd, .f77

Typical Fortran (DF command) source files have a file extension of .f90,
.for, and .f. When editing your source files, you need to choose the source
form, either free-source form or fixed-source form (or a variant of fixed
form called tab form). You can either use a compiler option to specify the
source form used by the source files (see /fixed or /free), or you can use
the following file extensions when creating or renaming your files:

o The compiler assumes that files with an extension of .f90, .F90, or .i90
are free-form source files.

o The compiler assumes that files with an extension of .f, .for, .FOR,
or .i are fixed-form (or tab-form) files.

o Files passed to the linker: .lib, .obj, .0, .exe, .res, .rbj, .def, .dll

For example, object files usually have a file extension of .obj. Files with
extensions of .lib are usually library files.

The output produced by the DF command includes:

e An object file (.OBJ) if you specify the /compile_only, /keep, or /object
option on the command line.

e An executable file (.EXE) if you do not specify the /compile_only option

e A dynamic-link library file (.DLL) if you specify the /dll option and do not
specify the /compile_only option

e A module file (.MOD) if a source file being compiled defines a Fortran 90
module (MODULE statement)

e A program database file (.PDB) if you specify the /pdbfile or /debug:full (or

equivalent) options

A listing file (.LST) if you specify the /list option

o A browser file (.SBR) if you specify the /browser option

You control the production of these files by specifying the appropriate options on
the DF command line. Unless you specify the Zcompile_only option or /keep
option, the compiler generates a single temporary object file from one or more
source files. The linker is then invoked to link the object file into one executable
image file.

If fatal errors are encountered during compilation, or if you specify certain
options such as /compile_only, linking does not occur.

When a path or file name includes an embedded space or a special character,
enclose the entire file location name in double quotation marks (). For
example:
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DF "Project xyz\fortmain.f90"
For more information about naming input and output files, see:

¢ Naming Output Files
e Temporary Files

Naming Output Files

To specify a file name for the executable image file, you can use one of several
DF options:

e The /exe:file or the /out:file linker option to name an executable program
file.

e The /dll:file alone or the /dll option with the /out:file linker option to name
an executable dynamic-link library.

You can also use the /object:file option to specify the object file name. If you
specify the /compile_only option and omit the /object:file option, each source
file is compiled into a separate object file. For more information about the
output file(s) created by compiling and linking multiple files, see Compiling and
Linking Multiple Fortran Source Files.

Many compiler options allow you to specify the name of the file being created. If
you specify only a filename without an extension, a default extension is added
for the file being created, as summarized below:

Default File Extensions for Compiler Options

Option Default File Extension

/asmfile:file || .ASM

/browser:file || .SBR

/dll:file .DLL
/exe:file .EXE
/list:file .LST
/map:file .MAP

/pdbfile:file || .PDB (default filename is df60.pdb)

Temporary Files
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Temporary files created by the compiler or linker reside in the directory used by
the operating system to store temporary files. To store temporary files, the
operating system first checks for the TMP environment variable.

If the TMP environment variable is defined, the directory that it points to is used
for temporary files. If the TMP environment variable is not defined, the
operating system checks for the TEMP environment variable. If the TEMP
environment variable is not defined, the current working directory is used for
temporary files. Temporary files are usually deleted, unless the /keep option
was specified. For performance reasons, use a local drive (rather than using a
network drive) to contain the temporary files.

To view the file name and directory where each temporary file is created, use
the /watch:cmd option. To create object files in your current working directory,
use the /compile_only or /keep option. Any object files (.obj files) that you
specify on the DF command line are retained.

Environment Variables Used with the DF
Command

The following table shows the environment variables that affect the DF
command.

Environment Variables Affecting the DF Command

Environment

Variable Description
PATH The PATH environment variable sets the search path.
LIB The linker uses the LIB environment variable to determine

the location of .LIB files. If the LIB environment variable is
not set, the linker looks for .LIB files in the current directory.

LINK_F90 The LINK_F90 environment variable contains a list of libraries
used for linking IMSL libraries (Professional and Enterprise
Editions), as listed in Library Naming Conventions.

INCLUDE The make facility (NMAKE) uses the INCLUDE environment
variable to locate INCLUDE files and module files. The Visual
Fortran compiler uses the INCLUDE environment variable to
locate files included by an INCLUDE statement or module files
referenced by a USE statement. Similarly, the resource
compiler uses the INCLUDE environment variable to locate
#include and RCINCLUDE files.
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DF The DF environment variable can be used to specify
frequently used DF options and files. The options and files
specified by the DF environment variable are added to the DF
command; they are processed before any options specified
on the command line. You can override an option specified in
the DF environment variable by specifying an option on the
command line.

For information about using the DF environment variable to
specify frequently-used options, see Using the DF
Environment Variable to Specify Options.

You can set these environment variables by using the DFVARS.BAT file or the
Fortran Command Prompt command-line window (see "Using the Command-Line
Interface"” in Compaq Visual Fortran Installing and Getting Started).

For a list of environment variables recognized at run-time, see Run-Time
Environment Variables.

Specifying Project Types with DF Command
Options

This section provides the DF command options that correspond to the visual
development environment project types.

When creating an application, you should choose a project type. The first four
projects are main project types, requiring main programs:

e To create a Fortran Console Application with the DF command, you do not
need to specify any options (if you link separately, specify the link
option /subsystem:console). This is the default project type created.

e To create a Fortran Standard Graphics Application with the DF command,
specify the /libs=gwins option (which also sets certain linker options).

e To create a Fortran QuickWin Application with the DF command, specify
the /libs:qwin option (which also sets certain linker options).

e To create a Fortran Windows Application with the DF command, specify
the /winapp option (which also sets certain linker options).

To create a Fortran COM Server, you must use Developer Studio (see Creating
COM Servers); you cannot create a Fortran COM Server project type with the DF
command.

The following types are library projects, without main programs:

e To create a Fortran Dynamic-Link Library with the DF command, specify
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the /dll option (sets the /libs:dll option).

e TO create a Fortran Static library with the DF command:

o If your application will not call any QuickWin or Standard Graphics
routines, specify /libs:static and /compile_only options to create the
object files. Use the LIB command to create the library (see Managing
Libraries with LIB).

o If your application will call QuickWin routines, specify /libs:qwin
and /compile_only options to create the object files. Use the LIB
command to create the library (see Managing Libraries with LIB).

o If your application will call Standard Graphics routines,
specify /libs:qwins and /compile_only options to create the object
files. Use the LIB command to create the library (see Managing
Libraries with LIB).

For an introduction to Visual Fortran project types, see Types of Projects.

Redirecting Command-Line Output to Files

When using the command line, you can redirect standard output and standard
error into separate files or into a single file. How you redirect command-line
output depends on which operating system you are using:

e On Windows NT 4 and Windows 2000 systems, to place standard output
into file one. out and standard error into file t wo. out , type the df command
(with its filenames and options) as follows:

df filenanes /options 1>one.out 2>two.out

You can also use a short-cut form (omit the 1):

df filenanes /options >one.out 2>two.out

To place standard output and standard error into a single file both. out on a
Windows NT 4 or Windows 2000 system, type the df command as follows:

df filenanes /options 1>both.out 2>&1

You can also use a short-cut form (omit the 1):

df filenanes /options >both.out 2>&1

e On Windows 98, Windows Me, and Windows 95 systems, use the EC
command-line tool to place standard output and standard error into
separate files or into a single file. The EC tool is located on the Visual
Fortran CD-ROM in the x86\ Usupport\ M sc\ W n95 folder. Copy ec.exe into a
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folder in your command-line path (PATH environment variable) on your
hard disk.

Precede the DF command line with the EC command and place the entire
DF command in quotes. For example, to place standard output into the file
one. out and standard error into file t wo. out , type the EC and DF command
(with its filenames and options) as follows:

ec "df filenanes /options 1>one.out 2>two.out"

To place standard output and standard error into a single file bot h. out on a
Windows 98, Windows Me, or Windows 95 system, type the EC and DF
commands as follows:

ec "df filenames /options 1>both. out 2>&1"

Using the DF Command to Compile and Link

By default, when you use the DF command, your source files are compiled and
then linked. To suppress linking, use the /compile_only option. The following
topics show how to use the DF command:

e Compiling and Linking a Single Source File

¢ Using the DF Environment Variable to Specify Options
¢ Compiling, but not Linking, a Fortran Source File

e Compiling and Linking Multiple Fortran Source Files

e Generating a Listing File

¢ Linking Against Additional Libraries

¢ Linking Object Files

¢ Compiling and Linking for Debugging

¢ Compiling and Linking for Optimization

¢ Compiling and Linking Mixed-Language Programs

Compiling and Linking a Single Source File

The following command compiles x.for, links, and creates an executable file
named x.exe. This command generates a temporary object file, which is deleted
after linking:

DF x.for

To name the executable file, specify the /exe option:

DF x.for /exe:myprog. exe

Alternatively, you can name the executable file by using the linker /out option:
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DF x.for /link /out:myprog. exe

Using the DF Environment Variable to Specify Options

The following command-line sequences show the use of the DF environment
variable. In the first command sequence, the SET command sets the DF
environment variable. When the DF command is invoked, it uses the options
specified by the DF environment variable, in this case, /debug:minimal and /list:

set DF=/debug:mninmal /1ist
DF myprog. for

You can also specify additional options on the DF command line. In the following
command sequence, the SET command sets the DF environment variable. The
DF options specified are /debug:minimal and /list.

set DF=/debug:mnimal /1ist
DF nyprog. for /show map

If the options specified on the command line conflict with the options specified
by the DF environment variable, the option specified on the command line takes
precedence. In the following command sequence, the /debug:minimal option
specified by the DF environment variable is overridden by the /debug:none
option specified on the command line:

set DF=/debug:mninmal /1ist
DF nyprog. for /debug: none

Compiling, but not Linking, a Fortran Source File

The following command compiles x.for and generates the object file x.obj.
The /compile_only option prevents linking (it does not link the object file into an
executable file):

DF x.for /conpile_only
Compiling and Linking Multiple Fortran Source Files

The following command compiles a.for, b.for, and c.for. It creates a single
temporary object file, then links the object file into an executable file named
a.exe:

DF a.for b.for c.for

If the files a.for, b.for, and c.for were the only .for files in the current directory,
you could use a wildcard character to similarly compile the three source files:

DF *.for
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If you use the /compile_only option to prevent linking, also use the /object:file
option so that multiple sources files are compiled into a single object file,
allowing more optimizations to occur:

DF /compile_only /object:a.obj a.for b.for c.for

When you use modules and compile multiple files, compile the source files that
define modules before the files that reference the modules (in USE statements).

When you use a single DF command, the order in which files are placed on the
command line is significant. For example, if the free-form source file moddef.f90
defines the modules referenced by the file projmain.f90, use the following DF
command line:

DF noddef.f90 projnain.f90
Generating a Listing File
To request a listing file, specify the /list option with the DF command. When you
request a listing file, a separate listing file is generated for each object file

created.

The content of the listing file is affected by the /show option. For more
information about this option, see Compiler and Linker Options.

The following command compiles and links a.for, b.for, and c.for. It generates
one listing file for the three source files:

DF a.for b.for c.for /1list

The following command compiles a.for, b.for, and c.for. It generates three
listing files (and three object files) for the three source files:

DF a.for b.for c.for /list /conpile_ only

The following command sequence compiles and links a.for, b.for, and c.for. It
generates one named object file (a.obj) and one listing file (a.lst). The second
command links the object files into an executable file (a.exe):

DF a.for b.for c.for /list /conpile_only /object:a.obj
DF a. obj

The following command sequence compiles and links a.for, b.for, and c.for. It
generates three object files (a.obj, b.obj, and c.obj) and three listing files (a.lst,
b.Ist, and c.Ist). The second command links the object files into an executable
file (a.exe):

DF a.for b.for c.for /list /conpile_only
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DF a.obj b.obj c.obj
Linking Against Additional Libraries

By default, the DF command automatically adds the libraries needed to build a
Fortran Console application to the link command that it generates.

The /libs:dll option indicates that you want to link against single-threaded DLLs;
other /libs options allow you to link against other types of libraries.

The /libs:static option (the default) indicates that you want to link against
single-threaded static libraries.

You can link against additional libraries by listing those libraries on the
command line.

For example, the following command links against static libraries. In addition to
linking against the default libraries, it links against the library nylib.1ib:

DF x.f90 nylib.lib

The following command links against single-threaded DLLs:

DF x.f90 /Ilibs:dllI

The following command links against single-threaded DLLs. It links against the
default libraries and nylib.lib:

DF x.f90 /libs:dll nylib.lib
To request the creation of a dynamic-link library, see /dll.

For more information on the types of libraries available to link against, see the
following options:

e /dbglibs
e /libs

/threads
e /winapp
e /fpscomp:libs

For more information about compiling and linking Visual Fortran and Visual C++
programs (and the libraries used), see Specifying Consistent Library Types.

Linking Object Files

The following command links x.obj into an executable file. This command
automatically links with the default Visual Fortran libraries:
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DF x. obj
Compiling and Linking for Debugging

If you use a single DF command to compile and link, specify the /debug option
(/debug sets the default optimization level to /optimize:0), as follows:

DF x.for /debug

By default, the debugger symbol table information is created in a PDB file, which
is needed for the debugger integrated within the visual development
environment.

If you use separate DF commands to compile and link, you will want to specify
the same debugging information level for the compiler and the linker. For
example, if you specify /debug:minimal to the compiler, you will also

specify /link /debug:minimal. The following command sequence compiles and
then links x. f or for debugging with the integrated visual development
environment debugger:

DF x.for /debug:full /optimze:0 /conpile only
DF x. obj /debug: ful

For more information about preparing your command-line program for
debugging, see Preparing Your Program for Debugging.

Compiling and Linking for Optimization

If you omit both the /compile_only and the /keep options, the specified Fortran
source files are compiled together into a single object module and then linked.
(The object file is deleted after linking.) Because all the Fortran source files are
compiled together into a single object module, full interprocedural optimizations
can occur. With the DF command, the default optimization level is /optimize:4
(unless you specify /debug with no keyword).

If you specify the /compile_only or /keep option and you want to allow full
interprocedural optimizations to occur, you should also specify the /object
option. The combination of the /compile _only and /object:file options creates a
single object file from multiple Fortran source files, allowing full interprocedural
optimizations. The object file can be linked later.

The following command uses both the /compile_only and /object options to
allow interprocedural optimization (explicitly requested by the /optimize:4
option):

DF /conmpile_only /object:out.obj /optinze:4 ax.for bx.for cx.for
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If you specify the /compile_only or /keep option without specifying the /object
option, each source file is compiled into an object file. This is acceptable if you
specified no optimization (/optimize:0) or local optimization (/optimize:1). An
information message appears when you specify multiple input files and specify
an option that creates multiple object files (such as /compile_only

without /object) and specify or imply global optimization (/optimize:2 or higher
optimization level).

If you specify the /compile_only option, you must link the object file (or files)
later by using a separate DF command. You might do this using a makefile
processed by the NMAKE command for incremental compilation of a large
application.

However, keep in mind that either omitting the /compile_only or /keep option or
using the /compile_only option with the /object:file option provides the benefit
of full interprocedural optimizations for compiling multiple Fortran source files.

Other optimization options are summarized in Software Environment and
Efficient Compilation.

Compiling and Linking Mixed-Language Programs

Your application can contain both C and Fortran source files. If your main
program is a Fortran source file (myprog.for) that calls a routine written in C
(cfunc.c), you could use the following sequence of commands to build your
application:

cl -c cfunc.c
DF nyprog. for cfunc.obj /1ink /out:mprog. exe

The cl command (invokes the C compiler) compiles but does not link cfunc.c.
The -c option specifies that the linker is not called. This command creates
cfunc.obj. The DF command compiles myprog.for and links cfunc.obj with the
object file created from myprog.for to create myprog.exe.

For more information about compiling and linking Visual Fortran and Visual C++
programs, and the libraries used, see:

e Specifying Consistent Library Types
¢ Visual Fortran/Visual C++ Mixed-Language Programs.

DF Indirect Command File Use

The DF command allows the use of indirect command files. For example,
assume the file text.txt contains the following:
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/pdbfile:testout.pdb /exe:testout.exe /debug:full /optimze:0 test.f90 rest.f90
The following DF command executes the contents of file text.txt as an indirect

command file to create a debugging version of the executable program and its
associated PDB file:

DF @est.txt

Indirect command files do not use continuation characters; all lines are
appended together as one command.

Compiler and Linker Messages
The following sections describe compiler limits and messages:

¢ Compiler Diagnostic Messages and Error Conditions
e Linker Diagnostic Messages and Error Conditions

For information on compiler limits, see Compiler Limits.

Compiler Diagnostic Messages and Error Conditions

The Visual Fortran compiler identifies syntax errors and violations of language
rules in the source program. If the compiler finds any errors, it writes messages
to the standard error output file and any listing file. If you enter the DF
command interactively, the messages are displayed.

Compiler messages have the following format:

filenane(n) : severity: nessage-text
[text-in-error]
N

The pointer (---") indicates the exact place on the source program line where
the error was found. The following error message shows the format and
message text in a listing file when an END DO statement was omitted:

echar.for(7): Severe: Unclosed DO | oop or |F block
DO 1=1,5
N

Diagnostic messages usually provide enough information for you to determine
the cause of an error and correct it.

When using the command line, make sure that the appropriate environment
variables have been set by executing the DFVARS. BAT file. These environment
variables are preset if you use the Fortran Command Prompt window in the
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Compagq Visual Fortran program folder (see "Using the Command-Line Interface"
in Compaq Visual Fortran Installing and Getting Started). For example, this BAT
file sets the environment variables for the include directory paths.

For errors related to INCLUDE and module (USE statement) file use, see /[no]
include.

For a list of environment variables used by the DF command during compilation,
see Environment Variables Used with the DF Command.

To control compiler diagnostic messages (such as warning messages), see /[no]
warn.

To view the passes as they execute on the DF command line,
specify /watch:cmd or /watch:all.

Linker Diagnostic Messages and Error Conditions

If the linker detects any errors while linking object modules, it displays
messages about their cause and severity. If any errors occur, the linker does
not produce an executable file.

Linker messages are descriptive, and you do not normally need additional
information to determine the specific error. For a description of each Linker
message, see Linker Messages (LNKXxxX).

To view the libraries being passed to the linker on the DF command line,
specify /watch:cmd or /watch:all.

On the command line, make sure the DFVARS. BAT file was executed to set the
appropriate environment variables (see "Using the Command-Line Interface” in
Compagq Visual Fortran Installing and Getting Started). For example, this BAT
file sets the environment variables for the library directory paths. For a list of
environment variables used by the DF command during compilation, see
Environment Variables Used with the DF Command.

You specify the libraries to be linked against using compiler options in the
Libraries category (see Categories of Compiler Options, Libraries category).
Also, you can specify libraries (include the path, if needed) on the command
line.

With the Professional and Enterprise Editions, if you have trouble linking IMSL
libraries, specify the /imsl option and see also Using the IMSL Libraries from
Visual Fortran.

For information on handling build errors in the visual development environment,
see Errors During the Build Process.
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Compiler and Linker Options

Most of the compiler and linker options can be specified within the Microsoft
visual development environment or on the command line. This section contains
a description of the options available to you in building programs.

You can set compiler options from:

o Within the visual development environment, by using the Fortran tab in the
Project menu, Settings dialog box.
e The DF command line. Compiler options must precede the /LINK option.

Unless you specify certain options, the DF command line will both compile and
link the files you specify. To compile without linking, specify the /compile_only
(or equivalent) option.

After the /LINK option on the DF command line, you can specify linker options.
Linker options and any libraries specified get passed directly to the linker, such
as /NODEFAULTLIB. If you choose to use separate compile and link commands,
you can also specify linker options on a separate LINK command.

This section contains the following information:
e Compiler Options

e Linker Options and Related information
e Microsoft Fortran PowerStation Command-Line Compatibility

Compiler Options

This section describes the compiler options and how they are used. It includes
the following topics:

o Categories of compiler options, according to functional grouping.
e Descriptions of each compiler option, listed alphabetically.

Categories of Compiler Options

If you will be using the compiler and linker from the command line, specify the
options needed on the DF command line (as described in Using the Compiler and
Linker from the Command Line). You can use the functional categories of
options below to locate the options needed for your application.

If you will be using the compiler and linker from the Microsoft visual
development environment, select the options needed by using the various tabs
in the Project menu Settings item (see Project Settings). The following graphic
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shows a sample Fortran tab:

Project Settings, Fortran Tab

Project Settings 3
Settings For: |'WWin3? Debug LI General | Debug  Fortran | CfC++ | Link | F{esnur% EE
= G O
CELEIUS FOR - EEGELE] Eeset |
Debugging Lewel: IFuII -
Warning Lewvel: INDrmaI Warnings * ll
Cptimization Lewvel; INDne -
Eredefined Preprocessaor Yariables:
[T Generate Source Browse Information
Froject Optians:
finclude"'Debug/" feompile_only fnologo fdebugfull :I
fmodule"Debug" fobject"Debug,"
{pdbfile:"Debug/DFE0 FDB" ﬂ
Ok Cancel

The options are grouped under functional categories (the initial Category is
General, as shown) to help you locate the options needed for your application.
From the Fortran tab, you can select one of the following categories from the
Category drop-down list (exception: those options listed in the Miscellaneous
category below):

General Code Generation
Compatibility Compilation Diagnostics
Debug External Procedures
Floating Point Fortran Data

Fortran Language Libraries

Listing Files Miscellaneous

Optimizations Preprocessor
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Run-Time

If a compiler option is not available in the dialog boxes, you can enter the option
in the lower part of the Project Settings dialog box just as you would at the
command line (under Project Options:).

The following tables list the Visual Fortran compiler options by category in the
Fortran tab:

General-Purpose Options

Debugging Level /[no]debug
Warning Level /warn
Optimization Level /[no]optimize
Predefined Preprocessor Symbols /define

Generate Source Browse Information || /[no]browser[:file]

Code Generation Options

/[no]fast (changes multiple

Generate Most-Optimized Code .
options)

Enable Recursive Routines /[no]recursive

Object text string inserted into object file || /bintext:string

Math Library: Checking or Fast

Performance /math_library

Generate Code for xxx Chip /architecture

Compatibility Options (See also Fortran Data)

Unformatted File Conversion (Nonnative /convert (also see /assume:
Data) [no]byterecl)

Enable VMS Compatibility /[no]vms

Enable F77 Run-Time Compatibility /[no]f77rtl

Use F77 Integer Constants /[no]intconstant
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Microsoft Fortran PowerStation V4 /[no]fpscomp (various
Compatibility Options keywords listed below)

Microsoft Fortran PowerStation: Filenames

from Command Line /fpscomp:[no]lfilesfromcmd

Microsoft Fortran PowerStation: 1/0 Format | /fpscomp:[no]ioformat

Microsoft Fortran PowerStation: Libraries /fpscomp:[no]libs

Microsoft Fortran PowerStation: List

Directed 1/0 Spacing /fpscomp:[no]ldio_spacing

Microsoft Fortran PowerStation: Logical

/fpscomp:[nollogicals
Values P b:[no]log

Microsoft Fortran PowerStation: Other Run-

time Behavior /fpscomp:[no]general

Microsoft Fortran PowerStation: Predefined

Preprocessor Symbols /tpscomp:[no]symbols

Compilation Diagnostic Options

Compilation Error Limit /[no]error_limit
Warning Levels (Ignore, Normal, Treat /warn:nogeneral, default
Warnings as Errors) settings, or /warn:errors

Fortran Standards Checking (None, Fortran

90, or Fortran 95) /stand:keyword

Treat Fortran Standard Warnings as Errors || /warn:[no]stderrors

Argument Mismatch /warn:[no]Jargument_checking

Data Alignment /warn:[no]alignments

Inform when Compiling Files Separately

(effect on interprocedure optimization) fwarn:[no]fileopt

Truncated Source /warn:[no]truncated_source
Uncalled Routines /warn:[no]Juncalled
Undeclared Variables/Symbols /warn:[no]declarations

Uninitialized Variables /warn:[noJuninitialized
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Unused Variables /warn:[nojunused

Usage (Fortran language) /warn:[noJusage

Debug Options

Debugging Level (None, Minimal, Partial, Full) /[no]debug

Compile Lines With D in Column 1 /[no]d_lines
Use Program Database for Debug Information and File /[no]pdbfile
Name [:file]

External Procedures (and Argument Passing) Options

Argument Passing Conventions /[no]iface:keyword

External Names Case Interpretation /names:keyword

String Length Argument Passing /[no]iface:mixed_str_len_arg
Append Underscore to External Names || /assume:[no]Junderscore

Fortran Data Options (See also Compatibility)

Default REAL and COMPLEX Kind /real_size:num

Default INTEGER and LOGICAL Kind /integer_size:num

Append Underscore to External Names (under

Data Options) /assume:[noJunderscore

Enable Dummy Arguments Sharing Memory /assume:[no]
Locations dummy_aliases
Extend Precision of Single-Precision Constants /[no]fpconstant

Use Bytes as RECL= Unit for Unformatted Files /assume:[no]byterecl

/[noJautomatic or /[no]
static

Variables Default to Automatic or Static Storage

/[nolalignment:[no]
common

Common Element Alignment
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Structure Element Alignment (Derived Type and

Record Data) /alignment:[no]records

Allow SEQUENCE Types to be Padded for

i lignment:[n n
Alignment /alignment:[no]sequence

Floating-Point Options (See also Optimizations)

Floating-Point Exception Handling /fpe

Enable Floating-Point Consistency /[no]fltconsistency (ia32 only)

Extend Precision of Single-Precision J[nolfoconstant

Constants

Enable IEEE Minus Zero Support /assume:[no]minusO
Fortran Language Options

Enable FORTRAN 66 Semantics /[n0]f66

Enable Alternate PARAMETER Syntax /[no]altparam

Name Case Interpretation /names:keyword

Source Form (File Extension, Fixed Form, or Free /[no]free or /[no]

Form) fixed

Fixed-Form Line Length /[no]extend_source

Pad Fixed-Form Source Records /[no]pad_source
Library Options (See also External Procedures)

Enable Reentrancy Support /[no]reentrancy

Use Run-Time Libraries, DLL version /libs:dll

Use Run-Time Libraries, Static library version /libs:static

Use Run-Time Libraries, QuickWin version /libs:gwin

Use Run-Time Libraries, Standard Graphics version | /libs:qwins

Use Run-Time Libraries, Debug version /[no]dbglibs
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Use Run-Time Libraries, Multi-Threaded version /[no]threads
Disable Default Library Search Rules /libdir:noauto
Disable OBJCOMMENT Library Names in Object /libdir:nouser
Use Common Windows Libraries /winapp

Use Compaq Extended Math Library (CXML) /cxml

Use IMSL Math Libraries /imsl

Listing and Assembly File Options

Source Listing /[no]list

Contents of Source Listing File || /show:keyword... or /[no]lmachine_code

Annotations /annotations:keyword

Assembly Listing /[no]asmfile [:file] and /[no]asmattributes

Miscellaneous Linker Tab and Command-Line Options (Not Listed in
Fortran Tab)

Specify Linker Options
(after /link)

/link (use Linker tab)

Generate Link Map /[no]lmap (use Linker tab)

/compile_only or /c (use Compile in Build

Compile, Do Not Link

menu)
Create Dynamic Link Library /dll and Specifying Project Types with DF
(DLL project type) Command Options

/[no]pipeline (ia64 only; command line
only)

Software Instruction Scheduling

Display Help Text File /help or /? (command line only)

Specify Custom File Extension for

Compiler /source (command line only)

Specify Custom File Extension for

Compiler /extfor (command line only)
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Specify Custom File Extension for
Linker

/extink (command line only)

Create one object file for each
input source file

/[no]keep (command line only)

Name of Executable Program or
DLL File

/[no]exe[:file] (command line only)

Name of Object File

/[no]object[:file] (command line only)

Perform Syntax Check Only (No
Object File)

/[no]syntax_only (command line only)

Display Copyright and Compiler
Version

/nologo and /what (command line only)

Display Compilation Details

/[no]watch (command line only)

Write C-Style Comments for FPP

/comments (command line only; for FPP)

Specify Custom File Extension for
FPP

/extfpp (command line only)

Only Preprocess FPP Files

/preprocess_only (command line only)

Undefine Preprocessor Symbols

/undefine (command line only)

Optimization Options (See also Code Generation)

Optimization Level

/[no]optimize

Variables Default to Automatic Storage

/[noJautomatic

Enable Dummy Arguments Sharing
Memory Locations

/assume:[no]Jdummy_aliases

Transform Loops

/[no]transform_loops

Enable 1/0 Buffering

/assume:[no]buffered_io

Loop Unrolling

/unroll

Math Library: Checking or Fast
Performance

/math_library

Inlining Procedures

/[no]inline
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Code Tuning for xxx chip /tune

Allow Reordering of Floating-Point

) /assume:[no]accuracy sensitive
Operations [no] Y

/[no]pipeline (ia64 only; command

Software Instruction Scheduling

line only)
Preprocessor Options
Define Preprocessor Symbols /define
Default INCLUDE and USE Path /assume:[no]source_include
Module path (to place module files) /module[:file]
INCLUDE and USE Path /[no]include
Use FPP and specify options /fpp[:"options"]
Predefined Preprocessor Symbols to FPP Only || /nodefine

Run-Time Options

Generate Traceback Information || /[no]traceback

Default Output Carriage Control || /ccdefault:keyword

Array and String Bounds /check:[no]bounds

Integer Overflow /check:[no]overflow

Floating-Point Underflow /check:[no]Junderflow

Power Operations /check:[no]power

Edit Descriptor Data Type /check:[no]format

Flawed Pentium® Chip /check:[no]flawed_pentium (ia32 only)
Edit Descriptor Data Size /check:[no]output_conversion

For a table of DF command options listed alphabetically, see Compiler Options,
Alphabetic List.

/[no]alignment
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Syntax:
/alignment[:keyword...], /7noalignment, or /Zpn

The /alignment option specifies the alignment of data items in common blocks,
record structures, and derived-type structures. The /Zpn option specifies the
alignment of data items in derived-type or record structures.

The /alignment options are:
e /align:[no]Jcommons

The /align:commons option aligns the data items of all COMMON data
blocks on natural boundaries up to four bytes. The default

is /align:nocommons (unless /fast is specified), which does not align data
blocks on natural boundaries. In the visual development environment,
specify the Common Element Alignment as 4 in the Fortran Data Compiler
Option Category.

e /align:dcommons

The /align:dcommons option aligns the data items of all COMMON data
blocks on natural boundaries up to eight bytes. The default

is /align:nocommons (unless /fast is specified), which does not align data
blocks on natural boundaries. Specifying /fast sets /align:dcommons. In the
visual development environment, specify the Common Element Alignment
as 8 in the Fortran Data Compiler Option Category.

e /align:[no]records

The /align:records option (the default) requests that components of derived
types and fields of records be aligned on natural boundaries up to 8 bytes
(for derived types with the SEQUENCE statement, see /align:[no]sequence
below). The /align:norecords option requests that components and fields be
aligned on arbitrary byte boundaries, instead of on natural boundaries up
to 8 bytes. In the visual development environment, specify the Structure
Element Alignment in the Fortran Data Compiler Option Category.

e /align:[no]sequence

The /align:sequence option requests that components of derived types with
the SEQUENCE statement will obey whatever alignment rules are currently
in use (default alignment rules will align unsequenced components on
natural boundaries). The default value (unless /fast is specified)

is /align:nosequence, which means that components of derived types with
the SEQUENCE property will be packed, regardless of whatever alignment
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rules are currently in use. Specifying /fast sets /align:sequence.

In the visual development environment, specify Allow SEQUENCE Types to

be Padded for Alignment in the Fortran Data Compiler Option Category.

e /align:recNbyte or /Zpn

The /align:recNbyte or /Zpn options request that fields of records and
components of derived types be aligned on the smaller of:

o The size byte boundary (N) specified.
o The boundary that will naturally align them.

Specifying /align:recNbyte, /Zpn, or /align:[no]records does not affect

whether common block fields are naturally aligned or packed. In the visual
development environment, specify the Structure Element Alignment in the

Fortran Data Compiler Option Category.

Specifying Is the Same as Specifying

/Zp /alignment:records or /align:rec8byte
/Zpl /alignment:norecords or /align:reclbyte
/Zp2 /align:rec2byte

/Zp4 /align:rec4byte

/Zp8 with /align:dcommons, /alignment:all,

/alignment or /alignment:(dcommons,records)

/Zp1l, /alignment:none, or /alignment:

/noalignment
(nocommons,nodcommons,norecords)

/align:reclbyte || /align:norecords

/align:rec8byte || /align:records

When you omit the /alignment option, records and components of derived types

are naturally aligned, but fields in common blocks are packed. This default is
equivalent to:

[ al i gnnent =( nocommons, nodconmons, r ecor ds, nosequence)

You can also control the alignment of components in records and derived types

and data items in common blocks by Using the cDEC$ OPTIONS Directive.
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/[no]altparam
Syntax:
/altparam, /noaltparam, /Z4Yaltparam, or /4Naltparam

The /altparam option determines how the compiler will treat the alternate
syntax for PARAMETER statements, which is:

PARAMETER par 1=expl [, par2=exp2]

This form does not have parentheses around the assignment of the constant to
the parameter name. With this form, the type of the parameter is determined
by the type of the expression being assigned to it and not by any implicit typing.

In the visual development environment, specify the Enable Alternate
PARAMETER Syntax in the Fortran Language Compiler Option Category.

When the /[no]altparam or equivalent options are not specified, the compiler
default will be to allow the alternate syntax for PARAMETER statements
(/altparam).

To disallow use of this form, specify /noaltparam or /4Naltparam. To allow use
of this form, allow the default or specify /altparam or /4Yaltparam.

/[no]annotations
Syntax:
/annotations:keyword or /Znoannotations

The /annotations option specifies that additional information will be added to the
source listing file. This information indicates which of a set of optimizations the
compiler applied to particular parts of the source file. Note that some of the
values of keyword may exist for optimizations that are not supported on your
platform. If so, the source listing file contains no corresponding annotations
(such as feedback). In the visual development environment, specify the various
annotations keywords under the Annotations list box in the Listing Compiler
Option Category.

You can view the resulting annotations in the source listing file to see what
optimizations the compiler performed or else why the compiler was not able to
optimize a particular code sequence. The default is /noannotations, which places
no annotations in the source listing file.

The /annotations option keywords are as follows:
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¢ /annotations:none

Same as /noannotations, the default value.
¢ /annotations:all

Specifying /annotations all selects all of the following annotations.
e /annotations:code

Specifying /annotations:code annotates the machine code listing with
descriptions of special instructions used for prefetching, alignment, and so
on.

e /annotations:detail

Specifying /annotations:detail provides, where available, an additional level
of annotation detail.
o /annotations:feedback

Specifying /annotations:feedback provides information about any feedback
optimizations (not available for Windows systems).
e /annotations:inlining

Specifying /annotations:inlining indicates where code for a called procedure
was expanded inline.
e /annotations:loop_transforms

Specifying /annotations:loop _transforms indicates where advanced loop
nest optimizations have been applied to improve cache performance (unroll
and jam, loop fusion, loop interchange, and so on).

e /annotations:loop_unrolling

Specifying /annotations:loop_unrolling indicates where a loop was unrolled
(contents expanded multiple times).
e /annotations:prefetching

Specifying /annotations:prefetching indicates where special instructions
were used to reduce memory latency.
e /annotations:shrinkwrapping

Specifying /annotations:shrinkwrapping indicates removal of code
establishing routine context when it is not needed.
e /annotations:software_pipelining

Specifying /annotations:software_pipelining indicates where instructions
have been rearranged to make optimal use of the processor’s functional
units (not available for ia32 systems).

e /annotations:tail_calls
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Specifying /annotations:tail_calls indicates an optimization where a call
from one routine to another can be replaced with a jump.
e /annotations:tail_recursion

Specifying /annotations:tail_recursion indicates an optimization that
eliminates unnecessary routine context for a recursive call.

The /annotations option is ignored unless you also specify the /list[:file] option

or select the equivalent Source Listing option in the Listing File category in the
visual development environment.

/architecture
Syntax:
/architecture:keyword
The /architecture (/arch) option controls the types of processor-specific

instructions generated for this program unit. The /arch:keyword option uses the
same keywords as the /tune:keyword option.

All processors of a certain architecture type (ia32) implement a core set of
instructions. Certain (more recent) processor versions include additional
instruction extensions.

Whereas the /tune:keyword option is primarily used by certain higher-level
optimizations for instruction scheduling purposes, the /arch:keyword option
determines the type of machine-code instructions generated for the program
unit being compiled.

In the visual development environment, specify the Generate Code For in the
Code Generation Compiler Option Category.

For ia32 (Intel and AMD) 32-bit processor systems, the supported /arch
keywords are:

e /arch:generic
Generates code (sometimes called blended code) that is appropriate for
processor generations for the architecture type in use. This is the default.
Programs compiled on an ia32 system with the generic keyword will run on
all ia32 systems.

e /arch:host

Generates code for the processor generation in use on the system being
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used for compilation. Depending on the host system used on ia32 systems,
the program may or may not run on other ia32 systems. Using /arch:host
on a:

o Intel Pentium processor system selects the pnl keyword

o Intel Pentium Pro, Intel Pentium 11, or AMD K6 processor system
selects the pn2 keyword
Intel Pentium 111 processor system selects the pn3 keyword
AMD K6_2 or AMD K6_ 11l processor system selects the k6_2 keyword
AMD Athlon processor system selects the k7 keyword
Intel Pentium 4 processor system selects the pn4 keyword

o O O O

e /arch:pnl

Generates code for the Pentium processor systems. Programs compiled
with the pnl keyword will run correctly on Pentium, Pentium Pro, Pentium
I, Pentium 111, AMD K6, and higher processors, but should not be run on
486 processors. The pnl keyword replaces the p5 keyword

(specifying /arch:pnl and /arch:p5 are equivalent).

e /arch:pn2

Generates code for the Pentium Pro, Pentium Il, and AMD K6 processor
systems only. Programs compiled with the pn2 or k6 keyword will run
correctly on Pentium Pro, Pentium I, AMD K6, Pentium |11, and higher
processors, but should not be run on 486 or Pentium processors. The pn2
keyword replaces the p6 keyword (specifying /arch:pn2 and /arch:p6 are
equivalent).

e /arch:k6

Generates code for the AMD K6 (same as Pentium |l systems) processor
systems only. Programs compiled with the k6 or pn2 keyword will run
correctly on Pentium Pro, Pentium IlI, AMD K6, Pentium |11, and higher
processors, but should not be run on 486 or Pentium processors.

e /arch:pn3

Generates code for the Pentium 111, AMD K6_2, and AMD K6 _Ill processor
systems only. Programs compiled with the pn3 keyword will run correctly
on Pentium 111, AMD K6_2, AMD K6_Ill, Pentium 4, and higher processors,
but should not be run on 486, Pentium, Pentium Pro, Pentium Il, or AMD
K6 processors. The pn3 keyword replaces the p6p keyword

(specifying /arch:pn3 and /arch:p6p are equivalent).

e /arch:k6_2

Generates code for the AMD K6_2 and AMD K6_ Il processor systems.
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Programs compiled with the k6_2 keyword will run correctly on AMD K6_2,
AMD K6_ 111, and AMD Athlon™ processors, but should not be run on 486,
Pentium, Pentium Pro, Pentium Il (same as AMD K6), Pentium 111, or
Pentium 4 processors.

e /arch:k7

Generates code for the AMD Athlon processor systems only. Programs
compiled with the k7 keyword will run correctly on AMD Athlon processors,
but should not be run on 486, Pentium, Pentium Pro, Pentium Il (same as
AMD K6), Pentium 111, Pentium 4, AMD K6_2, or AMD K6_ 11l processors.

e /arch:pn4

Generates code for the Pentium 4 processor systems only. Programs
compiled with the pn4 keyword will run correctly on Pentium 4 processors,
but should not be run on 486, Pentium, Pentium Pro, or Pentium Il (same
as AMD K6), Pentium I1l, AMD K6_2, AMD K6_ 111, or AMD Athlon
processors.

Other processors (not listed) that have instruction-level compatibility with the
processors listed above will have results similar to those processors.

For ia64 (64-bit) systems, specify either /arch:generic or /arch:host.

The following table shows the ia32 /arch:keywords and the systems that
programs using these keywords can be used on:

Intel
Pentium
Pro and Intel Intel
AMD AMD AMD AMD Intel Intel Pentium Pentium Pentium
keyword K6 K6 _2 K6 _Ill Athlon 486 Pentium 11 i 4
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pn4 X
k6_2 X X *
k7 X

Legend: * indicates supported combinations of keyword and
processor type

X indicates the best code generation combination of keyword
and processor type

Specifying /fast sets /arch:host.
For more information:
e About timing program execution, see Analyze Program Performance.

e About the types of instructions used by the various keywords, see
Requesting Code Generation for a Specific Processor Generation

/[no]asmattributes
Syntax:

/asmattributes:keyword, /noasmattributes, /FA, /FAs, /FAc,
or /FAcs

The /asmattributes option indicates what information, in addition to the
assembly code, should be generated in the assembly listing file.

In the visual development environment, specify Assembly Options in the Listing
File Compiler Option Category. The /asmattributes options are:

e /asmattributes:source or /FAs
Intersperses the source code as comments in the assembly listing file.
o /asmattributes:machine or /FAc

Lists the hex machine instructions at the beginning of each line of assembly
code.

e /asmattributes:all or /FAcs
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Intersperses both the source code as comments and lists the hex machine
instructions at the beginning of each line of assembly code. This is
equivalent to /asmattributes.

e /asmattributes:none or /FA

Provides neither interspersed source code comments nor a listing of hex
machine instructions. This is equivalent to /noasmattributes.

If you omit the /asmattributes option, /asmattributes:none is used (default).
The /asmattributes option is ignored if the /[no]asmfile[:file] option is not

specified. The /FA, /FAs, /FAc, or /FAcs options can be used without the /[no]
asmfile[:file] option.

/[no]asmfile
Syntax:
/asmfile[:file], /7noasmfile, /Fa[file], /Fc[file], ZFI[file], or /Fs[file]
The /asmfile option or equivalent /Fx option indicates that an assembly listing
file should be generated. If the file is not specified, the default filename used will

be the name of the source file with an extension of .asm.

In the visual development environment, specify Assembly Listing in the Listing
File Compiler Option Category.

When the /asmfile option or equivalent /Fx[file] option is specified and there are
multiple source files being compiled, each source file will be compiled
separately. Compiling source files separately turns off interprocedural
optimization from being performed.

When you specify /noasmfile or the /asmfile option is not specified, the compiler
does not generate any assembly files.

To specify the content of the assembly listing file, also specify /[no]
asmattributes:keyword or specify the /Fx[file] options:

o /FA[file] provides neither interspersed source code comments nor a listing
of hex machine instructions.

o /FAs][file] provides interspersed source code as comments in the assembly
listing file.

o /FAc[file] provides a list of hex machine instructions at the beginning of
each line of assembly code.

o /FAcs[file] provides interspersed source code as comments and lists hex
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machine instructions at the beginning of each line of assembly code.
/assume
Syntax:

/assume:keyword

The /assume option specifies assumptions made by the Fortran syntax analyzer,
optimizer, and code generator. These option keywords are:

/assume:[no]accuracy_sensitive /assume:[no]buffered_io

/assume:[no]byterecl /assume:[no]Jdummy_aliases
/assume:[no]lminusO /assume:[no]protect constants
/assume:[no]source_include /assume:[no]Junderscore

The /assume options are:
e /assume:[no]accuracy_sensitive

Specifying /assume:noaccuracy_sensitive allows the compiler to reorder
code based on algebraic identities (inverses, associativity, and distribution)
to improve performance. In the visual development environment, specify
Allow Reordering of Floating-Point Operations in the Optimizations Compiler
Option Category.

The numeric results can be slightly different from the default
(/assume:accuracy_sensitive) because of the way intermediate results are
rounded.

Numeric results with /assume:noaccuracy_sensitive are not categorically
less accurate. They can produce more accurate results for certain floating-
point calculations, such as dot product summations. For example, the
following expressions are mathematically equivalent but may not compute
the same value using finite precision arithmetic:

X
X

(A+B) - C
A+ (B- O

If you omit /assume:noaccuracy_sensitive and omit /fast, the compiler
uses a limited number of rules for calculations, which might prevent some
optimizations.

If you specify /assume:noaccuracy_sensitive, or if you specify /fast and
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omit /assume:accuracy_sensitive, the compiler can reorder code based on
algebraic identities to improve performance.

For more information on /assume:noaccuracy_sensitive, see Arithmetic
Reordering Optimizations.

e /assume:[no]buffered io

The /assume:buffered_io option controls whether records are written
(flushed) to disk as each record is written (default) or accumulated in the
buffer.

For disk devices, /assume:buffered _io (or the equivalent OPEN statement
BUFFERED="YES' specifier or the FORT_BUFFERED run-time environment
variable) requests that the internal buffer will be filled, possibly by many
record output statements (WRITE), before it is written to disk by the
Fortran run-time system. If a file is opened for direct access, 1/0 buffering
will be ignored.

Using buffered writes usually makes disk 1/0 more efficient by writing
larger blocks of data to the disk less often. However, if you request
buffered writes, records not yet written to disk may be lost in the event of
a system failure.

Unless you set the FORT_BUFFERED environment variable to TRUE, the
default is BUFFERED="NO" and /assume:nobuffered_io for all 1/0, in which
case, the Fortran run-time system empties its internal buffer for each
WRITE (or similar record output statement).

The OPEN statement BUFFERED specifier applies to a specific logical unit.
In contrast, the /assume:[no]buffered_io option and the FORT_BUFFERED
environment variable apply to all Fortran units.

In the visual development environment, to enable /assume:buffered_io,
specify the Enable 1/0 Buffering in the Optimizations Compiler Option

Category.

For more information on /assume:buffered_io, see Efficient Use of Record
Buffers and Disk 1/0.

e /assume:[no]byterecl

The /assume:byterecl option applies only to unformatted files. In the visual
development environment, specify the Use Bytes as Unit for Unformatted
Files in the Fortran Data Compiler Option Category. Specifying

the /assume:byterecl option:
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o Indicates that the units for an explicit OPEN statement RECL specifier
value are in bytes.

o Forces the record length value returned by an INQUIRE by output list
to be in byte units.

Specifying /assume:nobyterecl indicates that the units for RECL values with
unformatted files are in four-byte (longword) units. This is the default.

e /assume:[no]Jdummy_aliases

Specifying the /assume:dummy_aliases option requires that the compiler
assume that dummy (formal) arguments to procedures share memory
locations with other dummy arguments or with variables shared through
use association, host association, or common block use. The default

is /assume:nodummy_aliases.

In the visual development environment, specify Enable Dummy Argument
Aliasing in the Fortran Data (or Optimizations) Compiler Option Category.

These program semantics do not strictly obey the Fortran Standard and
they slow performance. If you omit /assume:dummy_aliases, the compiler
does not need to make these assumptions, which results in better run-time
performance. However, omitting /assume:dummy_aliases can cause some
programs that depend on such aliases to fail or produce wrong answers.

You only need to compile the called subprogram
with /assume:dummy_aliases.

If you compile a program that uses dummy aliasing

with /assume:nodummy_aliases in effect, the run-time behavior of the
program will be unpredictable. In such programs, the results will depend on
the exact optimizations that are performed. In some cases, normal results
will occur; however, in other cases, results will differ because the values
used in computations involving the offending aliases will differ.

For more information, see Dummy Aliasing Assumption.

e /assume:[no]minusO

This option controls whether the compiler uses Fortran 95 standard
semantics for the IEEE floating-point value of -0.0 (minus zero) in the
SIGN intrinsic, if the processor is capable of distinguishing the difference
between -0.0 and +0.0. The default is /assume:nominusO, where the value
-0.0 or +0.0 in the SIGN function is treated as 0.0.

To request Fortran 95 semantics to allow use of the IEEE value -0.0 in the
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SIGN intrinsic, specify /assume:minusO.

In the visual development environment, specify Enable IEEE Minus Zero
Support in the Floating Point Compiler Option Category.

e /assume:[no]protect_constants

This option specifies whether constant actual arguments can be changed.
By default, actual arguments that are constants are read-only
(/assume:protect_constants). To allow changes to actual arguments that
are constants, specify /assume:noprotect_constants.

In the visual development environment, specify Constant Actual Arguments
are Read-Only in the Fortran Data Compiler Option Category.

e /assume:[no]source_include

This option controls the directory searched for module files specified by a
USE statement or source files specified by an INCLUDE statement:

o Specifying /assume:source_include requests a search for module or
include files in the directory where the source file being compiled
resides. This is the default.

o Specifying /assume:nosource_include requests a search for module or
include files in the current (default) directory.

In the visual development environment, specify the Default INCLUDE and
USE Paths in the Preprocessor Compiler Option Category.

e /assume:[nojunderscore

Specifying /assume:underscore option controls the appending of an
underscore character to external user-defined names: the main program
name, named COMMON, BLOCK DATA, and names implicitly or explicitly
declared EXTERNAL. The name of blank COMMON remains _BLNK___, and
Fortran intrinsic names are not affected.

In the visual development environment, specify Append Underscore to
External Names in the External Procedures (or Fortran Data) Compiler
Option Category.

Specifying /assume:nounderscore option does not append an underscore
character to external user-defined names. This is the default.

For example, the following command requests the noaccuracy_sensitive and
nosource_include keywords and accepts the defaults for the other /assume
keywords:
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df /assune: (noaccuracy_sensitive, nosource_include) testfile.f90
/[no]Jautomatic
Syntax:
/automatic, /noautomatic, /74Ya, or /4Na
The /automatic or /4Ya option requests that local variables be put on the run-

time stack. In the visual development environment, specify Variables Default to
Automatic in the Fortran Data (or Optimizations) Compiler Option Category.

The /noautomatic or /4Na option is the same as the /static option. The default
is /noautomatic or /4Na, which causes all local variables to be statically
allocated.
If you specify /recursive, the /automatic (/4Ya) option is set.
/bintext
Syntax:

/bintext:string or /Vstring
Specifying /bintext (or /V) places the text string specified into the object file
(.OBJ) being generated by the compiler. This string also gets propagated into
the executable file. For example, the string might contain version number or

copyright information.

In the visual development environment, specify Object Text in the Code
Generation Compiler Option Category.

If the string contains a space or tab, the string must be enclosed by double
quotation marks (""). A backslash (\) must precede any double quotation marks
contained within the string.

If the command line contains multiple /bintext or /V options, the last (right-
most) one is used. You can specify /nobintext to override previous /bintext or /V
options on the same command line.

/[no]browser

Syntax:

/browser|[:filename], /Znobrowser, or /FR
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The /browser or /FR option controls the generation of source browser
information. When the /browser option is not specified, the compiler will not
generate browser files (same as /nobrowser).

In the visual development environment, specify Generate Source Browse
Information in the General Compiler Option Category. Also, in the Browselnfo
tab, set Build Browse info check box.

Browser information includes:

¢ Information about all the symbols in the source file

e The source code line in which a symbol is defined

e Each source code line where there is a reference to a symbol

e The relationships between calling functions and called functions

The default extension for source browser files is .SBR.

The browser output is intended to be used as input to the Browse Information
File Maintenance Utility (BSCMAKE), which generates a browse information file
(.BSC) that can be examined in browse windows in the Microsoft visual

development environment.

Instead of using BCSMAKE, you can use the Project Settings dialog box in the
visual development environment:

¢ Click the Browselnfo tab.
¢ Set the Build browse info file check box.

When the /browser or /FR option is specified and there are multiple source files

being compiled, each source file will be compiled separately. Compiling source
files separately turns off interprocedure optimizations.

/ccdefault
Syntax:
/ccdefault:keyword...

The /ccdefault option specifies the default carriage control when a file is
displayed on a terminal screen.

In the visual development environment, specify the Default Output Carriage
Control in the Run-Time Compiler Option Category. The /ccdefault keywords are
as follows:

e /ccdefault:default
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Allows other options, such as Compatibility option /vms, to affect this
default setting:

o If /vms is specified with /ccdefault:default, carriage control defaults to
FORTRAN (/ccdefault:fortran) if the file is formatted, and the unit is
connected to a terminal.

o If /novms (default) is specified with /ccdefault:default, carriage control
defaults to LIST (/ccdefault:list).
e /ccdefault:fortran

Uses normal Fortran interpretation of the first character, such as the
character "0" resulting in a blank line before output.

e /ccdefault:list
Adds one line-feed between records.
e /ccdefault:none
Uses no carriage control processing.
/[no]check
Syntax:
/check:keyword, /nocheck, 74Yb, /74Nb
The /check, /4Yb, or /4Nb options control whether extra code is generated for
certain run-time checking. Run-time checks can result in issuing run-time
messages for certain conditions.
In the visual development environment, specify the Runtime Error Checking

items in the Run time Compiler Option Category. The /check options are as
follows:

/check:arg_temp_created /check:bounds
(Actual Arguments use Temporary Storage) || (Array and String bounds)

/check:flawed pentium (ia32 systems) /check:format
(Flawed Pentium) (Edit Descriptor Data Type)
/check:output_conversion /check:overflow

(Edit Descriptor Data Size) (Integer Overflow)
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/check:power /check:underflow
(Power Operations) (Floating Point Underflow)
/4Yb /check:none, /nocheck, or /4Nb

/check or /check:all

If you omit these options, the default is:
/check:
(noarg_temp_created,nobounds,flawed_pentium,noformat,nopower,nooutput_con

When using the visual development environment debug configuration, the
default for bounds checking changes from /check:nobounds to /check:bounds.

The /check keywords and /4Yb, and /4Nb options are:
e /check:arg_temp_created

Requests that a run-time informational message appear if actual
arguments are copied into temporary storage before routine calls.
Specifying /check:noarg_temp_created (the default) does not generate the
extra code needed to display a message run-time when this condition
occurs.

e /check:bounds

Requests a run-time error message if a reference to an array subscript or
character substring is outside of the declared bounds. The default for the
command line and the release configuration (visual development
environment) is /check:nobounds, which does not issue a run-time
message for this condition. The default for the debug configuration

is /check:bounds, which issues a run-time message for an out-of-bounds
array subscript or character substring.

e /check:flawed_pentium (ia32 systems)

On ia32 systems, requests a run-time error message if a flawed Pentium
(586) processor is detected. The default is /check:flawed_pentium, which
does issue a run-time error message for this condition and stops program
execution. To allow program execution to continue when this condition
occurs, set the environment variable FOR_RUN_FLAWED_PENTIUM to true
and rerun the program (see Run-Time Environment Variables).

For more information on the Pentium flaw, see Intel Pentium Floating-Point
Flaw. You can also use the FOR_CHECK_FLAWED_PENTIUM routine.
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e /check:format

Requests a run-time error message when the data type for an item being
formatted for output does not match the FORMAT descriptor.

Specifying /check:noformat suppresses the run-time error message for this
condition.

e /check:output_conversion

Requests a run-time message (number 63) when format truncation occurs
(when a number is too large to fit in the specified format field length
without loss of significant digits). Specifying /check:nooutput_conversion
does not display the message when format truncation occurs.

e /check:overflow

Requests a continuable run-time message when integer overflow occurs.
Specifying /check:nooverflow suppresses the run-time message.

e /check:power

Requests a run-time error message for arithmetic expressions 0.0 ** 0.0
and negative-value ** integer-value-of-type-real. The default

is /check:nopower (suppress the run-time error message), allowing the
calculations to occur, where 0.0 ** 0.0 equals 1.0 and (-3.0) ** 3.0 equals
-27.0.

You can specify /check:power to allow a run-time error message to be
issued for this type of expression.

e /check:underflow
Requests an informational run-time message when floating-point underflow
occurs when /fpe:0 is specified (/check:underflow is not supported
with /fpe:3). Specifying /check:nounderflow suppresses a run-time
message when floating-point underflow occurs.

e /4YD
Sets /check:(overflow,bounds,underflow).

e /check:none, /nocheck, or /4Nb
Equivalent to:

/check:
(noarg_temp_created,nobounds,noformat,nopower,nooutput_conversion,noo
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e /check or /check:all

Equivalent to:

/check:

(arg_temp_created,bounds,flawed_pentium,format,power,output_conversion
/[no]Jcomments
Syntax:

/comments or /nocomments
The /comments option writes C-style comments to the output file.
The /nocomments option does not write C-style comments to the output file.
This option applies only to the FPP preprocessor.
For more information, type FPP /? to view FPP options.
/[no]Jcompile_only
Syntax:

/compile_only, /Znocompile_only, or /c

The /compile_only or /c option suppresses linking. The default
iIs /nocompile_only (perform linking).

If you specify the /compile_only option at higher levels of optimization and also
specify /object:filename, the /object:filename option causes multiple Fortran
input files (if specified) to be compiled into a single object file. This allows
interprocedural optimizations to occur.

However, if you use multiple source files and the /compile_only option without
the /object:file option, multiple object files are created and interprocedural
optimizations do not occur.

In the visual development environment, to compile (not link) a source file:

1. In the FileView pane, select (highlight) the file to be compiled
2. From the Build menu, select Compile filename.xxx

/convert

Syntax:
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/convert:keyword

The /convert option specifies the format of unformatted files containing numeric
data. On ia32 and ia64 systems, the format used in memory is always IEEE little
endian format. If you want to read and write unformatted data in IEEE little
endian format, you do not need to convert your unformatted data and can omit
this option (or specify /convert:native).

This method affects all unit numbers that use unformatted data specified by the
program. Other methods are available to specify the format for all or certain
unformatted files (see Converting Unformatted Numeric Data).

In the visual development environment, specify the Unformatted File Conversion
in the Compatibility Compiler Option Category. The /convert options are:

/convert:big_endian /convert:cray

/convert:ibm /convert:little_endian

/convert:native /convert:vaxd

/convert:vaxg

e /convert:big_endian

Specifies that unformatted files containing numeric data are in IEEE big
endian (nonnative) format. The resulting program will read and write
unformatted files containing numeric data assuming the following:

o Big endian integer format (INTEGER declarations of the appropriate
size).

o Big endian IEEE floating-point formats (REAL and COMPLEX
declarations of the appropriate size).

e /convert:cray

Specifies that unformatted files containing numeric data are in CRAY
(nonnative) big endian format. The resulting program will read and write
unformatted files containing numeric data assuming the following:

o Big endian integer format (INTEGER declarations of the appropriate
size).

o Big endian CRAY proprietary floating-point formats (REAL and
COMPLEX declarations of the appropriate size).

e /convert:ibm
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Specifies that unformatted files containing numeric data are in IBM
(nonnative) big endian format. The resulting program will read and write
unformatted files containing numeric data assuming the following:

o Big endian integer format (INTEGER declarations of the appropriate
size).

o Big endian IBM proprietary floating-point formats (REAL and COMPLEX
declarations of the appropriate size).

e /convert:little_endian

Specifies that numeric data in unformatted files is in native little endian
integer format and IEEE little endian floating-point format (same as used in
memory), as follows:

o Integer data is in native little endian format.

o REAL(KIND=4) and COMPLEX(KIND=4) (SINGLE PRECISION) data is
in IEEE little endian S_floating format.

o REAL(KIND=8) and COMPLEX (KIND=8) (DOUBLE PRECISION) data is
in IEEE little endian T_floating format.

e /convert:native

Specifies that numeric data in unformatted files is not converted. This is
the default.

e /convert:vaxd

Specifies that numeric data in unformatted files is in VAXD little endian
format, as follows:

o Integer data is in native little endian format.

o REAL(KIND=4) and COMPLEX(KIND=4) (SINGLE PRECISION) data is
in VAX F_floating format.

o REAL(KIND=8) and COMPLEX (KIND=8) (DOUBLE PRECISION) data is
in VAX D_floating format.

e /convert:vaxg

Specifies that numeric data in unformatted files is in VAXG little endian
format, as follows:

o Integer data is in native little endian format.

o REAL(KIND=4) and COMPLEX(KIND=4) (SINGLE PRECISION) data is
in VAX F_floating format.

o REAL(KIND=8) and COMPLEX(KIND=8) (DOUBLE PRECISION) data is
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in VAX G_floating format.

For more information on unformatted file conversion, see Converting
Unformatted Numeric Data.

/cxml
Syntax:

/cxml
The /cxml option requests that the Compaq Extended Math Library (CXML)
library be passed to the linker. Your program still needs to specify the | NCLUDE
' CXML_I NCLUDE. F90' statement. The /cxml option is provided for documentation

purposes only.

For more information, see Using the Compag Extended Math Library (CXML).

In the visual development environment, specify the Use Compaq Extended Math
Library (CXML) in the Library Compiler Option Category.

/[no]d_lines
Syntax:
/d_lines, /nod_lines, /4ccD, or /4ccd
The /d_lines, /4ccD, or /4ccd options indicate that lines in fixed-format files that
contain a D in column 1 should be treated as source code. Specifying /nod_lines

(the default) indicates that these lines are to be treated as comment lines.

In the visual development environment, specify Compile DEBUG (D) Lines in the
Debug Compiler Option Category.

The compiler does not support the use of characters other than a D or d with
the /4ccstring (see the dlines Sample program in ...\ Sanpl es\ Advanced\ com ).

/[no]dbglibs
Syntax:
/dbglibs or /nodbglibs
The /dbglibs option controls whether the debug version or the non-debug

version of the C run-time library is linked against. The default is /nodbglibs,
which will link against the non-debug version of the C library, even
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when /debug:full is specified.

If you specify /debug:full for an application that calls C library routines and you
need to debug calls into the C library, you should also specify /dbglibs to
request that the debug version of the library be linked against.

In the visual development environment, specify one of the Debug library options
in the Use Fortran Run-Time Libraries in the Libraries Compiler Option Category.

When you specify /dbglibs, the C debug library linked against depends on the
specified /libs:keyword and /[no]threads options, and is one of: Iibcd.lib,
libcntd.lib, Or mevertd.lib.

For More Information:

¢ Visual Fortran/Visual C++ Mixed-Language Programs
e Specifying Consistent Library Types

/[no]debug
Syntax:
/debug:keyword, /nodebug, 727, /7Zd, or /Zi

The /debug, /Z7, /Zd, or /Zi options control the level of debugging information
associated with the program being compiled.

In the visual development environment, specify the Debugging Level in the
General or Debug Compiler Option Category. The options are:

/debug:none or /nodebug /debug:minimal or /Zd

/debug:partial /debug:full, /debuq, /Zi, or /Z7

The /debug options:
e /debug:none or /nodebug

If you specify /debug:none or /nodebug, the compiler produces no symbol
table information, which is needed for debugging or profiling. Only symbol
information needed for linking (global symbols) is produced. The size of the
resulting object module is the minimum size. If this option is

specified, /debug:none is passed to the linker.

e /debug:minimal or /Zd
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If you specify /debug:minimal or /Zd, the compiler produces minimal debug
information, which allows global symbol table information needed for
linking, but not local symbol table information needed for debugging.

If /debug:minimal is specified, /debug:minimal and /debugtype:cv is
passed to the linker.

If you omit the /[no]debug:keyword, /Z7, /Zd, and /Zi
options, /debug:minimal is the default on the command line and for a
release configuration in the visual development environment.

The /Zd option implies /nopdbfile and
passes /debug:minimal /pdb:none /debugtype:cv to the linker.

The object module size is somewhat larger than if you
specified /debug:none, but is smaller than if you specified /debug:full.

e /debug:partial

If you specify /debug:partial, the compiler produces debugging information
to allow global symbol table information needed for linking, but not local
symbol table information needed for debugging. If /debug:partial is
specified, /debug:partial /debugtype:cv /pdb:none is passed to the linker.

The object module size is somewhat larger than if you
specified /debug:none, but is smaller than if you specified /debug:full.

e /debug:full, /debug, /Zi, or /Z7

If you specify /debug:full, /debug, /Zi, or /Z7, the compiler produces
symbol table information needed for full symbolic debugging of
unoptimized code and global symbol information needed for linking. This is
the default for a debug configuration in the visual development
environment.

If you specify /debug:full for an application that make calls to C library
routines and you need to debug calls into the C library, you should also
specify /dbglibs to request that the appropriate C debug library be linked
against (see Specifying Consistent Library Types).

The /Z7 option implies /nopdbfile and
passes /debug:full /debugtype:cv /pdb:none to the linker.

The /debug:full, /debug, and /Zi options imply /pdbfile and pass /debug:full
and /debugtype:cv to the linker.

If you specify /debug (with no keyword), the default optimization level
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changes to /optimize:0 (instead of /optimize:4) for the DF command.

To request program counter run-time correlation to source file line numbers (full
traceback) for severe run-time errors, specify the /traceback option.

/define

Syntax:
/define:symbol[=value]

The /define option defines the symbol specified for use with conditional
compilation directives or the Fortran preprocessor, FPP. A value specified

for /define can be a character or integer value. If a value is not specified, 1 is
assigned to symbol.

When only using the Fortran preprocessor FPP, to request that symbol values
defined by /define apply only to FPP and are not seen by compiler directives,
also specify /nodefine on the DF command line.

In the visual development environment, specify the Predefined Preprocessor
Symbols in the General or Preprocessor Compiler Option Category.

You can use the directives to detect symbol definitions, such as the IF Directive
Construct. Like certain other compiler options, an equivalent directive exists
(DEFINE directive).

The following preprocessor symbols are predefined by the compiler system and
are available to compiler directives and FPP (except _DF _VERSION_ and
_VF_VERSION ):

Predefined Preprocessor Symbols

Predefined Symbol Name Conditions When this Symbol is Defined
and Value

DF_VERSION_=660 (660 for Compiler only

Version 6.6)

_DLL=1 Only if /libs:dll, /MDs, /MD, /dIl, or /LD is
specified, but not when /libs:static is
specified

_INTEGRAL_MAX_BITS=32 Only for ia32 (32-bit) systems

_INTEGRAL_MAX_BITS=64 Only for ia64 (64-bit) systems
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_ITANIUM_A3 =1 Only for ia64 (64-bit) systems

_MSFORTRAN_=401 Only if /fpscomp:symbols is specified or you
use the FL32 command

_MT=1 Only if /threads or /MT is specified

_M_1X86=500 Only for ia32 (32-bit) systems

_M_1A64=64100 Only for ia64 (64-bit) systems

_VF_VERSION_=660 (660 for Compiler only

Version 6.6)

_WIN32=1 Always defined (both ia32 and ia64
systems)

_WIN64=1 Only for ia64 (64-bit) systems

_WIN95=1 Only for ia32 (32-bit) systems running the
Windows 95 operating system

_WIN98=1 Only for ia32 (32-bit) systems running the
Windows 98 operating system

_WINME=1 Only for ia32 (32-bit) systems running the
Windows Me operating system

_X86_=1 Only for ia32 (32-bit) systems

When using the non-native ia64 compiler, platform-specific symbols are set for
the target platform of the executable, not for the system in use.

/dll
Syntax:

/dll[:file], /nodll, or /LD
The /dll or /LD option indicates that the program should be linked as a DLL file.
The /dll or /LD option overrides any specification of the run-time routines to be
used and activates the /libs:dll option. A warning is generated when

the /libs=qwin or /libs=gwins option and /dll option are used together.

In the visual development environment, specify the project type as Fortran
Dynamic Link Library (DLL).

If you omit file, the /dll or /LD option interacts with the /exe and the /Fe
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options, as follows:

o If neither /exe nor /Fe is specified, the first file name used on the
command line is used with an extension of .DLL.

o If either /exe:file or /Fefile is specified with a file name, that name is used
for the DLL file. If the specified file name does not end with a "." or have
an extension, an extension of .DLL is added to it.

To request linking with multithreaded libraries, specify the /threads option.
For information about building DLL files from the visual development

environment, see Fortran Dynamic-Link Library Projects and Creating Fortran
DLLs.

For a list of Fortran PowerStation style options (such as /LD and /MDs) and their
DF command equivalents, see Equivalent Visual Fortran Compiler Options.

/[no]error_limit
Syntax:

/error_limit[:count] or /Znoerror_limit
The /error_limit option specifies the maximum number of error-level or fatal-
level compiler errors allowed for a given file before compilation aborts. If you
specify /noerror_limit (command line), there is no limit on the number of errors

that are allowed.

In the visual development environment, specify the Compilation Error Limit in
the Compilation Diagnostics Compiler Option Category.

The default is /error_limit:30 or a maximum of 30 error-level and fatal-level
messages. If the maximum number of errors is reached, a warning message is
iIssued and the next file (if any) on the command line is compiled.
/[no]exe
Syntax:

/exe|:file], /noexe, or /Fefile
The /exe or /Fe option specifies the name of the executable program (EXE) or

dynamic-link library (DLL) file being created. To request that a DLL be created
instead of an executable program, specify the /dll option.

/[no]extend_source
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Syntax:
/extend_source[:size], /noextend_source, or /4Lsize

The /extend_source or /4Lsize option controls the column used to end the
statement field in fixed-format source files. When a size is specified, that will be
the last column parsed as part of the statement field. Any columns after that will
be treated as comments.

Specifying /extend_source (or /4L132 or /4L80) sets the /fixed option.
In the visual development environment, specify the Fixed-Form Line Length in

the Fortran Language Compiler Option Category. The following options are
equivalent:

e /noextend_source, /extend_source:72, or /4L72 specify the last column as
72.

o /extend_source:80 or /4L80 specify the last column as 80.

o /extend_source, /extend_source:132, or /4L132 specify the last column as
132.

/extfor
Syntax:
/extfor:ext
The /extfor option specifies file extensions (ext) to be processed by the Compaq

Fortran compiler. One or more file extensions can be specified. A leading period
before each extension is optional (for and .for are equivalent).

/extfpp
Syntax:

/extfpp:ext
The /extfpp option specifies file extensions (ext) to be processed by the FPP
preprocessor. One or more file extensions can be specified. A leading period
before each extension is optional (fpp and .fpp are equivalent).

/extink

Syntax:
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/extink:ext

The /extlnk option specifies file extensions (ext) to be processed by the linker.
One or more file extensions can be specified. A leading period before each
extension is optional (obj and .obj are equivalent).

/[no]f66
Syntax:
/166 or /nof66

The /f66 option requests that the compiler select FORTRAN-66 interpretations in
cases of incompatibility (default is /nof66). Differences include the following:

e« DO loops are always executed at least once (see Execution of DO
Constructs)

e FORTRAN-66 EXTERNAL statement syntax and semantics are allowed (see
FORTRAN-66 Interpretation of the External Statement)

o If the OPEN statement STATUS specifier is omitted, the default changes to
STATUS='NEW' instead of STATUS="UNKNOWN"

o If the OPEN statement BLANK specifier is omitted, the default changes to
BLANK="ZERO' instead of BLANK="'NULL'

In the visual development environment, specify Enable FORTRAN-66 Semantics
in the Fortran Language Compiler Option Category.

/[no]f77rtl
Syntax:
/t77rtl or /nof77rtl
The /f77rtl option controls the run-time support that is used when a program is
executed. Specifying /f77rtl uses the Compaq Fortran 77 run-time behavior. In

the visual development environment, specify Enable F77 Run-Time Compatibility
in the Compatibility Compiler Option Category.

Specifying /nof77rtl uses the Visual Fortran (Compaq Fortran) run-time
behavior. Unless you specify /f77rtl, /nof77rtl is used.

/fast

Syntax:
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/fast

The /fast option sets several options that generate optimized code for fast run-
time performance. Specifying this option is equivalent to specifying:

/alignment:(dcommons, records, sequence)
/architecture:host
/assume:noaccuracy_sensitive
/math_library:fast

/tune:host

If any of the /stand options are also specified, /align:dcommons
and /align:sequence are not set.

In the visual development environment, specify the Generate Most Optimized
Code in the Code Generation Compiler Option Category.

If you omit /fast, these performance-related options will not be set.
/[no]fixed
Syntax:

/fixed, /nofixed, /74Nf, or /74Yft

The /fixed or /4Nf option specifies that the source file should be interpreted as
being in fixed-source format. Equivalent options are as follows:

e The /fixed, /nofree, and /4Nf options are equivalent and request fixed-
source form.

e The /nofixed, /free, and /4Yf options are equivalent and request free-
source form.

In the visual development environment, specify the Source Form in the Fortran
Language Compiler Option Category.

If you omit /[no]free, /[no]fixed, /4Nf, and /4Yf, the compiler assumes:

e Files with an extension of .f90, .F90, or .i90 are free-format source files.
e Files with an extension of .f, .for, .FOR, or .i are fixed-format files.

/[ no]fltconsistency (ia32 only)
Syntax:

/fltconsistency, /nofltconsistency, or /70Op
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The /fltconsistency or /Op option enables improved floating-point consistency on
1a32 systems. Floating-point operations are not reordered and the result of each
floating-point operation is stored into the target variable rather than being kept
in the floating-point processor for use in a subsequent calculation. This option is
ignored on ia64 systems.

In the visual development environment, specify Enable Floating-Point
Consistency in the Floating Point Compiler Option Category.

The default is /nofltconsistency, which provides better accuracy and run-time
performance at the expense of less consistent floating-point results.

/[no]fpconstant
Syntax:
/fpconstant or /nofpconstant

The /fpconstant option requests that a single-precision constant assigned to a
double-precision variable be evaluated in double precision. If you

omit /fpconstant (or specify the default /nofpconstant), a single-precision
constant assigned to a double-precision variable is evaluated in single precision.
The Fortran 90 standard requires that the constant be evaluated in single
precision.

In the visual development environment, specify Extended Precision of Single-
Precision Constants in the Floating Point (or Fortran Data) Compiler Option

Category.

Certain programs created for FORTRAN-77 compilers (including Compaq Fortran
77) may show different floating-point results, because they rely on single-
precision constants assigned to a double-precision variable to be evaluated in
double precision.

In the following example, if you specify /fpconstant, identical values are
assigned to D1 and D2. If you omit the /fpconstant option, the compiler will
obey the standard and assign a less precise value to D1:

REAL (KIND=8) D1, D2
DATA D1 /2.71828182846182/ ! REAL (KIND=4) val ue expanded to double
DATA D2 /2.71828182846182D0/ ! Doubl e val ue assi gned to doubl e

/fpe

Syntax:
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/fpe:level

The /fpe:level option controls floating-point exception handling at run time for
the main program. This includes whether exceptional floating-point values are
allowed and how precisely run-time exceptions are reported. The /fpe:level
option specifies how the compiler should handle the following floating-point
exceptions:

e When floating-point calculations result in a divide by zero, overflow, or
invalid operation.

e« When floating-point calculations result in an underflow.

e When a denormalized number or other exceptional number (positive
infinity, negative infinity, or a NaN) is present in an arithmetic expression

For performance reasons:

e On ia32 systems, the default is /fpe:3. Using /fpe:0 will slow run-time
performance on ia32 systems.

e On ia64 systems, the default is /fpe:0 (many programs do not need to
handle denormalized numbers or other exceptional values). Using /fpe:3
will slow run-time performance on ia64 systems.

In the visual development environment, specify the Floating-Point Exception
Handling in the Floating Point Compiler Option Category. The /fpe:level (level is
0 or 3) options are as follows:

Handling of
/fpe:level _ Divide by Zero,
- Handling of Underflow Overflow, and
Option )
Invalid
Operation
/fpe:0 Sets any calculated denormalized value Exceptional values
(default on (result) to zero and lets the program are not allowed.
ia64 continue. Any use of a denormalized The program
systems) number in an arithmetic expression uses || terminates after
a value of 0.0 and execution continues. A | displaying a
message is displayed only message.
if /check:underflow is also specified.
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/fpe:3
(default on
ia32
systems)

performance.

Leaves any calculated denormalized value || The program

as is. The program continues, allowing continues. No
gradual underflow. Use of a denormalized || message is

(or exceptional) number in an arithmetic displayed. A NaN
expression results in program
continuation, but with slower

or Infinity (+ or -)
will be generated.

When compiling different routines in a program separately, you should use the
same /fpe:level value.

On ia32 systems, the /fpe option, /check:underflow option, and MATHERRQQ
routine interact as follows:

Specified
/fpe:n
Option

Was
/check:underflow
Specified?

Is a User-
Written
MATHERRQQ
Routine
Present?

Underflow Handling by
the Visual Fortran Run-
Time System on ia32
Systems

/fpe:0

No

No

The underflowed result is
set to zero (0). The
program continues.

/fpe:0

No

Yes

The underflowed result is
set to zero (0). The
program continues.

/fpe:0

Yes

No

The underflowed result is
set to zero (0). The
program continues. The
number of underflowed
results are counted and
messages are displayed
for the first two
occurrences.

/fpe:0

Yes

Yes

The underflowed result is
set to zero (0). The
program continues. The
number of underflowed
results are counted and
messages are displayed
for the first two
occurrences.
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/fpe:3 No No Denormalized results are
allowed and the program
continues. Traps are
masked and no handlers
are invoked.

/fpe:3 No Yes Denormalized results are
allowed and the program
continues. Traps are
masked and no handlers
are invoked.

/fpe:3 Yes No For Version 6, a fatal
error results and the
program terminates.

/fpe:3 Yes Yes Depends on the source
causing the underflow:

¢ If the underflow
occurs in an intrinsic
procedure, the
undefined result is
left as is. The
program continues
with the assumption
that the user-
specified
MATHERRQQ handler
will perform any
result fix up needed.

¢ If the underflow does
not occur in an
intrinsic procedure,
for Version 6.0, a
fatal error results
and the program
terminates.

For more information:

e About the /fpe option on ia32 systems, see How the Floating-Point
Exception Handling (/fpe) Compiler Option Works.

e About the floating-point environment and the MATHERRQQ routine (ia32
systems), see The Floating-Point Environment.
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e About creating exception and termination handlers, see Advanced
Exception and Termination Handling Considerations.

o About routines that can obtain or set the floating-point exception settings
used by Visual Fortran at run-time, see FOR_SET_FPE and FOR_GET_FPE.

o About IEEE floating-point exception handling, see the IEEE Standard for
Binary Floating-Point Arithmetic (ANSI/IEEE Standard 754-1985).

/fpp

Syntax:
/tpp[:"options]

The /fpp option activates the FPP preprocessor and optionally passes options to
FPP as is. The FPP preprocessor can process both free- and fixed-form Fortran
source files. Alternatively, you can use compiler directives, such as the IF
Directive Construct, to detect symbol definitions and perform conditional
compilation.

You can run FPP:

e On the DF command line, by adding the /fpp option. By default, the
specified files are compiled and linked. To retain the intermediate (. i
or .i90) file, specify the /keep option.

¢ In the visual development environment, by specifying the Use FPP option in
the Preprocessor Compiler Option Category. By default, the file is compiled
and linked. To retain the intermediate (.i or .i90) file, specify the /keep
option on the command line or (in the visual development environment,
Project Settings dialog box) the Project Options: box.

e On the command line, by using the FPP command. In this case, the
compiler is not invoked. When using the FPP command line, you need to
specify the input file and the output intermediate (.i or .i90) file.

FPP is a modified version of the ANSI C preprocessor and supports a similar set
of directives (including syntax and semantics). It supports the following
directives: #define, #elif, #el se, #endi f, #i f, #i fdef, #i f ndef, #i ncl ude, and #undef .

For example, the following DF command invokes FPP, specifies the /noC option

to FPP, uses the /define option to define the symbol testcase, and preprocesses
file cond. for before it is compiled and linked:

DF /fpp:"/noC" /define:testcase=2 cond. for
For a list of predefined preprocessor symbols (such as _X86 ), see /define.

For information on FPP options, type FPP /HELP on the command line.
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/[no]fpscomp
Syntax:
/fpscomp|:keyword...] or /Znofpscomp

The /fpscomp option controls whether certain aspects of the run-time system
and semantic language features within the compiler are compatible with Visual
Fortran or Microsoft Fortran PowerStation.

If you experience problems when porting applications from Fortran
PowerStation, specify /fpscomp:keyword (or /fpscomp:all). When porting
applications from Compaq Fortran, use /fpscomp:none or /fpscomp:libs (the
default).

In the visual development environment, specify the PowerStation 4.0
Compatibility Options in the Compatibility Compiler Option Category.
The /fpscomp options and their visual development environment names are:

/fpscomp:[no]filesfromcmd /fpscomp:[no]general
(Filenames from Command Line) (Other Run-time Behavior)

/fpscomp:[no]ioformat /fpscomp:[no]ldio_spacing
(1/0 Format) (List Directed 1/0 Spacing)
/fpscomp:[no]libs /fpscomp:[no]logicals
(Libraries) (Logical Values)

/fpscomp:[no]symbols
(Predefined Preprocessor Symbols)

/fpscomp:all and /fpscomp

/nofpscom